The Macintosh Bible: Guide to System 7.1

An exceptionally clear and accessible guide, from the publishers of the world's best-selling Mac book.

Charles Rubin
The Macintosh Bible Guide to System 7.1
The
Macintosh Bible
Guide to
System 7.1

by
Charles Rubin
PART 2  **The Finder and its menus**

Chapter 4. Working with the Finder ................................................ .45
  Familiar features, subtle changes .............................................. .46
  The Finder works like MultiFinder ........................................ 48
  Managing memory ..................................................................... 49
  Printing in the background ..................................................... 50
  Icon cosmetics ............................................................................ 51
  Window changes ...................................................................... 52
  Other file management changes .............................................. 56
  Fkeys ......................................................................................... 59
  Keyboard shortcuts ................................................................... 61
  For WorldScript users ............................................................. 66

Chapter 5. File and Edit menu commands ........................................... 69
  The File menu ........................................................................... 70
  The Get Info command ............................................................. 71
  The Sharing... command ........................................................... 76
  The Make Alias command ......................................................... 77
  The Find... and Find Again commands ..................................... 81
  The Edit menu ........................................................................... 87

Chapter 6. View, Label, Special, Help and Application menu commands .............................................................. 89
  The View menu .......................................................................... 90
  The Label menu ........................................................................ 90
  Customizing labels ..................................................................... 93
  The Special menu ...................................................................... 94
  The Clean Up commands .......................................................... 94
  The Empty Trash command ....................................................... 96
  The Help menu .......................................................................... 98
  The Application menu .............................................................. 100

PART 3  **The new System Folder**

Chapter 7. The System Folder .......................................................... 105
  The System Folder ..................................................................... 106
  The Apple Menu Items folder .................................................... 107
  The Control Panels folder .......................................................... 112
Table of contents

The Extensions folder ............................................................... 113
The Fonts folder ....................................................................... 114
The Preferences folder .............................................................. 119
The PrintMonitor Documents folder ....................................... 119
The Startup Items folder .......................................................... 120
The System file: installing sounds ............................................ 121

Chapter 8. Using control panels ............................................... 123
The Control Panels folder ........................................................ 124
Some control panels are the same ........................................... 125
Familiar control panels with new features .............................. 126
The Views, Date & Time, and Numbers control panels .................. 135
Other new control panels ......................................................... 143
International control panels .................................................... 145

PART 4 Working with applications

Chapter 9. Using applications ......................................................... 149
Managing program memory .................................................... 150
Opening and saving documents .............................................. 159
Using stationery ................................................................. 161
Using QuickTime ............................................................... 165

Chapter 10. Printing ................................................................. 169
The three font formats ............................................................ 170
Printing with a StyleWriter, ImageWriter, Personal LaserWriter LS, or other QuickDraw printers ............ 172
Printing with a PostScript-compatible LaserWriter or other laser printer ....................................................... 173
Using PrintMonitor ............................................................... 178
The LaserWriter Font Utility .................................................. 184
Mixing TrueType and other fonts on a LaserWriter .................. 190

Chapter 11. Publishing and subscribing ......................................... 193
What's publishing and subscribing? ........................................ 194
Publishing and subscribing in action ..................................... 195
Publisher and subscriber options ......................................... 198
Publishing and subscribing on a network ............................ 200
# Table of contents

## PART 5  Sharing files and linking programs

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>File sharing</td>
<td>203</td>
</tr>
<tr>
<td></td>
<td>File sharing for the AppleShare user</td>
<td>204</td>
</tr>
<tr>
<td></td>
<td>File sharing step-by-step</td>
<td>206</td>
</tr>
<tr>
<td></td>
<td>Connecting your Mac to other Macs</td>
<td>216</td>
</tr>
<tr>
<td>13</td>
<td>Users, groups and access privileges</td>
<td>223</td>
</tr>
<tr>
<td></td>
<td>About users and groups</td>
<td>224</td>
</tr>
<tr>
<td></td>
<td>About access privileges</td>
<td>230</td>
</tr>
<tr>
<td></td>
<td>Viewing access privileges</td>
<td>234</td>
</tr>
<tr>
<td></td>
<td>Access privileges in action</td>
<td>238</td>
</tr>
<tr>
<td></td>
<td>How secure is it?</td>
<td>241</td>
</tr>
<tr>
<td>14</td>
<td>File sharing tips and troubleshooting</td>
<td>243</td>
</tr>
<tr>
<td></td>
<td>File sharing tips</td>
<td>244</td>
</tr>
<tr>
<td></td>
<td>File sharing troubleshooting</td>
<td>246</td>
</tr>
<tr>
<td>15</td>
<td>Program linking, IAC and Apple Events</td>
<td>253</td>
</tr>
<tr>
<td></td>
<td>Two ways to link programs</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Starting program linking</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Sharing your programs with other uses</td>
<td>257</td>
</tr>
<tr>
<td></td>
<td>Controlling other users' access to your shared programs</td>
<td>258</td>
</tr>
<tr>
<td></td>
<td>Turning program linking off</td>
<td>260</td>
</tr>
<tr>
<td></td>
<td>Managing program linking performance</td>
<td>260</td>
</tr>
</tbody>
</table>

### Glossary

- Page: 263

### Index

- Page: 275
I'd first like to thank the thousands of readers who made *The Macintosh Bible Guide To System 7* one of the biggest successes I've had, and among them those who took the time to write me with suggestions about how to improve it. I've taken those suggestions to heart in this book.

To Ted Nace, Helmut Kobler, Suzanne Ludlum and everyone else at Peachpit Press, thanks for being so pleasant, conscientious, creative and energetic. I'm very glad to have you all on my side.

To Joel Cannon, Mark Zeren, Elli Holman, Lily Shoemaker and everyone else at Apple's Developer Technical Support Group, thanks for your patient assistance with my technical questions, and for generally putting out a ton of information each month. Also at Apple, my special thanks to Ron Lichty, a good friend to have on the inside.

Finally, my continuing gratitude goes to Arthur Naiman, for creating the *Macintosh Bible* series and building an audience for it second to none in the world of Mac books.
Introduction

It's the system software that makes the Macintosh unique, and System 7 brought the most revolutionary changes to the Mac's software since it was introduced in 1984. Since System 7 was released in May 1991, over half of the Mac users worldwide have upgraded to it. Many of those who didn't upgrade right away were waiting for the current release, System 7.1, so application developers would have time to make their products compatible with System 7. Now the wait for compatibility is over.
Every new Macintosh now comes with System 7.1 and a set of manuals for it. If you bought your Mac before System 7.1 came out, the chances are you'll want to upgrade. System 7.1 requires at least two megabytes of RAM and a hard disk to run (and four megabytes of RAM are really recommended), but once you see what it can do, the cost or hassle of upgrading your Mac will seem trivial compared to the power you'll gain.

Who this book is for

This book is primarily for people upgrading to System 7.1 from previous versions of the Mac system software. Since you're already familiar with the Mac, we'll get you up to speed quickly by focusing on what's new and different in System 7.1, rather than wasting your time rehashing mouse-clicking and other basic Mac features.

Apple's official System 7.1 Personal Upgrade Kit (which contains the software and manuals) retails for $99. But you can take a few floppy disks down to your Apple dealer and get a free copy of the System 7.1 software, and then buy this book. The money you save will probably buy a couple of extra megabytes of RAM for your Mac. Even if you bought a Mac after System 7.1 came out and thus have Apple's own manuals, you're likely to find this book more concise, more readable and better organized.

What this book assumes

Since The Macintosh Bible Guide assumes you've used a Mac before, it doesn't belabor the obvious and supposes you know how to use the Finder, windows, menus, icons and basic dialog boxes. Specifically, it assumes that you know how to:

• open a file, folder or disk
• save or print a file
• delete a file
• close a window
• resize or scroll a window or scroll a list in a dialog box
choose a menu command
• use checkboxes and buttons
• press the r or e key to select a heavily-outlined button in a dialog box (like the OK button) instead of clicking it
• quit a program
• move fonts and DAs using Font/DA Mover

If you've used a Mac for any time at all, you already understand most or all of these things (and the descriptions in this book are generous enough to make up for any minor gaps in your knowledge). If you don't, look them up in your old Mac manual, use the guided tour disk that came with your Mac, or buy a good reference like The Macintosh Bible.

Naturally, where System 7.1 offers new ways to work with windows, menus, dialog boxes, or programs, these will be clearly explained.

How this book is organized

I've divided the book into five sections:

Section I, Getting started, takes you through upgrading, installing System 7.1 and starting up.

Section II, The Finder and its menus, covers the new desktop and menus.

Section III, The new System Folder, deals with the new control panel devices (now called control panels), new folders in the System Folder and new ways of installing fonts and utilities.

Section IV, Working with applications, covers new features like publishing and subscribing, stationery and QuickTime, as well as memory management and printing.

Section V, Sharing files and linking programs, deals with these powerful new network-related features of System 7.1.
Introduction

In the back of the book, the glossary defines terms that are new in System 7.1, as well as others that may simply be unfamiliar to you. The index is a cross-reference for terms, concepts and procedures you’ll use in System 7.1.

How to use the book

This book was designed to be read from beginning to end, but you’ll probably end up picking out the chapters that interest you most. If you haven’t installed System 7.1 yet, follow the instructions in Chapter 2 and then you’ll be able to restart your Mac and poke around on your own.

The table of contents lists chapters, and each chapter has a title page that lists the sections within it so you can move quickly to topics that interest you. If you don’t find what you’re looking for there, check the index or glossary.

Conventions used in this book

Here are some conventions I’ve used in the interest of presenting information clearly and economically:

- System 6 and System 7 refer to all versions of these systems, while System 6.05 or System 7.1 (say) refer to the exact versions specified.
- Checking or unchecking a checkbox means clicking in it so an X appears or disappears (which selects or deselects the option the checkbox represents).
- The dialog boxes you see when you open the new control panel programs are called control panels instead of dialog boxes (because that’s what Apple calls them).

To help you find your way through conventional dialog boxes, I show the names of the new dialog box areas, checkboxes and buttons, as well as new features generally, in boldface the first time they’re explained, unless they’re obvious buttons like OK, Cancel or Quit. Since OK and Cancel are universally understood, I don’t
bother explaining their functions—unless they do something remarkable in a particular case.

The screen illustrations in this edition were taken from versions 7.0 and 7.0.1 of System 7, as well as from a prerelease copy of System 7.1. Many of the dialog boxes show specific software version numbers. The dialog boxes in your version of System 7.1 may show different version numbers.

Finally, I haven’t documented trivial changes in the appearance of objects or alert boxes unless they affect the way you use the Mac.

**The Mea Culpa department**

I’ve done my best to present practical and readable descriptions of every System 7.1 feature without putting anyone to sleep. If you think there’s a really hot tip that should be in here, or if you (gulp) discover a mistake, please write to me in care of Peachpit Press (the address is on the copyright page).

Dozens of readers of *The Macintosh Bible Guide To System 7* wrote in offering tips or suggestions, and most of those were included when the book was updated to cover System 7.1. Thanks, everyone.
PART 1

Getting started
System 7.1 at a glance

When it comes to improving the Mac, System 7.1 (and System 7 before it) blow the doors off any previous change in the system software. System 7.1 retains some basic features that go all the way back to 1984, but it also adds a lot of powerful new capabilities that will help the Mac keep its competitive edge through the 1990's.
As you might expect from a major increase in Mac capabilities, System 7.1 is not for every Mac user, and even if you can use it, you may not want to run right out and get it. In this chapter, I'll start with a quick look at the new features of System 7.1, and then we'll see how the various Mac models support those features. Putting that information together will help you decide whether or not it's worth it to you to upgrade.

If you just bought a Mac you don't need to upgrade: you're already running System 7.1. Skim the next section to get an overview of System 7.1's features, and then jump to What you need to run System 7.1 at the end of the chapter to see which of these features your Mac can use.

What's new in System 7.1

A more powerful, more flexible Finder

The new Finder makes your desktop easier to manage, with more control over how icons and windows look, easier access to applications and more ways to arrange items on the desktop.

It works like MultiFinder, which was an option with System 6. This means you can always have as many programs open as your Mac's memory allows and, if you have a PostScript printer like the Apple LaserWriter, you can print documents in the background while you do other work.

Easier font, sound and DA management

To install fonts, sounds and DAs, you just drag them into the System Folder. There's no more Font/DA Mover program and no more fifteen-DA limit on the menu. To view fonts and play sounds, you just doubleclick them.
Built-in Help

There’s a new Help menu in the Finder which explains parts of the desktop, windows and system software files as you point to them. You can also display a list of keyboard shortcuts.

System 7.1 comes with help information only for the Finder, but other developers are also using this menu to add instant help to their own programs.

Aliases

Aliases are stand-ins for folders, disks, files or programs. Got a folder you work with all the time? Put aliases of it on the menu, on the desktop and in any other folder where you might need quick access to it.

Aliases don’t take up a lot of disk space because they’re not copies—they’re just remote-control switches that permit you to open the real items they stand for.

Stationery

Some programs have a stationery option that lets you create letterheads, memo pages or other preformatted templates and then open them as new untitled documents. System 7.1 lets you make stationery for any program.

TrueType fonts

System 7.1’s new TrueType fonts work both for printing and to display characters smoothly on the Mac screen, so you don’t have to keep separate screen and printer versions of the same font. And you only need one file for a whole typeface like Helvetica (no more messing with Helvetica 10, 12 and 14). TrueType fonts can be used right along with any of your old fonts, even in the same document.
Better font management

Under System 7.1, all fonts are installed inside a special Fonts folder in the System Folder, rather than in the System file itself. You can drag any font or font suitcase file onto the System Folder icon and it will be placed in the Fonts folder, where any program can find it.

Tip

You can even install printer fonts in the Fonts folder, and the new LaserWriter printer driver will know to look for them there.

File sharing

File sharing lets you share data with other people on a network without having to buy special software like AppleShare or an electronic mail program. If your Mac is on a network, you can designate folders or disks on your system as shared items, so other people on the network can use them.

Virtual memory

Virtual memory tells your Mac to set aside free space on a hard disk as extra RAM. With the right Mac (see What you need to run System 7.1 below), virtual memory can give you up to a gigabyte of RAM.

32-bit addressing

32-bit addressing allows the more advanced Mac models to access far more RAM than the less powerful Macs, which are limited to the memory they can access with 24-bit addresses. (What you need to run System 7.1 below explains the capabilities of each Mac model.) Rather than being restricted to four or eight megabytes, these more advanced Macs can use from 10 to 128 megabytes of RAM. This will really help people who work with extra large graphics or spreadsheet files or who want to work with lots of big programs open at the same time.
Publish and subscribe

Publish and subscribe is a kind of automatic cut-and-paste function that lets you link documents created by different programs. For example, you can publish part of a spreadsheet and then subscribe to those published numbers in a word processor document. If you change the spreadsheet file, the spreadsheet numbers in the word processor document can automatically be updated.

Program linking

Program linking allows programs to exchange information without your intervention. For example, a color paint program could ask a compression utility to compress or decompress its files as they are saved or opened; or a spreadsheet program could ask a word processing program to check a worksheet for spelling errors.

Tip

Programs exchange information with Apple Events. See Chapter 15 for more information.

QuickTime

QuickTime is Apple's new technology for managing time-oriented data like sounds, animation and video. It allows any Macintosh user to cut, copy, paste, publish or subscribe, and display sounds or moving images as easily as they would text or PICT graphics. It includes an image compression feature that allows you to store sounds, movies or still images so they use up far less space than they normally would.

System 7.1 comes with the QuickTime capability, but in order to use it in your applications, the applications themselves must support it. For example, if your word processor supported QuickTime, you could paste an animated graphic into a document, and clicking on it would automatically tell your Mac to retrieve the animation and sound files and play them—the graphic would come to life right on the screen. QuickTime has only been
commercially available since March 1992, but within a year or so most of the major applications will support it.

Tip

QuickTime is remarkable, but don’t expect it to provide full-screen video on your Mac. See Using QuickTime on p. 165 in Chapter 9 for more information.

Data Access Language (DAL)

With DAL you’ll be able to use your favorite spreadsheet or word processor program to get information from a network or mainframe database without having to know that database’s specific query language.

Only the basic DAL facilities are included with System 7.1 (they’re in a file inside the System Folder) and you won’t find any further discussion of DAL in this book. Once developers begin supporting DAL, you’ll be able to learn about it from their application manuals.

WorldScript

WorldScript is the biggest change in the system software between System 7.0 and System 7.1. It’s a set of system extensions that allow System 7.1 to be easily localized for different international languages. Before this, each foreign language required a completely different version of system software. With the WorldScript I and WorldScript II extensions and local scripts and fonts for each language, Macs can easily be set to present text in different languages on the Mac screen. Versions of System 7.1 sold in the United States don’t ship with the WorldScript extensions.
Some of the features and utility programs we’ve grown used to in System 6 have been eliminated from System 7.1, because they’re not needed anymore or have been replaced by something better.

MacroMaker, the Apple-supplied keystroke macro program, isn’t included with System 7.1 and won’t work with it. (Apple is working on a far more sophisticated macro language called AppleScript, which is slated for release in 1993.)

Font/DA Mover, the utility you needed to add fonts or DAs to the System file in previous versions of the system software, is also gone because it isn’t needed anymore. You now install fonts by just dragging them into the System Folder, and DAs work like ordinary programs under System 7.1 (see Chapter 7).

Actually, Font/DA Mover version 4.1 or later is compatible with System 7.1, and you can still use it to create or edit suitcase files.

The Access Privileges DA and Get Privileges... command you used under System 6 if you were an AppleShare user have now been replaced by the Sharing... command on the File menu (see Chapters 5 and 12).

The Set Startup... command is gone from the Special menu, because you can now set anything to open automatically at startup by dragging it inside System 7.1’s Startup Items folder (see Chapter 7).

MultiFinder is gone, since its functions are performed by the System 7.1 Finder.
What you need to run System 7.1

System 7.1 requires at least two megabytes of RAM and a SCSI hard disk with at least three megabytes of free space on it. That’s just to run the system software and work with one or two relatively small applications open at the same time (a word processor and a DA, perhaps). A year’s experience with System 7.1 shows that for most users, 4 or 5 megabytes of RAM is a practical minimum, and the more RAM and disk space you have, the better.

(I suppose someone out there will find a way to install System 7.1 on a high-density 1.44 megabyte floppy disk. But for this to work, you’d have to strip away a lot of the fonts, printer drivers and other extra files, and your Mac’s performance would be far worse than when running System 6 from a floppy. Trying to shoehorn System 7.1 into less space than it was designed for is asking for trouble.)

There’s a definite hardware class structure when it comes to running System 7.1 and taking advantage of all of its features.

Left at the gate—Mac 128K, 512K, 512Ke models and any other Mac with one megabyte of RAM or without a SCSI hard disk. These can’t run System 7.1 at all.

Coach—Mac Plus, SE, Portable, PowerBook 100, Classic, and standard Mac II models can run System 7.1, but they can’t use virtual memory or 32-bit addressing.

Business Class—The Mac LC can use up to 10 megabytes of RAM in 32-bit addressing mode, but can’t use virtual memory.

First Class—The Mac Classic II, LC II, IIsi, IICci, IIfx, IIVi, IIVx; all PowerBook models except the 100; and all Performa and Quadra models can use both virtual memory and 32-bit addressing right out of the box.
Upgrading to business or first class

With a little tinkering, you can also use virtual memory and 32-bit addressing on a Mac II, SE/30, IIx or IIcx, and you can access virtual memory on other Macs equipped with 68030-based accelerator cards.

On the Mac II, you need to install a PMMU chip, and then install an extension program called MODE 32.

For the Mac SE/30, IIx or IIcx, you only have to install the MODE 32 extension.

For Macs using 68030 accelerator cards, Connectix makes a product called Compact Virtual that lets you use virtual memory.

You can get a PMMU chip from your Apple dealer or from Connectix (1-800-950-5880). MODE 32 and Compact Virtual are available for free from your Apple dealer, Connectix, or from the Macintosh forums on America On Line or CompuServe.

Should you upgrade?

With the new features and the hardware realities of running System 7.1 fresh in mind, your decision to upgrade will be based on the state of your system and on your financial priorities.

Hardware upgrade costs

If you’re one of the millions who’s only a one-megabyte memory upgrade away from System 7.1, all the new features are well worth the $50 (or less) per megabyte you’ll have to spend for the extra RAM. Along with the new features, you’ll be able to use all your old fonts and most of your existing inits, DAs and sounds.

If your system lacks a hard drive, you’ll have to spend a few hundred bucks to make it compatible with System 7.1, but the
performance leap from a floppy-driven Mac on System 6 to one running System 7.1 on a hard drive will be worth it. Still, if you’re happy with your system, it may not be worth your trouble or expense to switch.

System 7.1 is a bigger, more complex collection of programs than System 6, and it takes more horsepower to run. On 68000-based Macs like the Plus, you’ll find that some operations take a little longer, but the extra features should make up for the slight lag. If you’re not sure about the tradeoff, try test-driving System 7.1 on a Mac like yours at an Apple dealer’s, a friend’s house or office, or at a user group.

**Compatibility and reliability**

Anyone familiar with previous Mac system upgrades will be leery of bugs in early versions of System 7.1. But even prerelease versions of System 7.0 were far less buggy than the first version of System 6, and System 7.1 is quite solid.

Along with the reliability of the system software itself, however, there’s the issue of compatibility with other programs you’ve been using under System 6. When System 7 first came out, many people had to abandon or upgrade some of their favorite programs because they did strange or even catastrophic things under System 7.0. Now that System 7.1 is out, most of the software compatibility problems between it and older programs from other developers have been taken care of with new versions of those programs. Of course, upgrading to System 7.1-compatible versions of your favorite programs probably won’t be free at this point, so you should call the manufacturer for compatibility and upgrade information to see how much the transition will cost you.

**Sticking with System 6**

If you’re working with other Mac users on a network, don’t think you have to upgrade just because others on your network are using System 7.1. Your System 6-based Mac can coexist on a network with System 7.1-based Macs. In fact, if your System 6-based
Mac is set up as an AppleShare workstation, you can connect to System 7.1 Macs that are sharing files on the network and access those files as well.

The only change you really should make as a System 6 user is to upgrade your LaserWriter or other network printer drivers to the current System 7.1 version. When you print on a LaserWriter over a network, the printer is initialized with the specific version of the LaserWriter driver you’re using on your Mac. If you’re using a System 6 LaserWriter driver and everyone else is using a newer System 7.1 driver, you’ll get a warning about reinitializing the network printer every time you use it after someone else, and it will take you a couple of minutes longer to print documents. To upgrade your printer driver, just get a copy of it from a System 7.1 user and install it in your System Folder.
CHAPTER 2

Installing System 7.1

System 7.1 comes with a set of installation floppies and an Installer program that manages the software's installation as you insert the various disks. Along with these, there's a separate Disk Tools disk that contains disk utility programs that aren't installed with the software, and a QuickTime installation disk that contains the QuickTime extension and an Installer program.
In this chapter, we’ll see how to prepare your disk for installing System 7.1, how to install the basic system software and check the installation, how to install the QuickTime extension file, and (for international users) how to install the WorldScript extensions and scripts and fonts for other languages.

**Do you need to use the Installer?**

Yes, you do. Like every version of Mac system software, System 7.1 comes with an Installer program. In days gone by, you could install Mac system software more quickly by hand—you simply dragged the files from their floppy disks or another hard disk onto the destination disk. This procedure doesn’t work now because the files on the various System 7.1 floppy disks must be assembled by the Installer once they’re copied to your hard disk, or else your Mac won’t run.

**Preparing for the installation**

Before you upgrade to System 7.1, you’ll want to know just what you’re getting into in terms of software upgrade costs. The Compatibility Checker is a HyperCard stack that determines what programs are on your disk and whether or not they’re compatible with System 7.1. When programs aren’t compatible, you can call the developer to find out how much it will cost you to upgrade.

If you decide after running the Compatibility Checker that the upgrade hassles are manageable, you’ll want to back up your hard disk files to give yourself a safety net in case something goes wrong during the installation.

**Running the Compatibility Checker**

The Compatibility Checker is a HyperCard stack that searches your hard disk and then produces a report showing which application, init, cdev and utility programs are on it, which version
they are, and whether or not they're compatible. Since it's a HyperCard stack, you need HyperCard to run it. If HyperCard isn't installed on your hard disk, start the program from its floppy disk and then open the Compatibility Checker stack.

When you run the Compatibility Checker, it automatically selects your startup disk as the one to check for compatible programs. If you're connected to other hard disks or network servers, you can also check those disks. Once the check has been made, the report appears on your screen. It looks something like this:

![Compatibility Checker 1.0](image)

(Note: This sample was taken from the first version of this program, which shipped with System 7.0. The version you get with System 7.1 may look a little different.)

The compatibility information in this report is supplied by the manufacturers of the programs themselves. Some ratings are more accurate than others. For example, a “Must Upgrade” rating seems to indicate that the program won’t work under System 7.1, but this isn’t necessarily true—I’m still using some “Must Upgrade” products and haven’t had any problems. (On the other hand,
some “Must Upgrade” products wouldn’t run at all under System 7, let alone System 7.1.)

Depending on the product and how much information its developer supplied for the Compatibility Checker stack, the Notes column can show the latest version of a program, what it is about your version that’s incompatible (it doesn’t take advantage of 32-bit addressing, for example), and what to do about it. The report explains all the codes. When you produce the report, print it out so you’ll have it handy to refer to later.

While the Compatibility Checker gives you a good overall feel for the compatibility of your existing programs, you’ll still have to try them one at a time to see how they measure up. You may find that you’ll be able to get away with using your old programs indefinitely with no problems (although those versions may not be able to take advantage of all of System 7.1’s new features), while others will have to be upgraded right away. At the end of the report, you’ll find names and phone numbers for many of the software developers who created the programs on your disk, and you can call them to find out how to upgrade and what it will cost.

**Backing up your files**

If you decide to proceed with the System 7.1 installation after finding out which of your programs need upgrading, you should back up all the important files on your hard disk before doing the installation itself. Performing a system software installation is like major surgery for your hard disk, and while it’s not likely, it’s possible that your desktop file or directory information could be damaged or totally trashed, leaving you with no alternative but to reformat the disk and restore it from backup copies of your files. Obviously, if you don’t have backups of your files, you’ll be in big trouble.

The simplest backup method is to use a backup utility program like DiskFit, Retrospect, Fastback, or HD Backup. These programs will copy the entire contents of your hard disk to a set of floppy disks, a tape cartridge, a removable hard disk cartridge, or another
Installing System 7.1

hard disk. A backup utility will not only copy all your files, but it will preserve the desktop and folder organization of your disk, so you can restore it to exactly what it was, if necessary.

If you don't have a backup utility, you should back up by dragging files and folders to another disk. At the very least, make copies of your data files, program files for which you don't have the original master disk, and any accessory files for applications, such as preferences files, custom spelling dictionaries, glossaries or macro files that you've created yourself. (If you have the original master disks from your application programs, those can serve as backups for the actual programs.)

If you have a set of System 6 installation floppies, you don't need to back up the standard Macintosh system software files in your System Folder (except perhaps the Scrapbook and Note Pad, which could have your own data in them), since the installation will involve replacing it anyway. If your System Folder contains any non-Apple inits, cdevs, DAs or font files, though, you should back those up as well, unless you have them stored on master disks somewhere else.

Make two backups of really important files. If the first backup set gets trashed for some reason, you'll beat Murphy's Law with the second backup set.

Tip

The best way to install System 7.1

Although you can install System 7.1 right onto a disk that contains a System 7.0 System Folder, the best way to install System 7.1 is to put it on a disk that doesn't contain a System Folder. As we'll see, eliminating an existing System Folder isn't as hard as you might think. Along with eliminating the existing System Folder, you should delete your old system software files. And, once you've installed System 7.1, you should update your hard disk driver.
Unblessing the current System Folder

The only way the Installer or the Mac itself can identify a System Folder is by the System and Finder files inside it. These two files bless the System Folder, so the Mac will use its files to start up and run. A blessed System Folder has a Mac icon on it, like this:

![System Folder icon]

To turn your System Folder back into an ordinary folder, simply remove either the System or Finder file from it. After you unbless it this way, the System 7.1 Installer will ignore this folder and create a brand new System Folder during installation.

Although you'll be installing a new System Folder, your existing one probably has lots of files in it that you want to keep, including fonts, DAs, inits, control panel devices (cdevs) and program preferences files you installed yourself. You can move these files into the new System Folder once the System 7.1 Installer is finished.

Here's the procedure for unblessing your System Folder:

1. Restart your Mac with the Disk Tools disk from your set of System 7.1 floppy disks, or from another startup floppy.
2. If you've installed fonts, DAs or sounds directly in your System file and you don't have their original files stored elsewhere, drag the existing System file into a different folder. Once you've installed System 7.1, you can open the old System file and drag its fonts, sounds and DAs to the new System Folder.
3. Drag the Finder file to the Trash and empty the Trash.
4. Rename your current System Folder Stuff, so you won't confuse it with the new System Folder.
Deleting old system software files

Now that you’ve done away with your old System Folder (at least as far as the Installer program and your Mac are concerned), you can eliminate all the old system software files that will be replaced when you install System 7.1.

Open the Stuff folder and delete all the standard Apple system software files (the System 7.1 Installer will install new versions). If you’re not sure which are standard Apple system software files, they’re listed below (although your old System Folder probably won’t contain all of them):

<table>
<thead>
<tr>
<th>Access Privileges</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppleTalk</td>
<td>Laser Prep</td>
</tr>
<tr>
<td>AppleTalk ImageWriter</td>
<td>LaserWriter</td>
</tr>
<tr>
<td>AppleShare</td>
<td>LQ AppleTalk ImageWriter</td>
</tr>
<tr>
<td>Backgrounder</td>
<td>LQ ImageWriter</td>
</tr>
<tr>
<td>Battery</td>
<td>MacroMaker</td>
</tr>
<tr>
<td>Brightness</td>
<td>Monitors</td>
</tr>
<tr>
<td>Clipboard File</td>
<td>Map</td>
</tr>
<tr>
<td>CloseView</td>
<td>Mouse</td>
</tr>
<tr>
<td>Color</td>
<td>MultiFinder</td>
</tr>
<tr>
<td>DA Handler</td>
<td>Personal LaserWriter</td>
</tr>
<tr>
<td>Easy Access</td>
<td>PrintMonitor</td>
</tr>
<tr>
<td>Finder</td>
<td>Responder</td>
</tr>
<tr>
<td>Finder Startup</td>
<td>Scrapbook File</td>
</tr>
<tr>
<td>Font/DA Mover</td>
<td>Sound</td>
</tr>
<tr>
<td>General</td>
<td>Startup Device</td>
</tr>
<tr>
<td>ImageWriter</td>
<td>System</td>
</tr>
<tr>
<td>Key Layout</td>
<td>32-bit QuickDraw</td>
</tr>
</tbody>
</table>

Now there’s no System Folder on your hard disk and all your custom system software files are still saved in the Stuff folder.

Why you shouldn’t update an existing System Folder

Instead of the above procedure, you can update an existing System Folder when you install System 7.1. This avoids having to
copy your custom system software files into the new System Folder after installation. But it's not such a hot idea.

Because the System, Finder and other System Folder files are opened and closed a lot as you use your Mac, they can sustain minor damage from power surges, static electricity, cosmic rays (seriously!) and other problems. If you update an existing System Folder when you install System 7.1, you run the risk that damage in your System or Finder files will be "updated" to your System 7.1 software as it's installed. You might not notice any problems right away, but they could surface later on. Eliminating the System Folder from your disk and creating a new one removes the main risk of corrupted file problems—and since these problems tend to be very unpleasant, it's best to do what you can to avoid them.

Replace your System Folder files every few months as a preventive maintenance step; this usually also cures minor problems you may have opening, saving or printing files, or will keep them from happening.

---

**Installing from floppy disks**

Here's how to install using floppy disks:

1. Copy the complete set of System 7.1 installation disks, put the originals away in a safe place and label your copies with the same names as the original disks.

2. Restart your Mac with your copy of the Disk Tools disk. (If your Mac has two floppy drives, insert the Installer disk in the second drive, and you'll avoid all the floppy-swapping in steps 3 and 4 below.)

3. Eject the Disk Tools disk and insert the Install disk from your set of System 7.1 floppies. The Install disk's window will open on the desktop.
4. Double-click the Installer program’s icon. The program will begin launching, and then you’ll be asked to insert the Disk Tools disk again. (This is because the system software your Mac needs to launch the Installer is on the Disk Tools disk, and—unless you have it in your second floppy drive—that disk isn’t available to your Mac at this point.) You’ll be asked to swap the Disk Tools floppy and Install floppy in the disk drive a couple of times as the Installer program launches, but finally, you’ll see an information screen that explains what the Installer does.

Click the OK button and you’ll see the Easy Install dialog box, like this:

5. Check the name of the disk to make sure it’s the one you want to install on. Click the Switch Disk button until your hard disk’s name is showing like the Data Cell name in the example above.

6. Next, you need to decide whether you want to use the Easy Install method or Customize your installation.
The Easy Install option gives you the whole enchilada: all system software for your Mac, printer drivers for every Apple printer it can use, AppleShare user software and file-sharing software. To select Easy Install, click the Install button.

The Customize option lets you order à la carte, selecting only the specific system resources you want installed. This option saves disk space by not installing printer and networking drivers you don’t need now (you can also use it later, if you want to add an extra driver after you’ve installed System 7.1). To select this option, click the Customize button. You'll see a scrolling list of specific system resources you can install, like this:

Click on the resource you want to install (Shift-click to select several resources). A description of each resource you select appears underneath the first list, as shown at the top of the next page:
If you choose more than one resource, the resource names are displayed in a list. Once you've selected the resources you want installed, click the Install button.

7. You'll be prompted to insert various System 7.1 disks as the Installer needs files from them during the installation process. You won't be asked to insert the Disk Tools disk, though, because it contains utility programs that don't need to be installed.

If the installation is successful, you'll see a message saying so, with buttons to Continue or Quit. Clicking Continue returns you to the Easy Install screen so you can do other installations. Clicking Quit displays the shutdown screen, where you can either turn off your Mac or click the Restart button to start it up again. Once you restart, you'll be running under System 7.1.

If the installation wasn't successful, you'll see an explanatory message. See If the installation fails on p. 29.
Updating the hard disk driver

Once you've installed System 7.1, you should update the driver on your hard disk. The driver is the software that identifies your hard disk to the system software, and since you've changed versions of the system software, it's a good idea to update the driver. To do this, you must run your hard disk's setup program.

If you have an Apple hard disk, you use the Apple HD SC Setup program that comes on the Disk Tools floppy disk. Just start the program, make sure your hard disk's name is showing in the dialog box, and click the Update button to update the driver. (If the right disk name isn't showing, click the Drive button until it is.) The Apple HD SC Setup program will only recognize Apple-supplied hard disks, so if you're not sure where your hard disk came from and the HD SC Setup program doesn't recognize your disk, it's because it didn't come from Apple.

If your hard disk is from another manufacturer, you'll find the setup program on a floppy disk that came with it. You may have to restart your Mac with that floppy disk in order to run the setup program.

If your hard disk is a really old one, the setup program may not be compatible with System 7.1 at all, and updating the driver will cause problems. In this case, you'll need to call the hard disk's manufacturer to get an upgrade.

Installing from a file server or another local hard disk or CD-ROM disk

If you're updating system software for several Macs on a network or if you just want to save yourself some floppy swapping, you can install System 7.1 from a file server or file-sharing Mac, a CD-ROM disk or another hard disk connected to your Mac.
(Such a disk is called a local hard disk because it’s in a SCSI chain connected directly to your Mac—a file server or file-sharing Mac, by contrast, is a remote hard disk that’s accessed across a Mac network.)

If you want to install from a CD-ROM disk or remote file server, you must of course use one that contains the System 7.1 installation files.

To install System 7.1 from a file server or file-sharing Mac, you must start up your Mac with a System 6 startup floppy that has AppleShare Workstation software installed on it, because you can’t connect to the remote server or file-sharing Mac without it. (See Installing from a file server below.)

### Putting Installer files on a local hard disk or file server

Before you can install from a local hard disk or file server, you need to load the System 7.1 installation files onto it:

1. Make a new folder on the hard disk or network server you’ll be installing from and name it Install Stuff.

2. Insert each of the System 7.1 floppy disks into your disk drive and then drag its icon on top of the hard disk or network server icon. The Mac will copy each floppy disk’s files into a folder with that floppy’s name.

3. Drag each folder created from a System 7.1 floppy into the Install Stuff folder.

### Installing from a file server

1. Create a System 6 startup floppy disk that contains enough system software to start up your Mac and log onto your file server. You’ll need to install basic system software and AppleShare Workstation software on the floppy. It could be a squeeze fitting all the files you’ll need on an 800K floppy disk, but you can do it if you delete all the printer drivers,
the Scrapbook file, any custom fonts and every DA except the Chooser and Control Panel from the System Folder and System file.

2. Restart your Mac from the new startup floppy and, if you haven't already, unbless your old System Folder using the procedure explained on p. 20, *Unblessing the current System Folder*.

3. Log onto the file server.

4. Open the Install 1 folder inside the Install Stuff folder on the server, then open the Installer program there. You can then continue the installation following the steps described on p. 22, *Installing from floppy disks*, except that you won't have to swap floppies during the process.

**Installing from a local hard disk or CD-ROM disk**

To install from a local hard disk or CD-ROM disk, you should use that disk to start up your Mac. If it isn't the one that usually does this, you can make it the startup disk by following the procedure under *Switching startup disks* on p. 40, Chapter 3. Then:

1. Restart your Mac.

2. Prepare the disk where you'll be installing System 7.1 (if you haven't already done so—see *Preparing for the installation* on p. 16).

3. When you're ready to do the installation, open the Install 1 folder inside the Install Stuff folder and then open the Installer program there. You can then complete the installation following the steps outlined in *Installing from floppy disks* on p. 22, but without having to swap floppies during the process.
If the installation fails

If the installation isn’t successful, you’ll see a message that tells you why. It’s usually because one of the files needed by the Installer is missing or damaged or there’s something wrong with the hard disk where you’re installing the new System Folder.

If the message says an Installer file or script is missing or damaged, make a new copy of the Installer files on your floppy disks, hard disk or network server and try the installation process again. If you get the same message, you may have a damaged version of the Installer files and will have to try a different set of Installer files from another source.

If the message says the hard disk isn’t working properly or can’t be located, try updating its driver using the setup software that came with it. (See Updating the hard disk driver on p. 26.) Then try the installation process again. If you still get a message that says the hard disk isn’t working, back up all the data on the hard disk, reformat it and try the installation once more.

When the Installer is finished

Once the Installer has done its work and you’ve restarted your Mac, you’re running under System 7.1.

If you updated an existing System Folder, System 7.1 will have moved all the old inits, DAs, cdevs and other system software files from the old System Folder to the new one.

If you installed System 7.1 using the method discussed at the beginning of this chapter, your System Folder will contain only the Apple-supplied system software, control panel files, printer drivers and networking files. Now you can reinstall the files you copied into the Stuff folder, and then move the fonts, DAs and sounds
from your old System file (if any) to the new System folder. Your new, intelligent System Folder makes both of these procedures relatively painless.

**Reinstalling old System Folder files**

First of all, reinstall the inits, cdevs, and other items that were directly inside your old System Folder, which was renamed Stuff when you prepared your disk for the System 7.1 upgrade. Not all the files in the Stuff folder may be compatible with System 7.1, so it's best to compare the items in the Stuff folder with the printed report from the Compatibility Checker, and then install the items in groups, according to how they rated for compatibility. Here's the procedure:

1. Restart your Mac if you haven't already done so.
2. Open the disk icon for your startup disk and make the window big enough for you to see the System Folder and the Stuff folder at the same time.
3. Open the Stuff folder and [Shift]-click to select all the files in it that were rated Compatible by the Compatibility Checker, along with any folders containing preferences files, dictionaries, glossaries and so forth.
4. Drag the selected contents from the Stuff folder onto the new System Folder icon. An alert message will appear:

```
These items need to be stored in special places inside the System Folder in order to be available to the Macintosh. Put them where they belong?
```

[Cancel] [OK]
System 7.1 only installs system software files automatically if you drag files on top of the System Folder icon, not if you drag the files inside the open System Folder itself. If you drag a file or folder into the open System Folder, System 7.1 assumes you know what you’re doing and doesn’t attempt to examine file types or arrange the files accordingly. Fonts, sounds and some init files may not work properly unless they’re inside the correct folder inside the System Folder.

5. Click the OK button. A dialog box will show you the progress of the files being copied. When they’re all done, another dialog box will tell you where they were put, like this:

```
8 fonts were put into the Fonts folder.
1 desk accessory was put into the Apple Menu Items folder.
1 control panel was put into the Control Panels folder.
```

Some of the files or folders from the Stuff folder may not be properly identified and the System Folder won’t know what to do with them. In this case, they’ll simply be placed inside the System Folder itself. It’s also possible that you’ll try to copy an older version of a standard Apple file from your Stuff folder, and that there’s a newer version already in the new System Folder. If you do this, the Mac will identify the file and warn you that you’ll be replacing a newer version with an older one. Make sure you want to do this; if you don’t, click the Cancel button and select a different group of files to drag.

6. Click the OK button.
7. Restart your Mac to make sure the files you’ve copied don’t cause any startup problems. (If you have problems restarting, see Chapter 3.)

8. Return to the Stuff folder, (Shift)-click all the files in it that were rated “Mostly Compatible” by the Compatibility Checker, and drag them onto the System Folder icon. Your Mac will install them as shown in steps 4–7 above.

9. Restart your Mac to make sure none of the files you dragged over this time causes any incompatibilities. (See Chapter 3 if you run into problems.)

10. Return to the Stuff folder again, and then drag any remaining items—the only ones left should have been rated Must Upgrade or Not Avail. by the Compatibility Checker—over to the System Folder icon one at a time, restarting the Mac after you install each item. This way, if an item is incompatible with System 7.1 and it’s going to cause a startup problem, you can identify the problem file right away.

At this point, you should have copied all the items from the Stuff folder, and you can delete the folder itself.

Reinstalling fonts, sounds, and DAs from the old System file

Now you can move any custom fonts, sounds and DAs from your old System file. Since fonts and sounds won’t cause any incompatibility problems that cause system crashes, you can install them all at once. With DAs, it’s best to check the Compatibility Checker report and install them in groups according to their level of compatibility, as with the Stuff folder above.

1. Locate your old System file and double-click on it to open its window. You’ll see all the fonts, DAs and sounds installed in it.

2. Drag any fonts, sounds, or DAs you want from the old System file’s window onto the new System Folder icon. You’ll see the same alert messages you did when you
dragged from the Stuff folder. Click the OK button to install the files.

Your old System file will contain some fonts, sounds and DAs that you don't need to copy because new versions of them have already been installed with the System 7.1 software. These include DAs like the Chooser, fonts like Geneva or sounds like Boing. You'll be warned if you're about to replace existing versions of these files inside the new System Folder—don't replace newer versions with the old ones from your old System file.

Since fonts, sounds and DAs won't cause your Mac to crash at startup, you don't have to restart the Mac after installing them to test for compatibility. Instead, try running each DA you install by double-clicking it to launch it. If the DA won't run, you'll know it's not compatible.

---

**Installing the QuickTime extension**

As mentioned in Chapter 1, QuickTime is an extra capability of System 7.1 that allows you to cut, copy, paste and play movies and sounds from within documents of programs that support it. After you've installed System 7.1 and are running under it, you can install the QuickTime extension file and then restart your Mac again to enable QuickTime. Once QuickTime is installed, you'll be able to use its features in programs that support it. (For more on using QuickTime in programs, see *Using QuickTime* on p. 165 in Chapter 9.)

Installing the QuickTime extension will increase the amount of memory your system software uses by about 400K. Make sure you can spare the memory in your Mac. If you have only two megabytes of memory in your Mac, QuickTime will take up more space than you can afford.
The QuickTime extension comes on a separate disk with its own Installer program. There are two different ways to install it: either drag the QuickTime extension file from the QuickTime disk to the System Folder icon on your hard disk, or launch the Installer program on the QuickTime disk and then use the Installer to install the file on your hard disk.

If you drag the QuickTime extension to your hard disk’s System Folder icon, you’ll see a message asking if you’d like the file placed in its proper folder. Click the OK button to install the file. You’ll then need to restart your Mac to activate the QuickTime extension.

If you use the Installer program, you’ll see an Installer dialog box like the one you saw when installing System 7.1 (see p. 23 above), and you can select your hard disk and then click the Install button to install it. Once the installation is complete, quit the Installer. Just as with dragging the Extension to install it, however, you’ll have to restart your Mac after the installation is finished to activate QuickTime.

---

**Installing WorldScript extensions and scripts**

*Note:* This section covers extra features of System 7.1 that allow the Mac to work properly with different language conventions. If you’re using the Mac outside the United States, some of these features may be installed automatically during a normal System 7.1 installation.

System 7.1’s WorldScript extensions allow you to select a language other than English as the primary language for keyboard layouts, measurement units, date, time and number formats, currency symbols, and sort order. With these extensions and the appropriate scripts and fonts installed, you can use a special Keyboard menu to select different scripts. (There’s also a special control panel program, Text, which lets you select the default
language and control how the Mac handles text—see *International control panels* on p. 145 in Chapter 8.)

**Installing WorldScript extensions**

There are two WorldScript extension files. WorldScript I handles languages in which characters can run in either direction, such as Arabic, Cyrillic, Greek, Hebrew, Persian and Thai. WorldScript II handles languages with picture characters, such as Chinese, Korean and Japanese. You need only install the WorldScript extension that handles the languages you want to use.

To install a WorldScript extension, locate the WorldScript I or WorldScript II folder, open it, and drag the extension onto the System Folder icon of your hard disk. The Mac will ask if you want the extension placed in the Extensions folder. Click the OK button.

**Installing scripts and font files**

After installing the WorldScript extension(s), just open the folder for the language you want, select all the contents, and drag them onto the System Folder icon of your hard disk. Click the OK button to have the Mac place all the files in their proper places.

**Activating WorldScript**

Once you’ve installed the WorldScript extension(s) and script and font file(s), you must restart your Mac to activate them. You’ll know WorldScript is active because there will be a new Keyboard menu between the Help and Application menus in your Mac’s menu bar. (For more on this, see *For WorldScript users* on p. 66 in Chapter 4.)

If you add new script or font files later, you’ll also have to restart your Mac before you’ll be able to select and use them.
Reclaiming disk space

Once you've installed everything, you can reclaim some disk space from your System Folder or elsewhere, especially if you used the Easy Install option.

For instance, from the System Folder you can delete any printer drivers that work with printers you don't use. This can easily save you a quarter of a megabyte or so since most printer drivers are from 40K to 100K in size.

Elsewhere on the disk, you can eliminate those utilities that have been upgraded in System 7.1 or aren't needed anymore. These include Apple File Exchange, Apple HD SC Setup, Disk First Aid, Font/DA Mover, LaserWriter Font Utility, CloseView and TeachText. You'll find new versions of all of these on one of the System 7.1 utilities disks.
CHAPTER

3

Starting Up

When you start your Mac up with System 7.1 installed, the procedure will be familiar: you'll see the "happy Mac" icon followed by the Welcome to Macintosh box and then the Finder desktop. If you get an error message or your Mac won't start up properly, the most likely cause is an incompatibility between it and some of the older system software files on your hard disk. In this chapter we'll look at how to solve common software compatibility problems, alternative ways to start your Mac and how to have programs automatically open when you turn it on.
**System software compatibility problems**

When your Mac won’t start properly after you install System 7.1, it’s probably because some of the inits, cdevs, DAs and other system software files you copied over to the new System Folder from your old one aren’t compatible with System 7.1. If you followed the installation procedure outlined under *The best way to install System 7.1* in Chapter 2, you should have identified and avoided such problems already. But if you do have trouble starting up from your hard disk, you’ll need to use a floppy disk instead. The Disk Tools disk in your set of System 7.1 installation floppies contains a System Folder you can use to start up your Mac.

**Startup incompatibilities**

If you run into an incompatibility problem that prevents your Mac from starting up, you can isolate and repair it as follows:

1. Restart your Mac from your System 7.1 Disk Tools disk.

2. Open the System Folder on your hard disk and then open the Extensions folder inside it.

3. Drag all your old inits (or *system extensions*, as they’re called under System 7.1) completely out of the System Folder. (Don’t just drag them outside the Extensions folder and into the System Folder, because the Mac may try to load them at startup again.) Check the Control Panels folder for init files too, and drag any inits in there outside the System Folder.

   **Tip**

   If you have Extension Manager, INITPicker version 2.02 or later, or another System 7.1-compatible extension management program, it’s easier to turn your extensions off with that instead of moving them.

4. Restart the Mac from the hard disk. If it starts up fine, try reinstalling the inits by dragging them inside the Extensions
folder one at a time, restarting the Mac after each one, until you see which one is causing the problem. Get rid of the problem extensions—trash them or at least keep them out of the System Folder.

If your Mac still won’t start up after you’ve removed all the old inits:

1. Update your hard disk’s printer driver using whatever setup software came with the hard disk—the Apple HD SC Setup program if it’s one of Apple’s disks.

2. Try reinstalling the system software again.

If these remedies fail, consult your local computer guru or Apple dealer.

Running incompatibilities

Once you have System 7.1 running, try out all your old inits, control panel files, DAs and FKey programs one at a time. Some may cause the Mac to display a message telling you the program doesn’t work. Others may simply cause your Mac to crash.

If a program doesn’t work properly, it’s probably incompatible and it’s best not to use it. If you really don’t want to give the program up, call the manufacturer and explain your problem—there’s probably a newer version that works with System 7.1.

Starting up with more than one hard disk connected

If you have more than one hard disk connected to your Mac and each has a System Folder, you can choose which to use as the startup disk.
Starting up

Startup disk scanning order

Normally, the startup disk is determined by the SCSI scanning order. The Mac searches the various storage devices connected to it, looking for a System Folder to start up with. This is the sequence:

- First the Mac looks in any internal or external floppy drives.
- Next it looks on the internal hard disk (if any).
- Finally it looks on external hard disks.

Each hard disk has a unique SCSI address from 0 to 6. To choose among external hard disks, the Mac looks first at the one with the highest numbered address, then at those with lower numbers. Each SCSI hard disk must have a unique address or the Mac will get confused and probably won't start up at all.

The Mac can't "see" external hard disks unless they're turned on and warmed up, so you should turn on any external hard disks a few seconds before you turn on your Mac to start it up.

If you've just installed System 7.1 on one of two or more hard disks connected to your Mac, you may need to switch the startup disk to the one containing the System 7.1 software.

Switching startup disks

To have your Mac to start up from a hard disk that wouldn't normally be first under the sequence shown above, you must use a control panel program to designate a different one. Here's how to change the startup disk:

1. Open the Control Panels folder inside the System Folder.
2. Doubleclick on the Startup Disk icon. You'll see a control panel like the one shown at the top of the next page:
3. Click on the icon representing the startup disk you want.

Unless you reset the startup disk again, your Mac will start up from this disk from now on.

In older versions of the system software, you could switch control of the Mac from the System file on one startup disk to the System file on another by holding down the (Shift) and (Option) keys and doubleclicking the System file you wanted to switch to, rather than restarting the Mac. This does not work under System 7.1.

---

**The Desktop and Trash folders**

When you install System 7.1 on a hard disk, it creates two folders called the Desktop folder and Trash. The Mac uses these folders to keep track of files located on the desktop and in the Trash. These folders are invisible on the disk from which you start your Mac, but they are visible on any other hard disk whose icon appears on your desktop (as long as that hard disk has System 7.1 installed on it). These folders are also visible if you start your Mac using System 6 or earlier software.
Starting up

When you see these folders on a disk, just ignore them. Don’t move or delete either folder, particularly if there are files in them. If you delete these folders, you’ll delete the files they contain (although the folders themselves will be replaced the next time you start up under System 7.1).

Opening files automatically at startup

Although the Mac normally starts up with the Finder, you can set it to start up and automatically load one or more additional programs, documents, DAs or control panels. Anything you set to load automatically this way is called a startup item.

In older versions of the system software, you used the Set Startup... command on the Finder’s Special menu to designate startup items. Under System 7.1, this has been replaced by the Startup Items folder in the System Folder (see The Startup Items folder in Chapter 7, p. 120).

Using aliases as startup items

If you transfer documents or programs to the Startup Items folder (so they’ll load automatically), you’ll have to navigate to that folder—way down inside the System Folder—whenever you want to open any of those items from the desktop. Normally, it’d be more convenient to store these things at a higher level on the disk.

But in fact, you don’t have to choose between making a startup item and leaving the item in a more convenient place on your disk. You can create an alias and place it inside the Startup Items folder, keeping the real document or program stored in a more logical place. (For more on aliases, see The Make Alias command on p. 77 of Chapter 5.)
PART 2

The Finder and its menus
CHAPTER 4

Working with the Finder

When you first look at the desktop after starting up under System 7.1, most of the Finder's new features won't be immediately obvious, although you'll see that the icons look a little different and that there are some new menus on the menu bar. The best way to learn the new features is to try them out, so click away. The Mac's system software has always been really good at protecting you from doing something destructive by accident, and System 7.1 is even better.
Depending on your level of expertise with the Mac, you may not even need a lot of the descriptions that follow. If you're less experienced, trying out new features as they're explained below will make them easier to understand.

This chapter covers changes in the way you use the Finder to manage disks and files. New commands on the Finder menus and new menus are covered in detail in Chapters 5 and 6.

---

**Familiar features, subtle changes**

Apple's big challenge in improving the Finder was to make it more powerful without changing it so much everybody had to relearn it. They've done a good job keeping changes to the desktop small.

The Finder still uses menus, windows and icons to let you work with disks and files. The basic point, click and doubleclick actions you use to open disks or folders are the same as ever, except for a change in selecting icon names, which is covered in the next section.

The familiar , File, Edit, View and Special menus are still there, but with a new Label menu between View and Special; and there are new Help and Application menus indicated by icons at the right end of the menu bar, like this:

If you're using WorldScript, there's also a Keyboard menu between the Help and Application menus. See For WorldScript users on p. 66 at the end of this chapter.

Also, you're likely to find some new commands (or miss one or two old ones) when you pull down a familiar menu. On the menu, for instance, each name now has an icon next to it. The *About the Finder...* command is now *About This Macintosh...*, and
the window you see when you choose this command is slightly different:

![About This Macintosh](image)

This window shows each program you're running and how much memory it's using, as well as the total memory in your Mac and the size of the largest unused block.

About this Macintosh always lists open programs and DAs in alphabetical order, not in order of size or when they were opened.

Selecting is different

Under the old system software, clicking once on an item also selected that item's name for editing. Apparently, too many people were hitting a key while an item was selected and accidentally renaming items as a result. The System 7.1 Finder makes it harder to do that.

There are now two ways to select an item:

- click on the item's name (which selects the name for editing)
- click on the item itself to select it but not the name

When you select the item name, you've also selected the item (but not vice versa). So if you choose Open from the File menu when a program icon's name is selected, for example, that program
Working with the Finder

will be opened. You can toggle between selecting just the icon and selecting both by pressing Return.

When an item name is selected, a box appears around it, like this:

You can then edit the name as you used to in System 6—just begin typing if you want to retype the whole name, or click between two letters to move the insertion point and edit the existing name. To complete the change, either click away from the icon name or hit Return.

It can be hard to click at the very beginning or end of a name to move the insertion point there, but pressing the right or left arrow key does the same thing.

The Finder works like MultiFinder

The biggest overall operational change in the Finder is that the capabilities of MultiFinder have now been built in.

Loading multiple programs

If you never used MultiFinder under System 6, you just need to know that it lets you load several programs at once and switch between them quickly. This is a lot faster than loading a program from the Finder, quitting it and then loading another one. The Finder itself remains running when you load other programs, so you can switch to it to manage disks and files without having to quit another program. Although you can load several programs, only one of them can be active at a time.
With the System 7.1 Finder, you can load as many programs or DAs as your Mac's memory will permit. As you open these applications, they're added to the Application menu (see Chapter 6, p. 100, for information about the Application menu).

**What's different from MultiFinder**

If you've used MultiFinder, you'll notice that the System 7.1 Finder handles some things differently. You can still click in a program's window on the desktop to switch to that program instantly, but now, instead of having to click on a particular icon to switch to the Finder, you can click anywhere in the open space on the desktop.

The application icon at the right end of the menu bar still shows you which application is currently active, but clicking on it now reveals the Application menu, from which you choose programs.

**Managing memory**

Each application or DA you open takes up a certain amount of memory. It informs the system software how much memory it needs, and that quantity is reserved for that program and its documents. If there isn't enough memory left to open a program, you'll see a message saying so. As shown a couple of pages ago, the About This Macintosh... command on the * menu shows how much memory each of your open programs is using and how much memory is still available.

If you open a lot of large documents with a program, you may exceed the amount of memory that's been set aside for it. In this case, you'll usually get a warning that you need to close some documents. (Sometimes, though, the program will quit unexpectedly or—in extreme cases—your Mac will crash instead.)

If you frequently exceed an application's allotted memory, you can change the amount of memory set aside for it by using the Get
Info command on the File menu (see Chapter 5, p. 71, for more information on Get Info).

When applications quit unexpectedly (or they won't open due to lack of memory) even though the About This Macintosh... window says there should be enough memory for them, you're probably experiencing memory fragmentation. See Managing program memory on p. 150 in Chapter 9 for more on this.

Printing in the background

If you have a LaserWriter, the System 7.1 Finder can print documents in the background, allowing you to get on with other work while your document is fed to the printer.

To turn on background printing:

1. Select Chooser from the menu. The Chooser window appears as shown at the top of the next page.

2. Select the LaserWriter icon from the box on the left. The LaserWriter name appears in the right-hand box.
3. Click on the name of the LaserWriter you want to use, and then click the On button for background printing. After this, background printing will remain on until you turn it off.

For more information about background printing, see Chapter 10, p. 178.

Tip

Whenever you change printers with the Chooser, the Mac shows an alert message reminding you to check the page setup of your documents, since they might be different with the new printer.

Icon cosmetics

If your Mac’s monitor can display 16 or more colors or shades of gray, and it’s set to do that, the icons on the desktop have a shaded, three-dimensional effect. (To set your monitor to display colors or shades of gray, choose Control Panels from the menu, then doubleclick the Monitors icon inside the Control Panels folder. If your system is capable of this feature, you can turn it on in the Monitors control panel.)
If you have a color system, you can use System 7.1's Label menu to change the color of any icon on the desktop so you can manage files and folders more easily. Unlike System 6's Color menu, the Label menu's colors can be changed to any of the colors available in the Mac's color palette. (See The Label menu, Chapter 6, p. 90 for more information.)

System 7.1 also lets you replace icons with your own graphics (see The Get Info command in Chapter 5, p. 71).

**Window changes**

The Finder's windows behave a little differently under System 7.1. Let's look at the changes by working our way from the edges of a typical window toward the middle, starting with the title bar.

You'll see the window title, close box and zoom box in the title bar as before, but the title and zoom box work differently.

**Pop-up window path**

When you hold down ⌘ and click on a window's title in the Finder, you'll see a pop-up menu showing that window's directory path, like this:

- Hold down the mouse button and you can drag down this menu to select any other folder or the disk on the directory path to open or activate its window in the Finder.
**Zoom works better**

Clicking the zoom box now makes a window just large enough to show everything it contains. (Under System 6, the window opened to its maximum size, even if it contained only one item, often obscuring everything else on your desktop.)

As with System 6, clicking the zoom box a second time returns the window to its previous size.

**New information, new ways to sort**

The list view windows now include a new Label category so you can sort by item labels. (This new category—which you can see between the Kind and Last Modified columns in the example below—replaces the old Color sort category on color Macs.) By selecting an item and choosing one of seven labels from the Label menu in the Finder, you can put documents or folders into different categories. You can easily change the names and colors of labels with the Labels control panel (see *The Label menu* in Chapter 6, p. 90).

![Tip](image)

To quickly see how a list view window is sorted, look for the column heading that's underlined. To sort on a different category, just click on that category name.
Outline view

More importantly, list views can have an outline structure that shows several organizational levels of your disk at once. Here’s how this works.

Notice the triangle next to the folder in the window above. If you click this triangle, the folder’s contents will appear in a list immediately below it in the current window, like this:

Now you are looking at items from two different organizational levels in the same window. (To indicate this, the triangle now points down instead of to the right.)

You can also select items from inside and outside a folder at the same time, like this:
Selecting groups of items in list views

Another nice change to the list views in System 7.1 is being able to drag the pointer across several folders or documents to select them as a group. Try it and see. (Before System 7.1, (Shift)-clicking was the only practical way to select more than one item in a list view window.)

Selecting items by typing

If you're more comfortable with the keyboard than the mouse, you can also select individual items in any Finder window by typing the first letter (or first few letters) of the item's name. When you know the name of the item you want, this is faster than hunting through a crowded window with the mouse. You can even open items by pressing keys—see Keyboard shortcuts at the end of this chapter for more information.

Customizing window layouts

System 7.1 offers lots of easy ways to customize the appearance of windows in the Finder. You can choose the font and font size for text displayed in windows, change the format of modification dates or times, arrange icon views in a straight or staggered grid, calculate folder sizes and much more. These options are available through the Views control panel (don't confuse it with the View menu on the Finder) and the Date & Time control panel. You'll find a complete discussion of these programs in Chapter 8.

Automatic scrolling

With System 6, when you wanted to move a document into a folder in the same window, and the window wasn't big enough to show both, you had to resize or scroll the window to bring both items into view. Automatic scrolling ends this hassle. Now when you drag a document to within 1/8" of the edge of a window and hold it there for a second, the window automatically scrolls in the direction you're dragging. (Be careful not to drag past the window's edge—if you do, the Mac will assume you're moving the
item to a different window and it won’t automatically scroll the window you’re dragging from.)

Unfortunately, automatic scrolling only works within a window, not from one window to the next. If you select items in one window and want to drag into a folder that’s out of view inside another window, you have to select the destination window first and move the folder into view.

If you’ve already selected the items you want to drag before you realize you need to scroll another window to see the destination folder, you can scroll that window without de-selecting the items you’ve already selected: just hold down Control and select the destination window. The item you selected originally will remain selected.

### Other file management changes

#### Opening files

You can still open a file by doubleclicking its icon or choosing Open from the File menu. But System 7.1 also lets you open a document by dragging its icon on top of the icon for any program that can open it, not only the one you used to create it.

Here’s an example. Let’s say you want to view a Microsoft Works document with Microsoft Word. Instead of opening the Word program, and then the Works file from the File menu, you can simply drag the Works file on top of the icon for Microsoft Word in the Finder. Word will then load and automatically open the Works file.

When Apple comes out with its QuickDraw GX print enhancements in 1993, you’ll be able to print on different printers by dragging and dropping documents onto printer icons on the desktop.
This little trick only works when the application you want to use isn’t currently running. (Obviously, if the program is already running, it’s no extra step to open the document with the program’s Open command.) If you drag a document to a program icon and the program can’t open that type of document, you’ll see a message telling you so.

As previously mentioned, you can also open documents or programs automatically when you start up your Mac by dragging them inside the Startup Items folder in the System Folder (see Opening files automatically at startup, Chapter 3, p. 42 or The Startup Items folder in Chapter 7, p. 120).

**Copying and moving files**

You still drag files to move them from one place to another in the Finder, but System 7.1 offers some new capabilities here as well, and it fixes a nagging problem.

In older system software versions, clicking an item you wanted to move would also activate the window containing it. And that sometimes covered up the folder you wanted to drag to. Look here, for example, at the following windows:

```
<table>
<thead>
<tr>
<th>Doris' Stuff</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 items</td>
</tr>
<tr>
<td>DISCOVER Facts</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scouting Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 items</td>
</tr>
</tbody>
</table>
```
Under System 6 you couldn’t drag the Scouting document from its present location into the Scouting Info folder, because the Doris’ Stuff folder would become active as soon as you selected the document, and would cover up the Scouting Info folder.

But under System 7.1, if you hold down the mouse button when selecting a document, it won’t activate the folder containing it, and so the destination folder isn’t covered up. This is a great example of how System 7.1 makes things work the way they always should have.

Finally, there’s a new alert box that warns you when you’re about to overwrite a file with the same name. Now, this alert usually tells you whether the file you’re about to overwrite is older or newer than the one you’re saving, like this:

An older item named “Budget 93” already exists in this location. Do you want to replace it with the one you’re moving?  

Cancel  OK

If the two items have the same modification date and time, the alert box doesn’t mention the older/newer distinction, because there isn’t one. And, if you copy more than one item at a time, the Mac doesn’t attempt to evaluate whether each item in the group is older or newer than one it replaces, it just says there are items with the same name on the destination disk.

Deleting files

The Trash no longer empties itself automatically when you eject a disk, restart or shut down your Mac. You still see a warning when you drag any program or system software file to the Trash, which you can still disable by holding down Option as you select and drag the item. But now you’ll also see a further warning when you try to empty the Trash:
The Trash contains 65 items, which use 1.8 MB of disk space. Are you sure you want to permanently remove these items?

[Cancel] [OK]

If this annoys you as much as it does me, you’ll be relieved to know you can turn it off. See The Empty Trash command in Chapter 6, p. 96 for details.

---

**FKeys**

The combination of Shift and any of the number keys in the top row of the keyboard are designated in the system software as FKeys (Apple shorthand for function keys). Each combination performs the same function every time, no matter which program or window is active.

In this section, we’ll focus on the four FKeys that have already been defined by Apple in System 7.1. (Programs for other FKeys have been developed by hobbyist programmers and small software companies. You can find out about them from your local user group. You can also assign tasks to the other number keys with a macro program like QuicKeys 2.)

**Ejecting floppy disks**

Two of these FKeys work the same as they always have:

- Shift ejects the floppy disk in the internal drive (or the upper or left drive if you have two).
- Shift ejects the floppy disk in the external drive (or the lower or right drive if you have two).
Now, you can also eject a floppy disk from a third floppy drive (if you have one), by pressing `Shift+3`.

**Note:** If you already have a floppy disk selected in the Finder, you can press `Shift+3` as usual, which is the same as choosing *Eject Disk* from the Special menu in the Finder. But while this ejects the floppy disk, it doesn't work with hard disks or network servers, and when it ejects the floppy it leaves a ghost of the disk's icon on the desktop, like this:

![Floppy Disk Icon](image)

The best way to remove disks from the desktop is by pressing `Command+Y` (the *Put Away* command on the File menu)—this ejects any disk (hard disk, server, floppy or CD-ROM) and removes its icon from the desktop. It's just like dragging the icon to the Trash.

**Taking screen snapshots**

As before, the fourth FKey, `Shift+3`, takes a snapshot of your Mac's screen and saves it as a file in the main window (or directory) of your startup disk, but this feature has been improved in several ways:

- Screens are now in PICT format, rather than MacPaint format, so you can capture color screens as well as monochrome ones, and you can capture any size screen. (Old screen snapshots were limited to about 8 x 10 inches.) The PICT format also makes it easier to open or use snapshot files with other programs.

- Snapshot files are now named *Picture 0*, *Picture 1*, and so on, numbered sequentially, rather than *Screen 0*, etc.

- You can take as many snapshots as you want, provided you have the disk space—you no longer have to stop at *Screen 9*. 
• You can now open these files with the System 7.1 version of the TeachText program (on one of your utilities disks).

• You can then select part or all of the image, copy it to the Clipboard, then paste it into the Scrapbook or into a document from another program.

---

### Keyboard shortcuts

You can use these keyboard shortcuts to do a lot of things you'd normally do with the mouse. You may be familiar with the old shortcuts, but the System 7.1 Finder has some really nice new ones.

The following descriptions are pretty brief—you really have to try these to appreciate how useful they are. (See F.Keys, above, for other shortcuts.)

#### Selecting icons on the desktop

These shortcuts select icons that are directly on the desktop, such as disks, the Trash, or document or program icons you've put there. They also work for selecting items inside windows.

<table>
<thead>
<tr>
<th>SHORTCUT KEY</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>an arrow key</td>
<td>selects the next item in that direction</td>
</tr>
<tr>
<td>Tab</td>
<td>selects the next item in alphabetical order by name</td>
</tr>
<tr>
<td>a letter key</td>
<td>selects the first item whose name begins with that letter</td>
</tr>
</tbody>
</table>
The third shortcut, pressing a letter key to select the first item that begins with that letter, also works inside directory dialog boxes you see when you use Open or Save As from inside a program. In fact, you can be more specific about selecting items this way by typing more than the first letter of an item’s name. You could select “Proposal” instead of “Potential Sales” by typing “pr” instead of “p,” for example. It doesn’t matter whether you type upper- or lower-case letters.

Navigating folders or windows

When you’ve got your disk organized so folders are inside folders that are inside other folders, you can use these shortcuts to navigate up and down the folder hierarchy (or directory path) or to open and close windows quickly. These select different folders in a window, or different nested windows on the desktop. Try them out for yourself.

<table>
<thead>
<tr>
<th>SHORTCUT KEY(S)</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘↑</td>
<td>opens the folder that contains the current folder or selects it (if it’s already open)</td>
</tr>
<tr>
<td>Option ⌘↑</td>
<td>opens the folder that contains the current folder and closes the current folder window</td>
</tr>
<tr>
<td>⌘↓</td>
<td>opens the selected item</td>
</tr>
<tr>
<td>Option doubleclick icon</td>
<td>opens the selected icon or folder and closes the current folder or window</td>
</tr>
<tr>
<td>Shift ⌘↑</td>
<td>selects the desktop itself (deselecting everything else)</td>
</tr>
<tr>
<td>⌘→</td>
<td>shows outline view of selected folder’s contents</td>
</tr>
<tr>
<td>⌘←</td>
<td>hides outline view of selected folder’s contents</td>
</tr>
<tr>
<td>Option ⌘→</td>
<td>shows outline view of active window</td>
</tr>
</tbody>
</table>
Working with the Finder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ +</td>
<td>hides outline view of active window</td>
</tr>
<tr>
<td>⌘ click zoom box</td>
<td>expands a window to the maximum size it can be on the screen</td>
</tr>
<tr>
<td>⌘ click on desktop</td>
<td>switches to the Finder and hides the current application’s windows from view</td>
</tr>
<tr>
<td>⌘ drag icon</td>
<td>reverses the current setting of the always snap to grid checkbox in the Views control panel while moving the icon (See The Views control panel on p. 135 in Chapter 8.)</td>
</tr>
</tbody>
</table>

Also navigates you up in the folder hierarchy when you’re in a directory dialog box that you see when you use Open or Save As in a program. ⌘ + moves you up one level, so you’ll see the contents of the folder that contains the folder you’re currently viewing. To move down the hierarchy, so you open up a folder in the current directory, just select the folder and press Return or Enter.

Dialog box shortcuts

These three shortcuts help you deal with dialog boxes more quickly.

<table>
<thead>
<tr>
<th>SHORTCUT KEY(S)</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>moves the insertion point from one option to another in a dialog box</td>
</tr>
<tr>
<td>Return or Enter</td>
<td>clicks the heavily outlined button in a dialog box</td>
</tr>
<tr>
<td>⌘ Esc</td>
<td>clicks the Cancel button in a dialog box</td>
</tr>
</tbody>
</table>

In many programs, you can also press ⌘ and the first letter of a dialog box option to select that option.
File menu command shortcuts

These shortcuts let you select File menu commands by using the keyboard.

<table>
<thead>
<tr>
<th>SHORTCUT KEY(S)</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ô×ÈÔ¼</td>
<td>New Folder</td>
</tr>
<tr>
<td>Ô×ÄÒ</td>
<td>Open</td>
</tr>
<tr>
<td>Ô×ÒÈ</td>
<td>Print</td>
</tr>
<tr>
<td>Ô×ÍÔ</td>
<td>Close Window</td>
</tr>
<tr>
<td>Ô×Î</td>
<td>Get Info</td>
</tr>
<tr>
<td>Ô×Ç</td>
<td>Duplicate</td>
</tr>
<tr>
<td>Ô×È</td>
<td>Put Away</td>
</tr>
<tr>
<td>Ô×Í</td>
<td>Find</td>
</tr>
<tr>
<td>Ô×Ô</td>
<td>Find Again</td>
</tr>
</tbody>
</table>

Edit menu command shortcuts

Here are the shortcuts for the Edit menu commands.

<table>
<thead>
<tr>
<th>SHORTCUT KEY(S)</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ô×ÈÔ×È</td>
<td>Undo</td>
</tr>
<tr>
<td>Ô×Ô×È</td>
<td>Cut</td>
</tr>
<tr>
<td>Ô×ÇÈ</td>
<td>Copy</td>
</tr>
<tr>
<td>Ô×ÍÈ</td>
<td>Paste</td>
</tr>
<tr>
<td>Ô××Ô</td>
<td>Select All</td>
</tr>
</tbody>
</table>
Special menu command shortcuts

Here are some shortcuts and special features of commands on the Special menu.

<table>
<thead>
<tr>
<th>SHORTCUT KEY(S)</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option Clean Up By Name</td>
<td>sorts the icons in an icon view window in alphabetical order, and aligns them in rows on an invisible grid—a window must be selected for this to work</td>
</tr>
<tr>
<td>Option Clean Up All</td>
<td>arranges all icons on the desktop except the Trash in a column in the upper right corner of the screen, puts the Trash in the lower right corner of the screen—the desktop itself (or an icon on it) must be selected for this to work</td>
</tr>
<tr>
<td>Option Empty Trash</td>
<td>stops the warning box from showing when you empty the Trash</td>
</tr>
<tr>
<td>⌘ E</td>
<td>ejects the selected floppy disk</td>
</tr>
</tbody>
</table>

Other shortcuts

Finally, these shortcuts help with other Finder activities.

<table>
<thead>
<tr>
<th>SHORTCUT KEY(S)</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option drag item</td>
<td>copies item instead of moving it</td>
</tr>
<tr>
<td>Option click close box (or Option ⌘ W )</td>
<td>closes current window and all other windows on the desktop</td>
</tr>
<tr>
<td>⌘ drag window by its title bar</td>
<td>moves window without making it active</td>
</tr>
<tr>
<td>⌘ click a window title</td>
<td>shows the directory path of that window</td>
</tr>
</tbody>
</table>
Option while starting up, rebuilding the desktop file
mounting a hard disk, or inserting a floppy disk.

Shift while starting up prevents any extension files (inits)
from loading during startup

---

For WorldScript users

If you have one or both of the WorldScript extensions and one or more language script and font files installed, there will also be a Keyboard menu (signified by a flag icon) between the Help and Application menus, like this:

The icon's flag changes, depending on which language script you have installed. When you pull down this menu, all the keyboard layouts or the scripts you have installed on your Mac are listed, but only the keyboard layouts for the U.S. and for the currently active script are available. The current layout is checked. In the example at the top of the next page, the Arabic script is active, so the Keyboard menu icon is a crescent moon and the active options on it are the Arabic and U.S. ones.
For more information on the U.S. layouts and why there are two of them, see *Keyboard* on p. 132 in Chapter 8.
CHAPTER 5

File and Edit menu commands

The File menu has undergone significant changes in System 7.1, while the Edit menu looks exactly the same but may, in certain applications, contain new commands to take advantage of System 7.1's new publish and subscribe feature. ➤
The File menu

We'll look at these commands in the order in which they appear on the File menu.

Some commands are the same

The New Folder, Open, Print and Close commands work the same way, although the Close command is now called Close Window to more accurately describe what it does (anything you can close with this command is a window). The Duplicate, Put Away and Page Setup and Print Window... commands are the same.

The Print Window.../Print Desktop... command used to be called Print Directory.... Again, the new command names more accurately describe what this command does. If a window or an item inside it is selected, the command name is Print Window... and choosing it prints a list of the window's contents, just like a List view. If the desktop itself or an icon on the desktop is selected, the command name is Print Desktop... and choosing it prints a graphic view of the desktop as it currently appears.

There are a couple of changes to the dialog box you see when you choose the Print... command, but we'll cover these in Chapter 10 along with other printing details.

Some commands have been moved or eliminated

Two File menu commands from System 6 are no longer on this menu. The Get Privileges... command is gone. If you're an Apple-Share user, you can now view folder privileges with the new Sharing... command, which we'll get to on p. 76 in this chapter and in Chapter 12, p. 211.

You may notice that the Eject command is missing. It has been renamed Eject Disk and moved to the Special menu.
The Get Info command

The Get Info command displays information about any item whose icon you select in the Finder. A different information window will appear depending on whether you've selected a program, a document, an alias or a storage location (a folder or disk). The one new feature all these windows share is that you can change the icon of the item they describe.

Customizing icons

If you want to change an icon:

1. Select a graphic (or prepare your own using a paint or draw program) and copy it to the Clipboard.

2. In the Finder, select the program, document, alias or volume whose icon you want to modify, and choose Get Info. The item's information window will be displayed.

3. Click on the icon in the information window. A box will appear around it. (If no box appears, then you can't change that particular item's icon.)

4. Choose Paste from the Edit menu. The new icon will replace the old one. (If it doesn't, make sure the Locked checkbox isn't checked and try again.)

You can customize folder icons, too, but when you do the Mac will no longer change the folder icon according to the folder's file-sharing status. See folder privileges icons on p. 235 in Chapter 13.

Program information

When you select an application and choose Get Info, you'll see a window like the one at the top of the next page:
This window is for applications only, not for DAs, control panels or other system software, because applications let you adjust the requested memory and those other types of program don’t.

The Version category right above the Comments box is the same as in System 6 (as before, when programs don’t make their version information available to the system software, this area will say not available).

In the Memory Requirements section at the bottom, the names have changed from Suggested memory size and Application memory size to the simpler Suggested size, Minimum size and Preferred size. The suggested size is the amount of memory the application would normally ask for, and if you haven’t modified the lower two boxes, it’s the same as the Preferred size.

If you use big documents with an application, however, you may need to provide more memory for it. To do this, click the Preferred size box and enter a larger number. (It’s best to up the
ante by at least 20 percent, so if a program asks for 512K in the Suggested size box, try entering at least 640K in the Preferred size box.) Then close the window, and the new memory limit will be in effect the next time you open the program.

The Minimum size box lets you specify an alternate amount of memory to allow the program if the preferred size isn’t available. The minimum size is set automatically by the software when you first use the Get Info command, and you should only specify a higher minimum size if you change this value. If you try to specify a lower minimum value than the default, you’ll see an alert message and the program probably won’t run at all, or it will quit or crash unexpectedly later.

The nice thing about the minimum size is that it gives you two different options for memory size. If you’d really like to have 1024K set aside for FileMaker Pro but you’d settle for 768K, you’d enter 768 in the Minimum size box and 1024 in the Preferred size box. If the Mac didn’t have 1024K available, it would allow you 768K.

As with System 6, you can lock a program by checking the Locked checkbox (now relocated to the lower left corner of the window).

Locking a program prevents it from being changed or erased, but it’s not always a good idea, because some programs don’t work properly when they’re locked.
Document information

When you select a document and choose Get Info, you’ll see a window that looks like this:

Like the window for applications, this one shows information about the file’s location, kind, size, creation and modification dates and version. But notice the Stationery pad checkbox in the lower right corner (which is an option only for documents). It lets you turn a document into a stationery pad—a template which will always open as a new document.

For more information about this feature, see Using stationery in Chapter 9, p. 161.
Alias information

The information window that appears when you select an alias and choose Get Info is slightly different from the one for documents:

When you need to locate the file that an alias represents, click the Find Original button. The Mac will search for the original and then select it on the desktop (see The Make Alias command on p. 77 in this chapter for more information).

You can change aliases' icons or lock them using the information window. Changing an alias's icon doesn't affect the original file it represents.

Locking an alias really only protects its icon and title (and prevents the alias itself from being deleted); you can modify or even delete an original while the alias is locked.
Folder or disk information

When you select a folder or a disk and use Get Info, you'll see a window like this:

Since this is a storage location rather than a file, there's no version information, and you don't have options to lock the folder or turn it into stationery.

The Sharing... command

The Sharing... command lets you make selected folders or even entire disks available to other Mac users on an AppleTalk network. You can also use it to view the access privileges for any shared disk or folder on the network.

File sharing gives you lots of options for sharing your files with others. Turn to Chapter 12 for a full discussion of this powerful new feature.
The Make Alias command

An alias is a stand-in file that allows you to open a real file, folder or disk by remote control. When you open an alias, it opens the real item that the alias represents.

This simple command can make it a lot easier to locate and open programs, documents, folders or disks on your Mac.

Making an alias

The procedure for making an alias is simple:

1. Select an item in the Finder or a Finder window.
2. Choose the Make Alias command from the File menu. An alias of the item immediately appears, overlapping it like this:

Notice that the alias's name is selected. When you first create it, an alias is always given the name in italics of the item you originally selected plus the word alias. You can, though, change the name to anything you want. The alias has the same icon as the item it represents.

Usually, you'll just want to delete the word alias from the end of an alias name. Remember to move the alias to a different folder from the original item before you do this (the Mac won't let you give one item the same name as another in the same folder).
There are two ways to tell an alias from a real item:

- An alias name always appears in italics on the desktop.
- An alias’s Kind designation in a list view window or in the Get Info command’s information window is always alias.

**Using an alias**

Once you create an alias, you can treat it like a normal file. You can:

- doubleclick it to open the item it represents
- copy items to it or open items inside it
- rename its icon just as you would any other icon (this doesn’t rename the original file)
- duplicate, copy or move it to any other location on your Mac’s desktop, such as another folder or another disk
- select it and use Get Info to display its information window
- drag it to the Trash when you don’t need it anymore
- lock it to prevent it from being deleted and to prevent changes to its name or icon

**Tips for using aliases**

Because you can make several aliases for the same item and copy them anywhere, aliases make it much easier for you to find and open items you use a lot. And they take up very little disk space (usually only 1K or 2K).

System 7.1 comes with one alias already set up: the Control Panels alias inside the Apple Menu Items folder. The real Control Panels folder is inside the System Folder, but you can open it by choosing this alias from the menu. Below are some other ideas for using aliases.
Application aliases  Most people store all their applications in the same folder. This makes organizational sense, but it means you have to open that folder every time you want to open a particular program. To avoid this problem, you can:

- make an alias of a program and put it on the desktop
- put aliases of programs you use every day in the Startup Items folder inside the System folder. Then they’ll be opened each time you start up your Mac.

DA aliases  DAs stored in the Apple Menu Items folder appear on the menu, so they’re already pretty accessible, but since you can now open DAs by doubleclicking them, you can also make an alias of any DA you use a lot and put it on the desktop.

Control panel aliases  If you use certain control panels frequently, put aliases of them in the Apple Menu Items folder so you can open them directly from the menu.

A Clipboard alias  Some programs have a Show Clipboard command so you can see the contents of the Clipboard at any time. But if the programs you use don’t have such a command, make an alias of the Clipboard file in the System Folder and then place it inside the Apple Menu Items folder. After that, you can choose the Clipboard alias from the menu at any time, and it will open a window showing you what’s on the Clipboard.

Folder aliases  Try these ideas with folders you use a lot:

- Put a folder’s alias in the Apple Menu Items folder, so you can open it from the menu. (You can even make an alias for the Apple Menu Items folder itself, so you can open it from the menu when you want to add or remove items.)
- Put an alias on the desktop so you can drag things into or out of the folder there, without having to open other folders to get to it.
• Put a folder’s alias inside any other folder where you normally work. That way you can avoid navigating through folders in your programs’ Open or Save dialog boxes when you’re opening from or saving to that folder.

**Shared folder aliases** To connect to a shared folder over a network, you normally have to use the AppleShare resource in the Chooser and then enter your name and password. But if you make an alias of a shared folder or disk, you’ll go directly to the user login dialog box when you open the alias; or—if no password or user name is required to connect to the shared item—the item will be automatically placed on your desktop. (See Chapter 12 for more information about connecting to shared folders and disks.)

**Disk or Trash aliases** You can even make aliases of hard disks or the Trash and put them in more convenient places—like the Apple Menu Items folder (so you can open them from the menu).

There are lots of uses for aliases, so explore a few of them for yourself. You can’t hurt anything by creating an alias, and you can always get rid of any you don’t want by dragging them to the Trash; your original file stays where it is.

**Aliases that don’t make sense**

You can make an alias of any item on the desktop, but some aliases just don’t serve any purpose. Since aliases are easy ways to open a file or access a folder, you don’t need aliases for any files or folders you don’t interact with. These include system software files like the Laserwriter file in the Extensions folder inside the System Folder, or special folders that some programs create automatically for their own use, like ones that store Help or dictionary files.

**Alias troubleshooting**

If you try to open an alias and nothing happens, either the alias file is damaged or the original file has been deleted from the disk. To find out which is the culprit:
File and Edit menu commands

1. Select the alias and choose Get Info. The information window appears.

2. Click the Find Original button. Your Mac will attempt to find the original file.

   If your Mac can’t find the file, then the original has been deleted. Delete the alias, copy a new original file to your disk, and make a new alias.

   If your Mac finds the file, the alias itself is damaged. Delete the alias and make a new one.

The Find... and Find Again commands

The Find... and Find Again commands let you locate files on any disk or shared folder available to your Mac. These commands replace the Find File DA that Apple included with previous versions of the system software.

The Find... command gives you a lot more flexibility than the old Find File did, and enables you to search through more than one disk or shared folder at a time. Once a file is found, Find... opens the folder containing it and selects it. This process was a lot clumsier with Find File.

The Find Again command lets you continue a search begun with Find..., so as to locate other files that match the same criteria.

Finding files by name

The Find... command offers two levels of file-finding options. Here’s how the basic level works:

1. Choose Find... from the File menu. The Find dialog box appears as shown at the top of the next page:
2. If you know all or part of the lost file's name, type it into the box. You can enter any contiguous part of a file's name to locate it—for example, the first few characters, a few characters in the middle of the name or the last few characters.

Tip

Obviously, the more complete the name you enter in the Find dialog box, the more likely the Mac will find just the file you want. Typing one or two characters in the Find dialog box usually makes the Mac find several files with similar names.

3. Click the Find button. The Mac automatically searches every disk or shared folder on your desktop alphabetically for the first name that matches what you typed in. (Depending on how many disks or shared folders and files there are, a search can take around fifteen seconds—but usually it takes less than five.)

If the Mac can't find a file that matches your search text, it will beep.

Finding files again using the same criterion

If more than one item's name contains your search text, the first one the Mac finds may not be the one you're looking for. To resume the search, use the Find Again command.

The Find... command stores the last search criterion you entered, so when you use the Find Again command you're asking the Mac for other files that match that criterion.

Here's an example. Suppose you have two files on your disk, one named Avenue and another named Venue. If you type Venue in the Find box, the Mac will find the file named Avenue first,
because the letters you typed are part of that name, and Avenue comes before Venue in alphabetical order. (The Mac ignores upper- and lower-case text when it searches for files.) In this case, you’d have to use the Find Again command to search further for the Venue file.

If repeatedly searching for a file doesn’t appeal to you, or if you want to see all the found files as a group, you’ll need to use other Find options.

**Finding files by size, kind or other criteria**

To move to the second level of options available with the Find… command, choose Find… from the File menu, then click the More Choices button in the dialog box. An expanded Find dialog box appears, like this:

![Find dialog box](image)

The default choices in this box offer exactly the same search capabilities as the basic Find dialog box. But when you click name, contains and all disks, pop-up menus appear, from which you choose to search for files by creation or modification date, kind, size, label, version, file comments or even by whether they’re locked or not. (See File-finding tips relating to these options on p. 86 of this chapter.)

The pop-up menu for contains changes according to the choice you made with the name menu—as does the text box at the upper right. The type of information you enter here depends on the
choices you made before on the pop-up menus; and in some cases, the text box itself becomes a pop-up menu of search options.

We could use up a lot of space here showing the various search criteria you can select, but you can see them all just as easily by exploring the menus yourself.

Once you've specified your search criteria in the pop-up menus and text box, just click the Find button or press Return or Enter. Try a few searches this way, and you'll soon get the idea.

The Find... command assumes you want to search every storage location available (all disks is the default choice), but you can use the Find within pop-up menu to restrict the search to just one of the storage locations on your desktop. In fact, you can restrict a search to just the active window in the Finder, or even to items that are currently selected (see the next section, Searching selected items).

The all at once checkbox is handy when you want to find all the items on a disk or in a folder that match your search criteria. When you check this box the Find within menu automatically changes to show your startup disk, and the Mac will select and display all the found files in one list view window, like this:
The actual window you see will probably be bigger than this example, and you’ll probably still have to scroll it to see all the files that have been selected. But if all the items that match your search criterion are inside the same folder or otherwise close to each other in the list view structure, you’ll be able to see them all at once.

Searching selected items

The one major limitation to your search options is that the Mac can only use one search criterion at a time. (In some third-party file-finding programs—CE Software’s DiskTop, for example—you can search for a file with multiple criteria, specifying a file’s date, kind, modification date or other information simultaneously.)

There is a partial work-around to this problem: once you’ve done an all at once search, you can then search among those found items with a different criterion. Here’s how:

1. Choose the Find… command and click the More Choices button to display the expanded Find dialog box.
2. Specify the first search criterion and check the all at once checkbox.
3. Click the Find button. The Mac will find and select the files that match the criterion you specified.
4. Choose the Find… command again and click the More Choices button to display the expanded Find dialog box.
5. Specify the second search criterion.
6. Click on the pop-up menu next to Find within, and choose the selected items from this menu.
7. Click the Find button. The Mac will search among only the items selected in the first Find operation to locate ones that match your second criterion.
File-finding tips

In case it’s not immediately obvious why you’d want to search for files by kind, label, modification date or some of the other criteria you can choose, here are a few suggestions:

Name is a good choice if you know a file’s exact name, if you remember part of its name, or if you have several files with similar names and you want to find and select them all at once.

Kind is useful for finding all aliases, applications, documents, folders or stationery pad files. If you’re backing up a disk, for example, you might want to select only documents to back up.

Size lets you find files above or below a certain size. If you use a lot of big graphics files, for example, you might want to locate them all so you can compress them or move them to another disk to free up space on your primary disk.

Label is only useful if you’ve actually used labels to identify certain files or folders on your disk. (See The Label menu Chapter 6, p. 90.) However, if you use labels to identify all the files belonging to a certain project, for example, you could find all those files at once and then back them up to the same disk.

Date created and date modified help you find recent files so you can back up those that have been created or changed since the last backup, or isolate older ones you may want to delete.

Comments will only help you find a specific file if you can remember the comments you made in its information window with the Get Info command. (You might have used a comment box, for example, to record some detailed notes about a file.)

Lock lets you find files that are locked. If you have locked files in a shared folder, for example, other users won’t be able to change them. If you want to unlock such files quickly, search for them all at once.
The Edit menu

The Edit menu and its commands look and work exactly the same under System 7.1 as under previous versions of the system software, as long as you're working in the Finder. You can undo the last thing you did; Cut, Copy, Paste, Clear or Select All the data in a document; or show the contents of the Clipboard.

When you use the Edit menu from within an application, however, it may contain commands relating to System 7.1's new publish and subscribe feature. Publishing and subscribing are capabilities that must be supported by specific Mac applications. For an overview of this feature and some examples of how it works, see Chapter 11.
This chapter covers changes to the Finder's View and Special menus and explains its new Label, Help and Application menus.
The View menu

The View menu (don’t confuse it with the Views control panel discussed in chapter 8) lets you choose the way items in Finder windows are displayed, as icons or in lists. As always, lists can be sorted by document names, dates, sizes or kinds.

Before System 7, users of color Macintosh systems used the Finder’s Color menu to assign colors to window contents, and sorted them by color with the by Color command on the View menu. The System 7.1 Finder replaces the Color menu with the Label menu and lets you sort with the new by Label command on the View menu. As we’ll see in the next section, labels provide much more flexibility in identifying and grouping desktop items, both by color and by label name.

The Label menu

The Label menu lets you assign one of seven label names to any item on the desktop, or to remove an existing label name from any item. If you have a color Mac and it’s set to display at least sixteen colors or shades of gray, each name on the Label menu has a color or shade associated with it, and assigning a label to an item also gives the item that label’s color or shade.

The standard Label menu on a black and white Macintosh looks something like the one at the top of the next page:
The labels shown above may be different in your version of System 7.1. In any case, you can use the Labels control panel to change the label names and colors (if you have a color Mac) to whatever you like. For information on doing this, see Customizing labels on the next page.

If you used the old Color command to assign colors to items on your disk under System 6, those items will automatically be given the label that corresponds to their color under System 7.1. Otherwise, none of the items on your disk will have labels when you first install System 7.1. (On the menu above, for example, the None command is checked because an unlabeled item was selected when this menu was displayed.) If items on your disk don't have labels, the Label column in a list view window of the Finder will look like this:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Kind</th>
<th>Label</th>
<th>Last Modif</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/15/90</td>
<td>2K</td>
<td>Microsoft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2/1/90</td>
<td>2K</td>
<td>Microsoft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CWInvoice1/22/91</td>
<td>3K</td>
<td>Microsoft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CWInvoice1/30/91</td>
<td>3K</td>
<td>Microsoft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CWInvoice10/10</td>
<td>3K</td>
<td>Microsoft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CWInvoice10/25</td>
<td>3K</td>
<td>Microsoft</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invoice4/1</td>
<td>3K</td>
<td>Microsoft</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
If you don't use labels, save some window space by eliminating the Label column from the window entirely. Just uncheck the option to show labels in the Views control panel. See Views on p. 135 in Chapter 8.

**Labeling desktop items**

Suppose you want to label the Invoice4/1 item in the window above as an *Essential* document. Simply select the item and then choose *Essential* from the Label menu. The invoice will take on the color that goes with the Essential label (if you have a color Mac) and the word *Essential* itself will appear in the Label column of the list view window, like this:

```plaintext
Invoice4/1 3K Microsoft Word doc.
```

**Sorting windows by label**

If you use labels to identify items in Finder windows, you can sort the items by label names using the *by Label* command on the View menu. Items are sorted by their label's position on the Label menu (from top to bottom), rather than alphabetically by name. Unlabeled items follow labeled ones. Referring back to the sample Label menu shown on p. 91, for example, items labeled Hot would be sorted before items labeled Cool, because Hot comes before Cool on the menu.

Try applying some labels yourself and then using the *by Label* command on the View menu to sort labeled items.
Customizing labels

If you use labels a lot, you’ll probably want to change their names to more accurately reflect your organizational scheme or priority levels. You can change the names on the Label menu at any time with the Labels control panel.

1. Choose Control Panels from the ⌘ menu.
2. Open the Labels icon. You’ll see a control panel like this:

![Labels control panel]

Again, the label names may be different on your Mac. Also, if you have a color monitor set to display sixteen or more colors, the boxes to the left of the labels will appear in the colors assigned to those labels.

Changing a label name

1. Doubleclick on the label name to select it.
2. Type a new name or edit the current one.
3. Press Return or Enter to confirm the change, or press Tab to confirm the change and move to the next label in the list.

Label name changes take effect as soon as you confirm them—not just on the Label menu, but everywhere the old label was used.
Changing a label color

Click on the color you want to change. The standard Macintosh color picker dialog box appears, and you can use it to select a new color. For instructions on using the color picker, see Color on p. 126 in Chapter 8.

The Special menu

The Finder’s Special menu lets you organize the contents of windows, empty the Trash, erase or eject disks and restart or shut down the Mac.

The Restart, Shut Down and Erase Disk… commands work the same way they always have. The Eject Disk command (called simply Eject in earlier system versions) has moved to the Special menu from its old location on the File menu.

The old Set Startup… command that used to be on the Special menu is gone; its functions are now handled with the Startup Items folder (see Chapter 7, p. 120).

The Clean Up commands

The Clean Up command arranges icons in windows or on the desktop in a regular pattern. As in previous versions of the system software, this command can have different names depending on what you have selected and whether or not you’re holding down Option. The command names are now more descriptive.

Clean Up commands work only in windows set to Icon or Small Icon view (with the View menu) or on the Finder desktop itself. Since these commands rearrange icons, they don’t work in list view windows.
The invisible grid

There's an invisible grid that underlies icon view windows and the
desktop itself (you actually have a choice of two grids—see the
Views control panel description in Chapter 8, p. 135). When you
clean up items, you're telling the Finder to move them to points
on the invisible grid. The grid has been around since before
System 6, but the Clean Up command in System 7.1 uses it a little
more intelligently.

Cleaning up the desktop

Here are the Clean Up commands you get with the desktop
selected. To select the desktop, select any icon on it, or click in the
background area so nothing is selected. Once you've done this:

- The command becomes **Clean Up Desktop** and choosing it
  moves each item on the desktop to its nearest grid point.

- If you hold down Option, the command becomes **Clean Up All**
  and choosing it moves every desktop icon except the
  Trash into a column in the upper right corner of the desktop.
  The Trash icon is moved to the lower right corner of the
desktop if it isn't there already.

Cleaning up windows

To use the Clean Up commands in windows, select an icon view
window or an icon inside a window.

- With a window or an icon inside a window selected, the com-
  mand becomes **Clean Up Window**. Choosing the command
  moves every item inside the window to its nearest grid point.

- If you hold down Option with a window or an icon in a win-
  dow selected, the command becomes **Clean Up By Name** or
  **Clean Up By** whichever order you have the window sorted on
at the time. (If the window is sorted by Size, for example, the
  command reads **Clean Up By Size**.) When you choose the
  **Clean Up By Name** command, the Mac arranges all the icons
in the window into rows and columns along the invisible grid and puts them in alphabetical order by name, size, kind, or whichever sort order you've chosen with the View menu.

When you use the Clean Up Window or Clean Up By Name commands, the Mac will never align icons so they overlap each other. So, sometimes Clean Up will move an icon with a particularly long name to a different row because it won't fit between two other icons on the grid in the same row.

When you use the Clean Up By Name command, the Mac also arranges icons so they fit the current window size.

**The Empty Trash command**

This command looks the same as before but it works a little differently because the Trash itself works differently in System 7.1.

Before System 7 came along, the Trash was automatically emptied whenever you shut down or restarted the Mac, when you ejected a disk containing a file you'd dragged to the Trash, and usually when applications started up or quit. Under System 7.1, items you throw in the Trash stay there until you tell the Mac to empty the Trash. This gives you better protection against accidentally throwing things away because it's easier to retrieve them.

Furthermore, System 7.1 doesn't just warn you as you drag your programs or system software files to the Trash. It also gives you a message when you try to empty it, like this:

![The Trash contains 65 items, which use 1.8 MB of disk space. Are you sure you want to permanently remove these items?

- [ ] Cancel
- [ ] OK]
You must then click the OK button or hit the Return or Enter key to empty the Trash.

**Turning the Trash warning off**

If you're not crazy about having to deal with this dialog box every time you delete a file, you can turn it off. To turn the warning off indefinitely:

1. Select the Trash icon.
2. Choose Get Info from the File menu. The Trash information window appears, like this:

   ![Trash Info Window]

   - Trash
   - Where: On the desktop
   - Contents: 0 file(s) and 1 folder(s) are in the Trash for a total of zero K.
   - Modified: Tue, Feb 19, 1991, 2:26 PM
   - Warn before emptying

3. Uncheck the **Warn before emptying** checkbox.
4. Close the window.

Now you won't ever see the warning when you choose the Empty Trash command. If you decide you want the warning back, just repeat steps 1–4 above, checking the warning box in step 3.

To turn off the Trash warning temporarily as you empty it, hold down **Option** when you choose the Empty Trash command.
The Help menu

The Help menu is new in System 7.1. It lets you turn System 7.1’s new built-in help balloons on and off, and it also lets you display a list of keyboard shortcuts for your Mac. Like the  menu and the Application menu, the Help menu is available at all times, whether you’re using the Finder or another application.

Balloon Help

Balloon Help is a built-in feature of System 7.1 that displays pop-up balloons describing various items on the screen as you point to them.

Balloon Help works automatically once you turn it on by selecting Show Balloons from the Help menu. It describes things like windows, documents, buttons, checkboxes, menus and menu commands. Here’s an example:

File Edit View Label S

File menu

Use this menu to perform operations with disks, files, folders, windows, file servers, and printers.

In this case, the pointer is on the File menu, so the balloon explains what the File menu does. Along with Finder icons, windows, menus and commands, the Balloon Help that comes with System 7.1 also explains:

- each file and folder in the System Folder
- items on the  menu
- each control panel in the Control Panels folder
- any document or disk on the desktop or in a window
Balloon Help is part of System 7.1 and any developer can use it to provide help for a non-Apple product. More and more products are taking advantage of this feature now, so you can use Balloon Help to get information about other programs as well as for the Mac's own system software.

If you try to use Balloon Help with a product that doesn't yet support it, the help balloon will simply tell you the item you're pointing to is a document, or a control panel program, or an application.

Balloon Help is useful if you don't recognize an item in a window or you don't know what a button or command is for. Balloon Help is useful if you don't recognize an item in an application, but having all those balloons popping up can be really distracting.

Fortunately, it's easy to turn Balloon Help on or off as you need it. Once you choose the Show Balloons command, the command name changes to Hide Balloons. Choose that command to turn Balloon Help off.

The About Balloon Help... command simply displays a dialog box that explains how to use the Balloon Help function. Try it and see.

As with Balloon Help, the Finder Shortcuts command can also be used by other developers and many programs already support it. When you run Microsoft Word version 5.0, for example, this command name changes to Microsoft Word Help, and it activates Word's on-line help system.

Finder Shortcuts

The Finder Shortcuts command displays a dialog box listing several keyboard shortcuts. For a complete list of System 7.1 keyboard shortcuts, see the Keyboard Shortcuts section at the end of Chapter 4.)
The Application menu

The Application menu, indicated by an icon at the far right of the menu bar, is the last new menu in the System 7.1 Finder. You use it to activate different programs you have running or to hide the windows of programs you aren’t currently using so things are easier to see on the desktop.

This menu is always available in the menu bar, but the icon identifying it changes to the icon of whatever program’s currently active on your Mac—a small Mac icon, say, if you’re in the Finder, or the compass and paintbrush icon if you’re in SuperPaint.

The bottom half of the menu lists all the programs you have running, so that area also changes as you open or quit programs. Click on the icon and the menu will appear, like this:

```
Hide Microsoft Word
Hide Others
Show All

Finder
Microsoft Word
SuperPaint
```

In this example, the Finder, Microsoft Word and SuperPaint are all currently running on this Mac. The check mark next to Microsoft Word shows that it’s the active application. We also know this because the Word icon identifies the Application menu in the menu bar.

Running and activating programs

To add another program to the menu, just start the program up. Once it’s running, its name is added to the Application menu.
When you quit a program, its name is automatically removed from the menu.

When more than one program is running, you can activate a different program by:

- choosing its name from the Application menu
- clicking in its document window on the desktop, or
- doubleclicking its icon on the desktop.

Remember, you can tell which program is currently active because:

- its window is active in the Finder
- its icon shows at the right end of the menu bar
- its name is checked on the Application menu
- its menus show in the menu bar

**Hiding and showing windows**

The *Hide* command changes to show the name of whichever program is currently active. In the example above, Microsoft Word is the active program, so this command says *Hide Microsoft Word*. When you choose this command, Microsoft Word’s menus and any document windows it has open will be hidden from view, and the program’s name is dimmed on the Application menu.

Another way to hide the currently-active program’s windows is to hold down [Option] and click on the desktop.

To reveal a program’s windows after you’ve hidden them, just choose the program’s name from the bottom part of the Application menu. Even though the name is dimmed, choosing it still activates the program and displays its windows.

The *Hide Others* command hides the windows of every program except the one that’s currently active. On the Application menu shown above, for example, choosing *Hide Others* would
hide any SuperPaint windows and any disk or folder windows open in the Finder. You can’t hide the Finder desktop itself, because it isn’t a window.

The *Hide Others* command is helpful when you have lots of Finder or program windows open and it’s hard to maneuver around them to see the particular window you’re working with.

The *Show All* command simply opens up all the windows you’d previously hidden with the *Hide* or *Hide Others* commands.
PART 3

The new System Folder
The System Folder has always been the Mac's nerve center. But in System 7.1 it does a lot more than store vital files, and the System file itself handles fonts and sounds differently. In this chapter you'll see how to use both the System Folder and the System file to customize and control your Mac. Chapter 8 covers control panels, which have their own folder within the System Folder.
The System Folder

When you first open the System Folder after installing System 7.1, you'll see an icon view window like this:

Although some icons look different, the new System Folder contains familiar items like the Finder, System, and Scrapbook File. The folders, which are all new, are designed to store specific types of files used by the system software. We'll look at each folder later in this chapter.

Installing files in the System Folder

The System Folder in System 7.1 is intelligent. Once you've started up your Mac with it, you can install most other system software files (like your own DAs, fonts or init files) simply by dragging them on top of the System Folder icon.

When you do this, the System Folder checks the file type of the item you're dragging. If it recognizes that type as belonging in a certain folder, it asks if you want to put it there, as shown at the top of the next page:
Control panels need to be stored in the Control Panels folder or they may not work properly. Put “SuperClock!” into the Control Panels folder?

If the System Folder doesn’t recognize a file type, the item will just be put inside the System Folder itself. These files may still work normally even though they’re not inside the proper folder. On the other hand, some of your old System Folder files won’t work under System 7.1 even if you do put them in the proper folders.

Now let’s look at each of these folders.

The Apple Menu Items folder

In System 7.1, the ⬤ menu has become a place where you can put anything you want to be able to find and open quickly, whether it’s a document, folder, program, DA or other item. Anything you put in the Apple Menu Items folder will appear on the ⬤ menu. There’s no absolute limit on the number of items you can put on the ⬤ menu, except the amount of space on your disk. (Under System 6, the limit was 15 items on this menu, and you could only install DAs there.)

In a standard System Folder, the Apple Menu Items folder looks like the one at the top of the next page:
(If you have a Mac Portable or PowerBook, your folder may have a couple of extra DAs in it for monitoring battery use or setting the screen brightness.) Because these items are in the Apple Menu Items folder, their names show up on the menu like this:

![Apple Menu Items](image)

Notice that along with the item name, the item’s icon appears on the menu so you can tell what sort of item it is. (The Control Panels item is a folder, for example.)

An item’s icon on the Apple menu is the same one it has on the desktop and in the Get Info dialog box. When you change an icon in the Get Info dialog box, its icon on the Apple Menu will change, too. See *The Get Info command* on p. 71 in Chapter 5.

Choosing a name from the menu opens the corresponding item from inside the Apple Menu Items folder. This procedure
works for desk accessories, programs, documents or folders, as well as aliases. (For more about aliases, see *Aliases on the menu* on p. 110, or *The Make Alias command* in Chapter 5, p. 77.)

**Installing desk accessories**

Most of the items on System 7.1's standard menu are desk accessories (DAs). The DAs that come with System 7.1 are individual programs with unique icons that you can double-click to open, just like other applications. (You could even store these DAs in some completely different folder, and open them by double-clicking there.)

DAs that came out before System 7 are stored in suitcase files like this:

```
LID  Acta 3.0
```

A suitcase file can store one or more DAs. To install all the DAs from a suitcase file on the menu, just drag the suitcase icon directly on top of the System Folder icon. When you do this, the System Folder recognizes the suitcase file, opens it and installs the DAs in the Apple Menu Items folder.

Under System 6 you needed the Font/DA Mover utility to install DAs, but now you can just drag them onto the System Folder icon to install them automatically on the menu, or put the DAs anywhere else you want them to appear.

If you’re dragging a suitcase file to the System Folder icon from somewhere else on your startup hard disk, the Mac will try to delete the empty suitcase file after copying its DA(s) into the Apple Menu Items folder. Sometimes this doesn’t work and you’ll see a message saying it didn’t. In that case, delete the empty suitcase file yourself.
If you want to manually remove a DA from its suitcase file (which you need to do if you don't want to install all the DAs in a suitcase), here's the procedure:

1. Doubleclick on the suitcase icon. You'll see a window like this:

   ![Suitcase Icon](image)

   (You can tell this is an older DA, because it has a generic application icon rather than a unique one.)

2. Drag the DA(s) you want out of this window, and then to the new location on your disk. (Put the DA in the Apple Menu Items folder if you want it to appear on the **menu.**)

### Installing documents, folders or programs on the **menu**

If you want to install a program, document or folder on the **menu, just drag the item into the Apple Menu Items folder. When you want to put an item on the **menu but you don't want to store it in the Apple Menu Items folder, use an alias.

### Aliases on the menu

If you have anything that you open frequently and it's buried deep inside other folders, you can easily make an alias for it and then put the alias in the Apple Menu Items folder. Then, choosing the alias name from the **menu will open that item. (For more on making aliases, see *The Make Alias command* in Chapter 5, p. 77.)
One ready-made example of an alias on the menu is the Control Panels folder: it isn't the real folder—it's an alias for it. Alias file names always appear in italics in Finder windows, but not on the menu. System 7.1 comes with an alias for the Control Panels folder in the Apple Menu Items folder so you can open the Control Panels folder easily while the folder itself remains inside the System Folder. (See The Control Panels folder on the next page for more information.)

Managing menu items

Because it's so easy to add items to the menu, it can quickly become cluttered with dozens of different folders, documents, DAs, or programs. Once you've added 14 or more items to the menu (depending on the screen size of your Mac), there will be an arrow at the bottom, and you'll have to drag down to the arrow to scroll down the menu. With two or three dozen items on your menu, it can become so crowded that it's difficult to find the exact items you want.

System 7.1 automatically alphabetizes item names on the menu, so you can always locate an item in that order. If you find yourself using a handful of items far more than the others, though, you may want to move those items up to the top of the menu where they're easier to find.

To do this, just add a number or special punctuation character to the beginning of the item name. System 7.1 alphabetizes punctuation characters before numbers, puts numbers before letters, and places special characters (created with the Option key) after the letters. So, for example, if you rename the Scrapbook file as “1Scrapbook” or “*Scrapbook,” the name will fall before the “a” items in the Mac's alphabetization scheme, and will ensure that the item appears at the top of the menu.
The System Folder

**menu items you don’t want**

Theoretically, you can put anything you want in the Apple Menu Items folder, but it doesn’t make sense to put non-openable files like the LaserWriter driver or program preferences files in it.

The System file has to remain directly inside the System Folder (not in some other folder within the System Folder) so putting it inside the Apple Menu Items folder will cause big problems. If you want to be able to open it from the ⌘ menu (to add sounds more easily, for example), put an alias of the System file in the Apple Menu Items folder.

---

**The Control Panels folder**

As with DAs, you can now open control panel programs like applications; when you double-click one, it displays the options you have available. You can store control panel programs anywhere you want on a disk. The Control Panels folder is just a convenient place, because it lets you quickly display and access them using the Control Panels alias on the ⌘ menu.

Once you open the Control Panels folder, you’ll see familiar programs like Color, Mouse, Keyboard, Map and Sound, along with some new ones that give you even more control over the look and feel of your Mac. For more information about all the control panels that come with System 7.1, see Chapter 8.

**Tip**

Most control panels become active as soon as you copy them to your disk and open them, but some, like screen-saver and clock programs, don’t start performing all their functions until you restart your Mac.
The Extensions folder

The Extensions folder stores extension files and Chooser resources such as printer, scanner or network drivers. Under System 6, files like these had various names when you looked under the Kind column in list view windows, but under System 7.1, these files are all called system extensions.

The other item you'll find in the Extensions folder is the PrintMonitor program, which allows you to spool printed documents to your disk and have them fed to a printer while you get on with other work. (See The PrintMonitor Documents folder below.)

Any system extension file will automatically be placed inside the Extensions folder when you drag its icon on top of the System Folder icon in the Finder (or you can drag extension files into the Extensions folder yourself).

In most cases, extension files will also work if they're located directly inside the System Folder, and not in the Extensions folder. But the Extensions folder lets you organize them all in one place and still have them work properly. If you put extension files inside any folder other than the Extensions folder or the System Folder, they probably won't work.

Some system extension files have more specific types:

Chooser extensions such as the LaserWriter driver or the AppleShare extension allow you to select various printers, file servers or other network devices. Some drivers for non-network devices include the ImageWriter and StyleWriter files. Chooser extension files become active as soon as you copy them into the Extensions folder.

Communications tools allow communications programs to connect to certain types of terminals or modems. These tools are generally supplied with communications programs. These might be called Hayes Modem Tool, Serial Tool, TTY Tool, XMODEM
Tool, and so forth. These types of extensions also become active as soon as you copy them into the Extensions folder.

Other system extension files just have the generic system extension label. Standard ones you’ll find inside the Extensions folder when you first install System 7.1 include the File Sharing and Network extensions that let your Mac share files with other Macs on a network. There are lots of third-party extensions, such as Capture (a screen dump utility) and QuickMail (the init that starts up the QuickMail electronic mail program). Most of these system extensions are activated only when the Mac starts up, so if you drag one of these into the Extensions folder, you’ll have to restart the Mac before it will begin working.

---

**The Fonts folder**

The Fonts folder is a new feature of System 7.1 (an improvement from System 7.0) which stores all the fonts your Mac will use in one convenient place. When you first install System 7.1, the Fonts folder contains several suitcase files, each of which contains a selection of standard fonts supplied with this version of the system software. When opened, the Fonts folder looks something like this:

![Font Display](image)

(Your Fonts folder may be different, depending on the final release version of System 7.1.)
The Fonts folder makes it easier to install and manage fonts than ever before. If you drag any font file or font suitcase onto the System Folder icon, it will also be stored automatically inside the Fonts folder. When your Mac starts up each time, it automatically looks in the Fonts folder and opens up to 128 font files or suitcases and makes them available for use.

Since the Mac opens up to 128 font suitcases at a time, and a font suitcase can contain up to 16 megabytes of data, the number of fonts you can install is practically limitless.

You can put any kind of individual font file or font suitcase file in the Fonts folder. The Macintosh can use bitmapped, or fixed-size fonts, TrueType fonts, or PostScript printer or screen fonts. Once inside the Fonts folder, any of these font types can be used properly by the Mac. If you put downloadable printer fonts in this folder, for example, the LaserWriter driver will automatically know that that’s where it should look for such fonts when you specify them in a document you’re printing.

If you’re using Adobe Type Manager to display PostScript fonts on the screen, it will still work with System 7.1, but you should install the screen fonts in the Extensions folder.

Opening a font suitcase

In the Font folder window shown above, each of the suitcases contains a selection of fixed-size and TrueType fonts. To open a suitcase, just doubleclick it. You’ll see a selection of different font files inside it, like the one at the top of the next page:
This Times suitcase window contains both fixed-size font files (Times 9, 10, 12, 14, 18, and 24) and TrueType font files (Times, Times (bold), Times (bold, italic), and Times (italic)). You can tell which fonts are TrueType because their icons show a character being scaled, and because they don’t have size numbers.

**Viewing fonts**

To view a font file, just doubleclick it and you’ll see a window showing a sample of the font in that size, like this:
This sample shows a fixed-size font, Times 14. Your Fonts folder will also contain TrueType fonts. TrueType is Apple's new scalable font technology. You use the same TrueType font file to display type on the screen and print it out a file, and you can make a font just about any size and still keep its nice, smooth appearance on the screen and on paper. If you double-click a TrueType font you'll see samples of the font in three different sizes, like this:

For more about TrueType and other fonts, see Chapter 10.

**Installing and removing fonts**

You can't make any changes to the Fonts folder while anything but the Finder is running. If you try, you'll see a message warning that you have to close any other applications first.

After making Font folder changes, you'll have to restart any programs you had closed. But you don't have to restart the Mac. Any changes you make to the Fonts folder take effect immediately.
Assuming you’ve quit all your programs except the Finder, you’re ready to install fonts. There are three ways to do it from the desktop:

- Drag a font file or font suitcase on top of the System Folder icon. You’ll see a message asking if you want to install the font in the Fonts folder. Click the OK button to do so.

- Drag the font file or font suitcase on top of the Fonts folder icon. The file(s) will be installed.

- Doubleclick the Fonts folder to open its window, then drag a font file or suitcase inside it. If you’ve stored a lot of fonts in one big suitcase and don’t want to install them all, double-click the suitcase first to open it, then select the fonts you want to install and drag only them into the Fonts folder. If you drag one font suitcase on top of another suitcase that’s already inside the Fonts folder, the contents of the suitcase you’re dragging will be merged with the contents of the one you’re dragging onto. However, you can’t ever replace a font in the Fonts folder with another font that has the same name.

When you drag fonts to the Fonts folder, the Mac automatically resolves any font ID conflicts.

To remove a font, just drag it out of the Fonts folder. You can also remove a single font file from a suitcase by dragging it out of the suitcase.

**Using font management programs**

While you don’t need the Font/DA Mover program to install fonts or DAs under System 7.1, that doesn’t mean you aren’t allowed to use a font and DA management program like Suitcase or MasterJuggler to install and manage these items. Suitcase and MasterJuggler have a lot of extra features (like displaying font names in the fonts they represent on font menus), and more importantly, they let you open and close individual font files easily, without having to quit programs or drag those files into or out of the Fonts folder.
The Preferences folder

This folder stores settings you've chosen for specific operations like sharing files with others, naming specific users or groups for file sharing, and viewing documents in the Finder. A lot of applications like PageMaker, Microsoft Word or Excel also create their own preferences files.

Applications that know about the Preferences folder will store their preferences files there, and others will store them directly in the System Folder. You should leave a preferences file wherever it happens to be so that the program that created it will be able to find it.

The PrintMonitor Documents folder

You won't see a PrintMonitor Documents folder if you look inside the System Folder before you've printed any documents with a newly-installed System 7.1. This folder is automatically created by the PrintMonitor program the first time you print a document with background printing turned on. As seasoned MultiFinder and LaserWriter users know, PrintMonitor is the printer spooler that comes with Macintosh system software. (See Using PrintMonitor, Chapter 10, p. 178 for more information.)

When PrintMonitor starts up, it looks for a PrintMonitor Documents folder in the System Folder. If there is no such folder, PrintMonitor will create one. PrintMonitor quickly “prints” your document into that folder, and then feeds the document to your printer at a slower pace while you get on with other work.

Unless PrintMonitor is in the process of sending a file to your printer, the PrintMonitor Documents folder is empty. Don’t bother deleting this folder, though; PrintMonitor will only create a new one the next time you print a document.
The System Folder

The Startup Items folder

The Startup Items folder replaces the old Set Startup... command on the Special menu in the Finder. It stores documents, folders, DAs or programs you want to open automatically whenever you start up your Mac. When you first install System 7.1, this folder is empty.

To have a program, folder or document open automatically, just drag it (or an alias for it) inside this folder. The next time you start up, that item will be opened. If you drag a document into the folder, your Mac will automatically find and load the program that created it, provided that program is on your hard disk. If the program can’t be found, you’ll see a message that says so.

Every program you open uses up memory. If you drag more programs into the Startup Items folder than your Mac can hold in its memory, not all of them will open. The Mac will open as many programs as it can, and then you’ll see a message that there isn’t enough memory to open the others.

To turn a startup item back into an ordinary document or program, you must drag it completely out of the System Folder, not just out of the Startup Items folder.

Startup items that don’t belong here

Although some people refer to system extensions (or inits) as “startup files,” the Startup Items folder isn’t where they belong. As explained on p. 113 of this chapter, all system extensions should be stored in the Extensions folder.

Also, it doesn’t make sense to move nonopenable files like printer drivers to the Startup Items folder, because they can’t be opened anyway.
The System file: installing sounds

In previous versions of the system software (before 7.0, that is), sounds on the Mac were always been handled with shareware utilities like Sound Manager or Sound Mover. In System 7.1, sounds are still installed directly in the System file, but you no longer need a special utility to install them. You can open the System file itself and double-click on any sound to play it. Simply drag sounds into or out of the System file's window to install or remove them.

Opening the System file and playing sounds

You can view the contents of the System file at any time by double-clicking on the System file icon. When you do, you'll see a window like this:

![System file window](image)

This particular window shows five different sound files. To play any sound, just double-click on it.

Tip

The System 7.1 Scrapbook contains a new sound. You can play the sound in the scrapbook, or copy it to the System file's window to install it in your Mac.

Installing sounds

You can't make any changes to the System file while anything but the Finder is running. If you try, you'll see a message warning that
you have to close any other applications first. Once you’ve quit other programs, you can install or remove sounds by simply dragging them into or out of the System file’s window.

If you previously used a sound management utility and your sounds are stored in a separate file (outside the System file), you should still be able to use these utilities to install sounds. Just make sure the sound files are snd resources. (Most shareware sound management programs either create snd resources or can convert sound files into snd resources.) If they are, and they’re also individual files, you can install them by dragging them into the System file window, as explained earlier. If your sound files aren’t snd resources, you’ll have to convert them with your sound installation utility before you’ll be able to install them.
Using control panels

Control panels are individual programs that let you set user preferences for the Finder or elsewhere in the system software's operations. (In System 6, they were called control panel devices, or cdevs.) In this chapter, we'll look at the standard control panels that come with System 7.1. As you'll see, many of them work much as they did before; others may have familiar names but operate differently; some are totally new.
The Control Panels folder

In previous versions of the system software, the Control Panel was a DA on the menu. Under System 7, control panels are separate programs, and they’re inside the Control Panels folder in the System Folder. (You can still access them from the menu, though, because choosing the Control Panels alias there opens the folder for you.) Control panels can now be opened just like applications, and they can display more options than in the old dialog box—as many as will fit on the screen. The collection of programs in Systems 7.1’s Control Panels folder looks like this:

![Control Panels folder screenshot]

To use any of these control panels, doubleclick its icon. The control panel will open and you’ll see some options. For example, doubleclicking on the Startup Disk icon shows this control panel (as mentioned in the Introduction, control panel is Apple’s name for a control panel’s window as well as for the program type):
This control panel shows all the startup disks (just one in this case) currently available to your Mac. This control panel differs from the old Startup Device cdev only in the way it's opened.

**Making control panels easier to use**

For even quicker access to a particular control panel, put an alias for it on the \(\text{\ð}\) menu so you won’t have to mess with the Control Panels folder at all. For example, if you frequently change the look of Finder windows, putting an alias for the Views control panel on the \(\text{\ð}\) menu will make it easier to open.

For more about using aliases, see *The Make Alias command* in Chapter 5, p. 77.

**Some control panels are the same**

Of the seventeen control panels that come with the System 7.1, four are unchanged: Map, Monitors, Mouse and Startup Disk. (Startup Disk used to be called Startup Device, but it's otherwise the same.)
The only other change you'll see in these four programs is the pointer. Before System 7.1, you used a crosshair pointer to select a control panel's options. Now the pointer is the same kind of arrow you see in the Finder.

Another control panel that hasn't changed, but doesn't automatically get installed in the Control Panels folder, is CloseView. CloseView magnifies the Mac's screen for people with impaired vision. It comes on one of the System 7.1 installation disks, but isn't put on your disk during a normal installation. If you want to use CloseView all the time, drag it inside the Control Panels folder so you can get to it more easily.

Familiar control panels with new features

The other control panels whose names you'll recognize from previous system versions have some significantly different features in System 7.1. We'll look at those in detail here.

Color

The Color control panel has been expanded in System 7.1. Before System 7 came out, you could only adjust the color used to highlight selected text. Now, you can change the color of window borders as well. When you doubleclick the Color control panel, you'll see this window:
The **Highlight color** and **Window color** pop-up menus list the colors you can select (with the actual color displayed next to each one if your Mac can do this). The Window color menu has nine standard colors on it that can’t be changed.

Clicking on the Highlight color menu makes its color selections appear like this:

![Highlight color menu](image)

The **Other...** command shown here lets you choose any one of over 16 million colors with the standard Macintosh color picker. To select any one of them:

1. Choose the **Other...** command on the menu. The color picker dialog box appears, like the one at the top of the next page:
Choose a highlight color:

- **Hue**: 38693
- **Saturation**: 36542
- **Brightness**: 33630
- **Red**: 14878
- **Green**: 23458
- **Blue**: 33630

(Thi example was taken from a Mac set to display in sixteen colors, so the color values are shown in the lower left corner. If you were viewing this example on a color screen the actual color represented by those values would appear in the square at the upper right.)

The wheel in the color picker shows a range of colors that includes the highlight color currently being used (you'll see it in the box at the upper left). On Macs set to display millions of colors, the wheel has a wider variety of color variations.

2. Point to a place on the color wheel and click. That color will appear in the top left-hand box. Holding down the mouse button and dragging the pointer around the wheel will change the current color.

Because the Mac can produce over 16 million colors and you can't see them all in the color wheel at one time, you can use the scroll bar to show others. If you want to choose a color by its numeric color component values, click the arrows next to the Hue, Saturation, Brightness, Red, Green or Blue boxes to select the values you want.
3. When the color you want is shown in the current color box, click the OK button. The change will take effect immediately.

**Easy Access**

The **Easy Access** control panel makes the Mac easier to use for people who have trouble using the mouse or keyboard normally, or who want to choose multiple-key commands with just one hand.

Before System 7, Easy Access was an init program that had no user-adjustable features. In System 7.1, the program is a control panel, and you can set several new options for it. When you open it, you see this:

![Easy Access Control Panel](image)

The Mouse Keys and Sticky Keys features shown here are basically the same as in the old version of Easy Access, except now you can modify the way they work, not just turn them on or off. Slow Keys was new with System 7. Taking them from the top:

The **Use On/Off audio feedback** checkbox lets you tell the Mac to make a little siren sound whenever you turn one of Easy Access's three features on or off. Uncheck the box to shut the siren off.
Using control panels

The On and Off buttons for each of the following features turn it on and off (but you knew that).

Mouse Keys lets you control the pointer on the screen and perform other mouse activities by pressing numbers on your numeric keypad, like this:

![Diagram of Mouse Keys]

Clicking one of the directional number keys moves the mouse incrementally; holding one down sets it in continuous motion in that direction. You can see that the direction keys all form a circle around the 5 key. The 5 key itself works like the mouse button: press it once or twice to click or double-click the mouse button.

Since Mouse Keys users sometimes have trouble pressing more than one key at a time, other keys can be used to help select and drag an item on the screen. Press 0 (zero) and it'll hold the mouse button down while you drag an item with one of the directional keys. Press 0 to release the mouse button if you've been holding it down with the 0 key.

Note that you can't type numbers using the numeric keypad when Mouse Keys is on.

The Initial Delay buttons let you decide how long the Mac waits between the time you begin holding down a keypad key and
the time it puts the pointer in continuous motion. The *Maximum Speed* buttons let you control the fastest rate at which the pointer moves across the screen. (The longer you hold down a key, the faster the pointer moves, but the maximum speed buttons let you determine the pointer's top speed.)

**Slow Keys** helps people who have trouble pressing keys or taking their fingers off of them quickly. It turns off the Mac’s key repeat feature, so a string of characters doesn’t print across the screen.

The **Acceptance Delay** buttons let you set the length of time you must hold down a key for that keystroke to take effect. The **Use key click sound** checkbox lets you add an audible click, which you’ll hear after each character appears on the screen. Uncheck the box to get rid of the clicking sound.

Sticky Keys lets you type two-key commands without having to press both keys at the same time. Normally, to issue a keyboard command, you have to hold down a modifier key (**Shift**, **Control**, **Option**) at the same time as you press another key. Sticky Keys lets you press the two (or more) keys in sequence.

When you turn Sticky Keys on, the Sticky Keys icon appears to the right of the Application menu in the menu bar, like this:

![Sticky Keys Icon]

Then you can press a modifier key. An arrow appears above the Sticky Keys icon, indicating the modifier key has been set. Press the second key in the command to finish the command.

Normally, the modifier key will be released when the command is finished. If you want to use the same modifier key for a series of commands, you can lock it down by pressing it twice. The Sticky Keys icon darkens to indicate that a modifier key is locked down.
You can also "hold down" two of the four modifier keys at the same time by pressing them one after the other. For example, if you wanted to type `Shift 5 3 6 B`, you'd press `Shift`, then `5 3 6`, and finally `B`. Both the `Shift` and `5 3 6` keys would be "held down" in this case.

To turn Sticky Keys off, either click the Off button in the control panel or press two modifier keys at the same time.

The **Beep when modifier key is set** checkbox lets you turn on a beep to notify you when a modifier key is set. This way, you don't always have to watch the Sticky Keys icon—you can just listen for the beep.

**General Controls**

The **General Controls** control panel replaces the General cdev in older versions of the Mac's system software. It's the same except the RAM cache options that used to be at the bottom of the box have been transferred to the Disk Cache area of the new Memory control panel (see Memory, p. 144).

**Keyboard**

The Keyboard control panel has the same Key Repeat Rate and Delay Until Repeat controls it's had for years, but now you can also use it to assign different international character sets to your keyboard. In the **Keyboard Layout** list, you'll see the names of keyboard layouts currently installed in your System file, like this:
The only ones supplied in the American version of System 7.1 are the U.S. and U.S. System 6 sets shown above. The default choice is the U.S. set, which is the latest version. (The U.S. - System 6 layout is available because it contains some older, non-standard key combinations that are used by a few font development programs.)

For International Users: If you're using the WorldScript extensions and you have another language script active, that language's keyboard layout(s) will be the ones shown in the list in the Keyboard control panel.

To install additional keyboard layouts, you must install the script and fonts for the language you want. See Installing WorldScript extensions and scripts on p. 34 in Chapter 2.

Sound

Some of the latest Mac models come with microphones for recording sounds. (Even if you have an older Mac, you can get the MacRecorder from Macromedia, in San Francisco, California, which will also let you edit what you record.) Once you've recorded your sounds, you can use them as Alert sounds instead of the beep your Mac usually makes.

The Sound control panel was changed in later versions of System 6, but since many Mac owners may not have used its new features, we'll look at them here. When you open the Sound control panel, it looks like the one at the top of the next page:
The sliding Speaker Volume control in this box is the same as ever. In the list of currently installed Alert Sounds, you can click on any sound’s name to select it to play. If you select any sound except the Simple Beep, the Remove button becomes active, and you can use it to remove a sound from the list, which deletes it from the System file as well. You can’t remove the Simple Beep (that’s why clicking on it doesn’t activate the Remove button).

The Microphones list at the bottom shows microphones currently connected to your Mac, and lets you switch between them for recording. Just click on the microphone you want to select it.

The Options… button is only active when you’re using the MacRecorder driver or another enhanced sound input driver. Clicking this button lets you select which port the microphone is connected to.

The Add… button lets you record a new sound. When you click this button, you’ll see a dialog box that lets you record or play sounds, like the one at the top of the next page:
Click the Record button to begin recording. You’ll see little sound wave lines coming out of the speaker icon, and a black line will begin filling the seconds bar to show you how much time you’ve spent recording. There’s also a counter to the right of the seconds bar. The Stop, Pause and Play buttons all work just as they would on an ordinary tape recorder.

When you’re done recording a sound, click the Stop button. The Save button will then become active. Click the Save button and you’ll see a standard directory dialog box you can use to name and save the sound. Once you’ve done that, you can install it in your System file by dragging it on top of the System icon in the System Folder. After you’ve installed the sound, it will appear in the Alert Sounds list.

---

**The Views, Date & Time, and Numbers control panels**

Three of the new control panels you’ll find under System 7.1 give you a lot of control over the appearance of icons, items in list views, and text that describes them in the Finder. We’ll look at each program separately.

**Views**

The new **Views** control panel lets you customize the layout of Finder windows. You can change the default layout of icons in icon view windows, change the font or size of text used in Finder windows or on the desktop, and control the amount of
information displayed about each item in a list view window.
Let’s have a look.

Choose Control Panels from the 🍎 menu. The Control Panels folder opens on the desktop. Doubleclick on the Views icon in the folder. The Views control panel will open, like this:

Instead of the boring old 9-point Geneva we’ve been stuck with since 1984, the Font for views area at the top of this box lets you select any font and font size available to your Mac for text in Finder windows or in the names of icons on the desktop.

You can’t change the fonts used for window titles or menu names in the menu bar—we’re still stuck with Chicago 12 for those.

To change the font, click on the font name to display a pop-up menu of fonts currently installed in your System file. Drag through the menu to choose one. To change the font size, click on the triangle next to that box and select one from the menu of sizes available. As soon as you select a different font or size, the change takes place immediately.
In the **Icon and Small Icon Views** area, you can now choose either straight or staggered icon layouts in Finder windows. The examples next to the **Straight grid** and **Staggered grid** buttons show how icons are arranged in each case when you choose the **Clean Up Window** command on the Special menu. Clicking the **Staggered grid** button helps you squeeze more icons into a window without having their names overlap.

The **Always snap to grid** checkbox forces the icons in a window to be on the straight or staggered grid you have chosen. When this box is checked, it's impossible to drag an icon off the grid. You can temporarily reverse this checkbox's current setting by holding down 

The **List Views** area, the three buttons under the different-sized icons let you pick what size icon will appear next to item names in list views. Normally this is the smallest of the three, but if you've used custom icons, you might want to select a larger size so you can see them more clearly.

This area also lets you control the amount of information displayed about each item in a list view window. With the standard settings, you see the name, size, kind, label and last modified date information, like this:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Kind</th>
<th>Label</th>
<th>Last Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget 91</td>
<td>21K</td>
<td>Microsoft Works do...</td>
<td>Crucial</td>
<td>Tue, Feb 2</td>
</tr>
<tr>
<td>Financial Tools</td>
<td>-</td>
<td>folder</td>
<td>Important</td>
<td>Sat, Feb 2</td>
</tr>
<tr>
<td>Invoices</td>
<td>-</td>
<td>folder</td>
<td>Crucial</td>
<td>Thu, Feb 1</td>
</tr>
<tr>
<td>Monthly Budget</td>
<td>3K</td>
<td>Microsoft Works do...</td>
<td>Average</td>
<td>Thu, Dec 6</td>
</tr>
<tr>
<td>Old Budgets, Trans, etc.</td>
<td>-</td>
<td>folder</td>
<td>Important</td>
<td>Fri, Jan 4</td>
</tr>
<tr>
<td>P&amp;I</td>
<td>8K</td>
<td>Microsoft Works do...</td>
<td>important</td>
<td>Tue, Mar</td>
</tr>
</tbody>
</table>

The item's name will always appear, but now you can choose whether you want the other categories in the list view window—size, kind, label, last modified date, version and comments—by checking or unchecking the relevant **Show...** box.
Here's what a window looks like with only the Show kind box checked:

These options help you make more efficient use of desktop space. In the above example, hiding the size, label and date information lets you make the window a lot narrower.

The Calculate folder sizes checkbox tells the Mac to determine the size of each folder's contents and display it in the list view window, like this:

You'll see that under the Size category for folders, the total size of the folder and its contents appears instead of just a dash.

If there are a lot of folders on your disk, using the Calculate folder sizes option can slow down screen response considerably, because the Mac calculates folder sizes each time you change or open a window.
Using control panels

The Show disk info in header checkbox displays a disk’s occupied space and free space just under a window’s title bar, like this:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Kind</th>
<th>Label</th>
<th>Last Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget 91</td>
<td>21K</td>
<td>Microsoft Works do... Crucial</td>
<td>Tue, Feb 2</td>
<td></td>
</tr>
<tr>
<td>Financial Tools</td>
<td>- folder</td>
<td>Important</td>
<td>Sat, Feb 2</td>
<td></td>
</tr>
<tr>
<td>Invoices</td>
<td>- folder</td>
<td>Crucial</td>
<td>Thu, Feb 1</td>
<td></td>
</tr>
<tr>
<td>Monthly Budget</td>
<td>3K Microsoft Works do... Average</td>
<td>Thu, Dec 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Old Budgets, Trans, etc.</td>
<td>- folder</td>
<td>Important</td>
<td>Fri, Jan 4</td>
<td></td>
</tr>
</tbody>
</table>

Under System 6 and older system software versions, you had to switch to icon view for this information, but now you can see it in any window.

Date & Time

The Date & Time control panel, new with System 7.1, lets you change the format of dates your Mac displays in Finder windows and Get Info windows. And, since these dates and times are accessed by other Mac programs, it lets you control how dates and times appear as you work with other applications as well. When you double-click the Date & Time icon in the Control Panels folder, you’ll see a control panel like this:
The current date and time formats are shown in the boxes below their respective names. To change a format, click the Date Formats... or Time Formats... button.

When you click the Date Formats... button, you'll see a list of options like this:

```
[Date Formats: U.S.]

[Long date]
Prefix:
- Weekday
- Month
- Day
- Year

[Short date]
Month/Day/Year

Separator:
- Leading zero for day
- Leading zero for month
- Show century

[Samples]
Thursday, January 2, 1992
Thu, Jan 2, 1992
1/2/92
```

The Date Formats pop-up menu at the top lists U.S. and Custom options. (If you have a different language script active when you use this control panel, that language's date format options will appear on this menu.) The Custom option is dimmed until you change the default date formats with the options below.

The main area of the dialog box is divided into Long date and Short date options. In the Long date area, pop-up menus let you set options for the weekday, month, day and year. The default U.S. format, as shown, is Weekday, Month, Day, and Year with commas separating the weekday name and day number. A sample of this format appears in the Samples area at the bottom of the dialog box.

Using the pop-up menus in the Long date area, you can rearrange the elements of a date so they appear in a different
order. You can also choose a None option from each pop-up menu to eliminate that piece of information. For example, by choosing None from the Weekday menu at the top, you'd reset the date format so it only shows the month, day and year. You can also add, remove or change prefixes such as commas by editing the Prefix box next to each menu.

The Short date area has only one pop-up menu, and it lets you choose Month/Day/Year, Day/Month/Year, Year/Month/Day, and Year/Day/Month formats for the short date. You’ll also notice the checkboxes for adding leading zeroes to day and month numbers, or to show or hide the two century digits in the year portion of a date. As with long dates, the effect of your choices is shown in the Samples area below.

Try the various options in this dialog box and see how they affect the Samples area.

By opting for less information in a date, you can conserve space in a list view Finder window. For example, if you eliminate the Weekday information from the long date (by choosing None from the Weekday pop-up menu), the Last Modified date in list view windows will be “Jul 10, 1992” instead of “Mon, Jul 10, 1992.”

Once you’ve set a different format option, the Date Format pop-up menu reads Custom (because you’re using a custom setting). You can return to the default format by choosing U.S. from the menu, and then switch back to your custom format by choosing Custom again. Each time you select different format options, you’re editing the Custom date format you set before.

Although date and time changes made in this control panel should take effect immediately, you may have to close a window and open it again before you’ll see the format change in a window on the desktop. Unfortunately, there’s no way to make the Mac use a short date format (MM/DD/YY) in a list view; the best you can do to conserve space is eliminate the weekday from the long date format (unless you want to eliminate the day, month or year information also, which would make the information far less useful).
When you click the **Time Formats...** button, you'll see a dialog box like this:

As with the Date Formats dialog box, you can choose a default U.S. format or a Custom format with the pop-up menu at the top. (If you have a different language script active when you use this control panel, that language's time format will appear as an option on the pop-up menu.)

The Clock options let you choose either a 12-hour or 24-hour clock. If you've chosen a 12-hour clock, you can set noon and midnight as either 0:00 or 12:00.

The Format options let you enter specific designators for before- and after-noon times (the default AM and PM are shown above), and you can specify the separator used between hours and minutes.

Finally, the checkbox adds a leading zero in front of single-digit hour times.

As with the Date Formats dialog box, samples of the time and clock formats are shown in the Samples area as you make different choices, and once you've set a format that's different from the default, it becomes the Custom format on the pop-up menu.
Numbers

The Numbers control panel lets you set the format of numbers as they’re displayed on the Mac. When you click the Number Format... button, the options look like this:

Here, the pop-up menu offers the default U.S. format or a custom one you’ve set. (If you have another language script active, that language’s number format will be the default option on the pop-up menu.)

In the Separators area, you can choose the separator used for decimals (period, comma, or space) and thousands (period, comma, space, or nothing). The Currency area lets you specify the symbol used for currency, and whether it appears before or after the number.

The Sample area shows the number format with the options you currently have set.

Other new control panels

The remaining five control panels found in the Control Panels folder are also new with System 7. They’re listed below and are
covered in detail in the chapters that describe the System 7 features they relate to.

**Labels**

Labels are a new way to identify documents, programs or folders in Finder windows. A label is a name and—on color Macs—a color or shade that you can attach to any item on the desktop or in a Finder window. These labels appear in a new Labels column in list view windows of the Finder.

This control panel and the procedure for changing labels are covered in more detail in Chapter 6 under *Customizing labels*, p. 93.

**Memory**

The Memory control panel lets you control the cache size, virtual memory and 32-bit addressing of your Mac. It's covered in detail in Chapter 9 in the section *Managing program memory*, p. 150.

**File Sharing Monitor**

This control panel shows you which folders or disks you're sharing over an AppleTalk network, and which other users on an AppleTalk network are currently sharing folders you have made available from your disk.

You can't open the File Sharing Monitor unless you've turned on file sharing with the Sharing Setup control panel. For more information about the File Sharing Monitor, see Chapter 12.

**Sharing Setup**

The Sharing Setup control panel is where you turn on file sharing, identify yourself and your Mac to the network, and control program linking. These topics are covered in Chapters 12–15.

**Users & Groups**

When you use file sharing or program linking on your Mac, you can limit access to specific users or groups of users on your
network by using the Users & Groups control panel (and you can also restrict them to specific documents using the *Sharing*... command on the Finder’s File menu). This procedure is covered in detail in Chapter 13.

---

**International control panels**

If you’re using the Mac outside the U.S. or are using the World-Script extensions, there are other control panels you can use to change the way the Mac handles text in that language. If you’re using the Mac in the U.S., these control panels won’t be included on your System 7.1 installation disks.

**Text**

The Text control panel lets you control how the Mac treats text in various languages. The control panel’s icon looks like this:

![Text icon](image)

What you see when you open the control panel depends on which language script you have active at the time. At a minimum, you’ll have the options shown at the top of the next page:
The Script pop-up menu in the Text Behaviors area shows all the language scripts currently installed in your Mac. When you choose a different language name there, the corresponding language behavior name appears on the Behavior menu. The Insertion Point options let you select a location for the insertion point and set its appearance and blink rate. The System Direction buttons control whether text flows from left to right or from right to left.

In addition to these, there may be other options specific to the language script you have active at the time.

**Language-specific control panels**

In addition to the Text control panel, there may be other control panels specific to the language you’re using. These control default fonts used by that language script, calendar features, and other options.
PART 4

Working with applications
CHAPTER 9

Using applications

System 7.1 brings several changes to the way you work with applications. We'll look first at some minor changes in how you manage the memory they use. After that, we'll consider those changes to the Mac's hierarchical file system that affect how you open or save files from within applications. Finally, we'll explore System 7.1's new stationery and QuickTime features. ➞
Managing program memory

Now that MultiFinder's features are built into System 7.1, you'll probably find yourself running more than one program at a time, even if you never used MultiFinder before. You can think of the total available memory as a pie, with different slices of the pie set aside for the System and for each application, control panel, or DA program you open. The size of the whole pie, of course, depends on how much RAM you have installed in your Mac.

As you open each program under System 7.1, it asks for a certain-sized slice of memory. The size it asks for—or will settle for if its preferred size isn't available—is set with the Get Info command. (See p. 71 in Chapter 5.)

However, if you have several programs open and you're using up most of the total available memory on your Mac and you then open a lot of documents at once with one program or work with particularly large documents, you may reach the limit of total memory available. When this happens, you'll usually get a warning that you need to close something. Sometimes, though, the program you're working with will quit without warning.

In this section we'll look at some ways to manage your Mac's available memory, so you can run as many applications or open as many documents as possible.

The more memory, the better

Although the minimum memory you need to run System 7.1 is two megabytes, you'll really want at least four or five megabytes. System 7.1 itself takes around 1.5 megabytes of space, and it can take a lot more if you run a lot of extension programs, which can occupy from 20 to 500K apiece. With four megabytes, you'll be able to run the system software with a few extra extensions plus at least one application program.
(On my own Mac IIci, 5 megabytes is enough to run two applications at once, as long as the total space needed by the programs I open is three megabytes or less. But I try to maximize the space I have available for programs by keeping the number of extensions in my Extensions folder to a minimum.)

Opening and closing programs is like asking the Mac to pack and unpack a piece of luggage—the bigger the piece of luggage, the less likely it is that something you want to throw in there won't fit. With five or eight megabytes of RAM, you'll spend far less time worrying about which programs you have open or which extensions you have installed.

If you have a Mac IIci, Ilsi, or another model with built-in color video, setting your monitor to display in black and white (rather than in 16 or more colors or shades of gray) saves memory.

**Tip**

**Resetting a program's memory size**

One way to manage memory on your Mac is to limit the amount of memory each program asks for when it starts up. The preferred and minimum memory sizes for each program can be changed to more accurately reflect the work you do with a program. For example, if you work with a lot of large documents and you get "out of memory" messages frequently, you can assign more memory to the program. Conversely, if you know you only work with one small document at a time with a particular program, you can set the memory size smaller than normal.

For instructions on using Get Info on the File menu to set a program's memory size, see p. 71 in Chapter 5.

**Using the Memory control panel**

Three other techniques for managing memory on your Mac are all handled with the Memory control panel in the Control Panels folder. Just doubleclick it to open it, and you'll see a control panel like the one at the top of the next page:
If your Mac can’t use virtual memory or 32-bit addressing, your Memory control panel won’t display all three sections shown here.

**Adjusting the disk cache**

For several years, Mac system software has let you turn on a RAM cache, a portion of memory that’s set aside to hold frequently used data. That way, the data doesn’t have to be read from disk every time you need it, which can significantly speed up operation of your system software and applications. In System 7.1, it’s called the disk cache, and you allocate its size here in the Memory control panel.

(In System 6 you could turn the cache on or off as well as set its size (using the General icon in the Control Panel). But, apparently, so much system software is now swapped between the disk and memory during a session with your Mac, performance would be too slow without help from the cache. So in System 7.1, it’s on all the time.)

To adjust the size of the disk cache, use the arrows on the right. In System 7.1, it can’t be set less than 16K and you’ll see a default
size from 32K up, depending on which Mac you’re using and how much RAM you have. If your Mac has relatively little RAM and you want to grab as much of it as possible for running applications, make the disk cache as small as possible. This may cause a slowdown in system software performance, but it will give you a little more space in which to run applications.

The change in cache size doesn’t take place until you restart your Mac.

**Using virtual memory**

With the coming of multimedia technology, some programs now require four megabytes of memory by themselves. If you’re trying to run some of these larger programs, virtual memory is a way to overcome the physical RAM limit in your Mac.

If you’re using a 68030-based Mac or a Mac II with the optional PMMU (Paged Memory Management Unit) chip installed, you can take advantage of System 7.1’s virtual memory feature to run more applications. Virtual memory lets your Mac set aside unused space on a hard disk and treat it as RAM. (See p. 10 in Chapter 1 for details on which Mac models can use virtual memory.)

Here’s how to use virtual memory:

1. Open the Memory control panel. It will contain options for using virtual memory only if your Mac can use it.

2. Click the *On* button in the Virtual Memory section. The hard disk name becomes active and the *After restart* setting appears below the Total memory indicator, like the one at the top of the next page:
(If you didn't update your hard disk driver when you installed System 7.1, a message box will tell you to do so now. Restart your Mac with the Disk Tools disk that contains the Apple HD SC Setup program, open the program and click the Update button. See p. 26 in Chapter 2 for more on this.)

Available on disk tells you how much free space there is on the hard disk named in the box above. (If you have more than one hard disk connected to your Mac, you can click on the disk name and choose another one from the pop-up menu that appears. However, don't choose a network server or other shared disk located across the network—the virtual memory performance will really suffer if you do.)

Total memory shows how much RAM is installed in your Mac. The After restart box tells you how much real RAM and virtual memory combined you will have after you restart your Mac.

3. Click one of the arrows next to After restart to set a different amount of virtual memory than the amount suggested, if you like. Remember, the figure shown here is your actual RAM plus virtual memory.
After you turn on virtual memory and restart, System 7.1 creates a file in your System Folder called VM Storage. The virtual memory feature requires one megabyte of disk space for each megabyte of virtual memory, including a megabyte of space for each megabyte of physical RAM you have installed. So, on a Mac with five megabytes of physical RAM installed (as shown above) and seven megabytes of virtual memory, the VM Storage file will be 12 megabytes. Furthermore, the space used for the VM Storage file must be contiguous (in one large block of space on the disk), not fragmented (the sum of several smaller blocks of free space in different locations on the disk). Because the VM Storage file must be contiguous, you're usually limited to a far smaller amount of virtual memory than the total space available on your hard disk would indicate.

4. Close the Memory control panel and restart the Mac.

**Virtual memory tips**

Virtual memory can be a lot slower than real memory, but it all depends on how much virtual memory you're using, how much physical RAM you have, and how large your application programs are.

Fundamentally, virtual memory involves swapping program or document files to and from the VM Storage file on your disk. As you activate a program, that program is read from the VM Storage file and into your physical RAM (assuming there's enough room in physical RAM). If the largest application you use will fit entirely into your available physical RAM, then the whole program will be swapped when you activate it, and (after a couple of seconds of disk access time) the program will run as quickly as ever. So, the basic rule of thumb is that when you open several programs under virtual memory, try to make sure that the largest of those programs will still fit into your available physical RAM.

If any of your programs is larger than the amount of physical RAM you have available, then your Mac will have to read portions
Using applications

of the program or documents you have open from the disk as you use the program. Sometimes, this will only be necessary when you use a particular program module (like a spelling checker or Thesaurus), so it won't be very intrusive. At other times, it will happen all the time and the overall performance of the program could drop by as much as 50 percent.

Here are a couple of other tips for making the most of virtual memory:

• You really need at least four megabytes of physical RAM for virtual memory to run smoothly, though it's possible to run it with fewer.

• It may not be compatible with some programs—those which insist on being in genuine RAM rather than virtual memory.

• Your Mac's performance will be better if you use virtual memory to load several smaller programs than to run one big program that's larger than your available physical RAM.

• If you defragment your hard disk before setting up virtual memory, you'll create more contiguous space and will enable System 7.1 to create a larger VM Storage file. (To defragment your hard disk, use a commercial disk management program like Norton Utilities, Disk Express or MacTools.)

• Don't use virtual memory with a PowerBook. Because it requires a lot of disk access, using virtual memory will run down your PowerBook's battery in a big hurry.

Using 32-bit addressing

If you have a Mac IIci, IIsi, LC, IIfx or a newer model based on the 68030 or 68040 chips, 32-bit addressing lets you exploit a lot more RAM in your Mac. (This is mainly useful if you work with very large files, or you want to be able to load dozens of programs at a time.) These newer Macs can use 32-bit numbers to specify memory addresses (as opposed to 24-bit numbers on other Macs), so they can handle far more memory locations and therefore use
much more RAM. (For exactly how much more, check the Special Features manual that came with your Mac.) For example, while a Mac Plus or Classic can address a maximum of four megabytes of RAM, a Mac Quadra with 32-bit addressing can address up to 128 megabytes of RAM. Of course, you have to buy and install extra RAM in order to use it.

To turn on 32-bit addressing:

1. Open the Memory control panel. If your Mac supports 32-bit addressing, you'll see a section for turning it on at the bottom of the window, like this:

   32-Bit Addressing
   
   □ On
   □ Off

2. Click the On button. You'll see a message to the right of the buttons that says 32-bit address is off (will be on after restart).

3. Close the control panel and restart your Mac.

**Memory fragmentation**

When you choose the About This Macintosh… command on the File menu in the Finder, the Mac displays a window that shows you which programs you have open and how much available memory you have, like the one at the top of the next page:
As you open and close programs, the Largest Unused Block amount shown at the upper right will change. However, the amount of memory available in your Mac can become fragmented, particularly if you open several programs that use nearly all of your available memory. When this happens you actually have less (sometimes far less) space available than the Largest Unused Block indicator tells you, so that even when you think you have enough room to open another program, the Mac will say you don’t.

To minimize memory fragmentation, open the programs you use the most first, and the ones you use the least after that. For example, if you use Microsoft Word all day long and only use DeskPaint, Excel, and AppleLink occasionally, always load Word first and then the other programs after that.

When this happens, you may get messages that say there isn’t enough memory to open new programs, or there isn’t enough memory to copy or paste a large selection on the Clipboard.

When you get a low-memory message, immediately save the changes to any open document. This way, if the Mac crashes, you won’t lose any work.

If your Mac’s memory is fragmented to the point where you can’t open new programs or cut and paste information you need, the only remedy is to save all your open documents and restart the
Using applications 159

Mac. This wipes the memory slate clean and starts you over with unfragmented memory.

**Getting technical with memory**

There are lots of technical details about using virtual memory, 32-bit addressing and memory in general on various Mac models that are beyond the scope of this book. If you’re interested in learning more, Connectix has a great booklet called *The Macintosh Memory Guide*. You can get it for free by calling 1-800-950-5880.

---

**Opening & saving documents**

System 7.1 makes three changes to how you open and save documents. There’s a new level of organization in the file structure, above the disk drive level, called the **Desktop** level. It’s visible in both dialog boxes and other directory paths. Secondly, in some directory dialog boxes you’ll also notice a **New Folder** button. Finally, there’s a new stationery feature that lets you easily create template documents for any program.

**The Desktop level and button**

In the Finder, the desktop is the place where you can see at a glance all the disks, network servers or shared folders you currently have available, along with the Trash and any program or document icons you’ve moved to the desktop. Before System 7.1, there was no way to see everything on the Finder’s desktop from inside a directory dialog box. You had to click the **Drive** button to switch from the contents of one drive to another.

In System 7.1, the Desktop level now shows up as the highest organizational level in lists like directory paths and dialog boxes, better reflecting the role it plays in the Finder. This makes it much easier to work with several disks at once.
When you use the *Open* or *Save As...* commands from inside an application under System 7.1, you'll see the familiar directory dialog box, with the *Drive* button replaced by the *Desktop* button. Clicking the *Desktop* button moves you to the Desktop level, like this:

![Directory dialog box](image)

The name above the list box has changed to Desktop, and the list itself now shows all the disks or other storage locations currently on the desktop.

The name of the disk you're on is still shown above the *Eject* button at the right. To switch disks, just doubleclick a different one in the list. (Dimmed items aren't available. The Trash is dimmed above because this is an *Open* dialog box in SuperPaint, and there's nothing in the Trash for it to open.)
The Desktop level also appears below the disk name on every directory path you display in a pop-up menu, like this:

Select a Document:

The New Folder button

Another change to the directory dialog box is the New Folder button. When you use Save with a new document, or whenever you use Save As..., the directory dialog box may (if your application supports it) contain a New Folder button, like this:

Making a new folder from inside a directory dialog box is obviously useful, and you'll soon see this button supported in most applications.

Using stationery

Some applications already have a stationery feature that lets you save a formatted template and then open it as a new untitled
document, instead of having to re-create a letterhead or re-set margins all the time. System 7.1 makes stationery possible for any program.

For instance, you might create stationery that stores your name and address in a nice font, centered at the top of the page. Then, whenever you open that piece of stationery you'll have a new untitled page with your letterhead already on it.

**Making stationery in the Save As… box**

If your application supports this new feature, Save As… will let you create stationery (if not, you can still use this feature from the Finder—see the next section). In some programs, the Save As… dialog box will have a Format pop-up menu that contains a stationery option. In other programs, there will be a radio button or checkbox for the stationery option in the Save As… dialog box.

To see an example of this for yourself, open the TeachText program that came with your System 7.1 software. Type a couple of characters in the untitled document that appears and then choose Save from the File menu. At the lower right corner of the directory dialog box that appears, you'll see the icons and the buttons you click to save the file as a standard document or as stationery, like this:

![Save this document as:](Untitled)

The stationery icon is the one on the right—the one that looks like a page being lifted off a pad.

**Making stationery in the Finder**

If your application doesn’t offer a stationery option in the Save As… dialog box, you can use the Finder to make any document into a stationery pad. Here’s how:
1. Select the document you want to make into a stationery pad by clicking on it in the Finder.

2. Choose Get Info from the File menu (other information about Get Info is covered in Chapter 5, p. 71). You'll see an information window like this:

![Budget 91 Info Window](image)

Notice that the icon and the Kind information show that this is a Microsoft Works document.

3. Check the Stationery pad checkbox at the bottom of the window. The document icon changes into a stationery pad and the Kind information changes with it, like this:
4. Close the window.

The next time you doubleclick this document in the Finder to open it, you'll see a message that asks you to name the new document, like this:

Once you name the document and click OK, the new document will appear with all the formatting and text you saved in the stationery pad. You can also save the template to another location—clicking the Save In... button produces a directory dialog box.
**Changing a stationery pad**

If you'd like to change the text or formatting of a stationery pad document, here's what you do:

1. First, open the program you used to create the stationery document, and then open the stationery document. You'll see a message like this:

   "Budget 91" is a Stationery pad. If you make changes, they will be saved into the Stationery pad itself.

   [Cancel] [OK]

2. Click OK. The document will open.

3. Make the changes you want and then save the file. It will be saved back to your disk as the stationery pad.

**Using QuickTime**

QuickTime is Apple's new system software facility for managing time-oriented data such as video and sounds. You can set up your Mac to use QuickTime by installing the QuickTime extension in your System Folder after you've installed System 7.1. (See *Installing the QuickTime extension* on p. 33 in Chapter 2.) Even with the QuickTime extension installed, however, you won't be able to use QuickTime in your programs unless they specifically support it. Most developers will support QuickTime in the next revision of their products if they don't support it already.
Typically, you use QuickTime by importing sound or graphic files into your documents, either with specific import or export commands on the program’s File menu or by simply cutting and pasting. Unlike text or regular graphics you might cut and paste, however, QuickTime data itself isn’t copied to the new location where you paste it. Instead, your Mac places a pointer that indicates where the original file can be found, along with a still representation of the file itself.

When you click on a representation of QuickTime data, your Mac automatically locates the original file and then displays control buttons you can use to play the movie or sound (see the example below). QuickTime data is stored in a compressed format on your disk to save space (because sounds and movies take up a lot of room). When you play a movie or sound, QuickTime automatically decompresses the file before playing it.

**A QuickTime example**

To see how this works, let’s look at a simple example. Suppose you’re a theatrical talent agent and you want to have quick access to video clips of auditions done by your clients. After videotaping the auditions, you use a video capture system like SuperMac’s VideoSpigot to digitize the video auditions and save them to disk in QuickTime format. Now, you want to insert those QuickTime movies into a FileMaker Pro 2.0 database file. Here’s what you would do:

1. Open the FileMaker Pro 2.0 database file.
2. Select the field into which you want to place the movie. (In our example, this is a picture/sound field called Audition.)
4. Navigate to the movie file and click the Open button. QuickTime places a representation of the movie in the Audition field, like the one at the top of the next page:
(Note that this is a representation of the QuickTime movie, not the actual movie file. The representation, or pointer, takes up only a few kilobytes of space in the file, while the actual movie could easily be several hundred kilobytes.)

The field remains selected after the movie is imported. As a result, the QuickTime movie player controls are shown below the movie itself. When the field isn’t selected, only the picture appears in the field, not the controls below it.

To play the movie, you would click the play button (the black triangle) on the left. To stop the movie at any time, click the play button again. The sound button (the speaker icon) on the left reveals a vertical slider you can drag up or down to adjust the volume of sound in the movie. The buttons on the right are forward and reverse buttons you click to move back and forth through the movie one frame at a time. Finally, by dragging the slider bar in the middle, you can move to any specific frame of the movie.)
Other QuickTime considerations

Considering all the data-handling it accomplishes, QuickTime is a marvel. However, don’t expect it to always play back video or sounds at the real-time speeds you expect from television. Several factors can affect the speed of movie playback, including the speed of your Mac model, the amount of memory you have available at the time, the speed of the disk on which the real QuickTime video file is stored, and the location of that disk. If you’re playing back a QuickTime movie whose file is located on a slow hard disk that’s connected to a different Mac on your network, expect playback to be slow indeed.

Another thing to remember is that the disk containing the original QuickTime movie must be available to your Mac. Remember, the QuickTime representation you paste or import into a document is only a pointer to the real file. If you select a QuickTime representation and the disk where the real file is located isn’t available, you’ll get a message asking you to insert the disk.

This brief example of QuickTime at work gives you a general idea of how it might work in programs you use. If a program supports QuickTime, its manual will have more information about how you can use QuickTime data.

For more information about making and using QuickTime movies, check out the QuickTime Starter Kit from Apple.
System 7.1 consolidates and extends several recent changes in Macintosh printing. Unless you bought a Mac or a LaserWriter after early 1990, many of these changes will be new to you. In this chapter, we’ll cover them and we’ll also look at the new TrueType fonts and how they work on both ImageWriter and LaserWriter printers.
The three font formats

There are essentially three font formats or types of font available for Macintosh screen display and printing:

- **Fixed-size, or bitmapped fonts** come in specific sizes like Geneva 14. With these fonts, each character is made up of a series of dots. This was the first Mac font format, and it's the one still used for most Mac screen fonts. You can also buy such fonts from companies other than Apple.

  The problem with fixed-size fonts is that you need to install a different font file for each size you want to display faithfully on your screen. Otherwise the Mac will shrink or enlarge a different-sized font that you do have installed, making the characters look blocky or blurred (and, sometimes, hard to read).

- **PostScript fonts** were the first scalable font type for the Mac and other computers. A PostScript font is stored as a mathematical description, and its characters are reproduced clearly at whatever size you specify. You only need one font file on your Mac for each font family you want to use (Helvetica or Helvetica Bold, for example). PostScript font files are also smaller—one file might be 50K or so, while a collection of bitmapped files for one font could use up 100–200K on your disk.

  The problem here is that while LaserWriter printers support the PostScript font format—indeed, some PostScript fonts are included in the LaserWriter's permanent memory—the Mac's screen display, StyleWriter and ImageWriter printers didn't support it. So even though your LaserWriter might need only one Helvetica file for printing, your Mac still needs a handful of fixed-size, bitmapped Helvetica files to display different sizes accurately on its screen, or print them clearly on an ImageWriter or StyleWriter. If you don't have *any*
fixed-size Helvetica files installed, you won’t even be able to select the font from a menu.

Adobe Systems, inventors of PostScript, resolved this problem in 1990 with a product called Adobe Type Manager (ATM). It’s an extension file that goes in your System Folder and allows you to install only one size of screen font for a given printer font family, and then scale that font smoothly to any size on your screen or print it smoothly on an ImageWriter or StyleWriter. However, ATM is a third-party solution that isn’t included in the standard Mac software, and PostScript fonts tend to be expensive.

The Read Me file that gets installed on your hard disk along with System 7.1 contains an offer from Adobe Systems that lets you get ATM and four typefaces for a mere $7.50 shipping charge (in the U.S.). This is a terrific deal.

- **TrueType fonts** are Apple’s homegrown solution to the problem of scalable fonts that can be displayed and printed on any printer. You need only one TrueType font file—the same one for screen display and for printing—for each font family. You can specify any font size you like, and it will come out looking smooth on both the screen and on any printer. This is the way Mac fonts should have worked all along. However, TrueType fonts aren’t always as typographically accurate as PostScript fonts. (See *Mixing TrueType and other fonts on a LaserWriter* on p. 190 below.)

System 7.1 comes with both fixed-size and TrueType fonts. PostScript fonts and Adobe Type Manager are sold by computer retailers. (For instructions on installing fonts, see *Installing and removing fonts* in Chapter 7, p. 117.)

Now, let’s see how these three font formats work on the Mac and its printers.
Printing with a StyleWriter, ImageWriter, Personal LaserWriter LS, or other QuickDraw printers

If you use a StyleWriter, ImageWriter, Personal LaserWriter LS, or another printer that creates text by reproducing characters from the Mac screen, the only thing new with System 7.1 is TrueType fonts. (Printers like this are called QuickDraw printers after the system software facility that creates characters on the Mac screen.) Printing procedures haven’t changed for QuickDraw printers in a few years, and the dialog boxes you see when you choose Page Setup... and Print... from the File menu are the same.

With TrueType fonts, however, the Mac can create smooth characters in a wider variety of sizes, so your printouts will look better when you specify TrueType sizes that aren’t available with fixed-size fonts.

Printing with fixed-size fonts

Like the Mac’s screen, a QuickDraw printer can produce smooth text only if your Mac supplies the font in exactly the size you specify. The printer takes that font and size from your System file (which gets it from the Fonts folder) and reproduces it as a bit map, or a collection of dots, on paper.

If you specify a font size that isn’t installed in your Fonts folder, the Mac makes a guess, based on a size that is, at what the characters would look like. Usually, the guess isn’t very good—the characters come out looking blocky instead of smooth.

Furthermore, a QuickDraw printer prints its Best-quality text by requesting a double-sized font from the Mac and having the Mac shrink it to the size you want, which makes each letter look darker and smoother on paper. If you want Best-quality Geneva 12, for example, you need Geneva 24 installed in your Fonts folder.
So fixed-size fonts severely limit your options for producing good quality printing on a QuickDraw printer. The fixed-size fonts supplied with the system software only come in 9, 10, 12, 14, 18, 20 and 24 point sizes, so if you need to use a size like 11 or 36 points, the characters won't look right.

**Printing with TrueType fonts**

With TrueType fonts, the Mac scales the font to whatever size you specify, so whether it's 11, 13, 36, 48, 50 or 72 point type, the QuickDraw printer always gets an exact-sized sample to print from. As a result, TrueType characters in any size look as smooth as those you'd get from a fixed-size font. When you use Best-quality printing, the font is automatically scaled to twice the specified size and then reduced 50% so the printer can print a denser, sharper character.

**Printing with a PostScript-compatible LaserWriter or other laser printer**

For those using PostScript-compatible LaserWriters or other printers that use the LaserWriter driver, System 7.1 incorporates changes to the *Print...* command's dialog box, the PrintMonitor program and the LaserWriter Font Utility. We'll look at these changes here. We'll also look at using TrueType fonts on a LaserWriter.

**The Page Setup... dialog box**

The *Page Setup...* dialog box in System 7.1 is just like the one in System 6, except for the pop-up menu in the paper selection area. When you choose *Page Setup...* from the File menu in the Finder, this dialog box appears:
(It may contain some extra options when you choose Page Setup... from inside an application. Many applications, including Word and PageMaker, offer options for printing PostScript information from a file.)

In the set of Paper options at the top of the box, you'll notice the new pop-up menu that says Tabloid (which is like the one in System 6's Page Setup... box for color or grayscale printing). Use it to choose other paper sizes, such as envelopes. The original LaserWriter had trouble printing anything except 8-1/2 x 11" sheets, but today's LaserWriters can easily accept various paper sizes and envelopes.

As before, Reduce or Enlarge lets you print a document's contents in a smaller or larger size.

As before, the Orientation icons let you print a document vertically (standard) or sideways on the page.

The sideways option makes printing slower because the LaserWriter has to take extra time to rotate the document's contents before printing them.

The Printer Effects options are all checked when you first open the Page Setup... dialog box. Here's what they do:

Font Substitution tells the LaserWriter to substitute three of its built-in fonts for certain ones you specify on your screen, rather than print bitmapped versions of the screen fonts. If the Font Substitution box is checked, the LaserWriter will substitute Helvetica for Geneva, Times for New York and Courier for Monaco.
Text Smoothing and Graphics Smoothing tell the LaserWriter to try to eliminate rough edges from type or graphics. Neither seems to cause print jobs to take longer, so you might as well leave them checked.

Faster Bitmap Printing preprocesses bitmapped images before they’re sent to the LaserWriter. You can leave this box checked too, since it doesn’t seem to hurt the printer’s performance.

More Page Setup options

Finally, when you click the Options button on the right, you get another dialog box, like this:

What’s nice about this dialog box is that you can see how each option will affect your document by looking at the sample on the left. None of these options is checked when you first display the dialog box.

Flip Horizontal and Flip Vertical do what they say—flip the entire image on your page either horizontally or vertically.

Invert Image creates a negative of your document, swapping white for black on the page.

Precision Bitmap Alignment reduces the whole page to 96% to avoid distortion when a bitmapped image on the Mac’s 72 dot-per-inch (dpi) screen is converted to the LaserWriter’s 300 dpi resolution.
Larger Print Area allows you to print closer to the edges of your paper (although certain applications won’t let you).

Unlimited downloadable Fonts Your LaserWriter can typically make use of only two or three downloadable fonts when printing a given document, as each one eats up RAM. (Exactly how many depends on which LaserWriter model you have and how much memory it has.) When you check this box, you remove the limit on the number of fonts per document.

Checking the Unlimited Downloadable Fonts option will slow printing to a crawl.

The Print… dialog box

This dialog box now allows you to save your document to a PostScript file, rather than send it to the printer. Other than that, it’s the same as in System 7.0 or later versions of System 6. But in case you’re upgrading from an older version of System 6, we’ll cover the whole box briefly.

When you choose Print… from the File menu, the dialog box looks like this:

Like the Page Setup… dialog box, this one may also look different when you choose it from inside an application. Some programs add printing options of their own, like whether to print back to front (in reverse order). Most of the basic features shown above are unchanged from System 6.
Copies lets you specify how many copies of the document to print. The default setting here is one.

Pages lets you print either the entire document or a range of pages in it.

Cover Page tells the printer to print a one-page report detailing the user name, application, document name, printer name, the date and the time. Clicking First Page or Last Page prints the cover page before or after the actual document.

Use the Cover Page option when you’re printing to a shared LaserWriter. The cover page will separate your document from others in the printer’s output tray.

Paper Source lets you use either the Paper Cassette built into your printer or the Manual Feed slot (part of the Multipurpose Tray on newer LaserWriter models). If you choose Manual Feed, you’ll be reminded to insert paper into the manual feed slot as the printing job begins. (You can turn this warning off with the Preferences... command in the PrintMonitor application. See below, p. 183.)

The Print buttons are primarily for people who have a color printer that uses the LaserWriter driver. Typically, you’ll use the default Black & White option. If your printer can print in color, you must choose Color/Grayscale to do so. If you choose Color/Grayscale with a black and white printer, the printer will try reproducing color or grayscale images with halftones (by printing dot patterns at different densities to imitate different shades of gray).

Destination is a new feature that lets you send your document to the Printer or save it as a PostScript® File. With some graphics files, you’ll get a better quality printout if you first save it as a PostScript file, because the LaserWriter prints finer, smoother lines and curves from PostScript instructions than it does by creating a bitmap of a drawing.

Many drawing programs have a built-in option to save files as PostScript files, but if yours doesn’t, you can create a PostScript
file this way. When you choose PostScript File here, the Print button changes to Save, and when you click it, you see a directory dialog box that lets you specify a disk and folder location for the new PostScript file.

**Using PrintMonitor**

If you're using an ImageWriter or another printer that doesn't have a LaserWriter printer driver, you can skip this section, since PrintMonitor only works with those that do (or with LaserWriters themselves, of course).

PrintMonitor is a utility program in the Extensions folder inside your System Folder that lets your Mac handle print jobs in the background while you get on with other work. We'll cover all of its features and operations here. Even if you've used PrintMonitor before, you'll want to check out the new options available with the Preferences… command in the PrintMonitor menu section, p. 182 below.

**Starting PrintMonitor**

To print in the background, you have to set PrintMonitor to start up automatically. Here's the procedure:

1. Select the Chooser from the menu. The Chooser window appears.

2. Select the LaserWriter icon at the left side of the window. The names of any LaserWriters on your network that are currently up and running will appear at the right, and the background printing options appear below the list of printer names, like the one at the top of the next page:
3. Click on the name of the LaserWriter you want to use, and then click the On button next to Background Printing.

4. Close the Chooser window.

Once you've turned on background printing, the Mac will automatically start up PrintMonitor whenever you print a document. Then your document is quickly sent to the PrintMonitor Documents folder (inside your System Folder), from which it's passed on to the printer while you get on with other work. More than one printing job can be in the background at once.

Once the printing job is done, the PrintMonitor program automatically quits.

You can also start PrintMonitor without printing a document by doubleclicking its icon inside the Extensions folder.

**The PrintMonitor window**

The PrintMonitor window shows the status and controls the operation of any printing jobs you've started. Normally this window is hidden when printing jobs are in progress, but you can display it in three ways:
- Change the PrintMonitor preferences to make the window appear during printing jobs (see The PrintMonitor menu, p. 182 below).

- Choose PrintMonitor from the Application menu when a printing job is in progress.

- Doubleclick on the PrintMonitor program to start it up when you aren’t printing something.

The PrintMonitor window shows the status of the current printing job and any other jobs that are waiting to be printed. If you display the window by using the third option above, when there’s no printing job underway and none waiting to be printed, it’ll be empty, with none of the following options available.

Here’s what the PrintMonitor window looks like when a printing job is underway and two documents are waiting to be printed:

At the top of the window, the Printing box shows the name of the document currently being printed and the name of the LaserWriter being used. The Printing Status box shows the current status of the document being printed, just the same as the messages
that would pop up on your screen during a printing job if you had background printing turned off (*Looking for LaserWriter, starting job*, etc.). The Printing Status box will also tell you how many pages are remaining to be printed in a document.

The *Cancel Printing* button cancels the current job.

The *Waiting list* shows the names of two documents waiting to print, numbered in the order they will be printed. You can use this list to view information about a document, change the order of documents or remove a document so it doesn’t print at all:

- To view information about a document, select its name on the waiting list. The *Printing Status* box will show which program created the document, when the document was spooled into the PrintMonitor Documents folder on your disk, and how many pages it contains.

- To change the printing order on the waiting list, select the printer icon between the document’s name and number and drag it to a different place on the list, which will then be renumbered from top to bottom.

- To remove a document from the waiting list, select it and click the *Remove from List* button that appears underneath the waiting list.

*Set Print Time*... lets you delay printing of a particular job. When you click this button, the Print Time dialog box appears, like this:

![Set Print Time Dialog Box](image)
This box shows the print time and date of the document that is currently printing, or one you’ve selected on the waiting list. You can click in the time or date boxes to change them, or click the Postpone Indefinitely button to put off a printing job until you choose a different time with this same dialog box.

**PrintMonitor alerts**

When your printer has a problem, the Mac normally displays an alert box. You’ll get one when the paper jams, or you run out of paper, or you’re being reminded to insert paper in the manual feed tray.

When you’re running PrintMonitor, you can choose whether these alerts appear on top of the work you’re currently doing, or whether they just cause the PrintMonitor icon to flash in the menu bar, by using the Preferences... command on the PrintMonitor menu, which is described next.

**The PrintMonitor menu**

Whenever PrintMonitor is running, it has its own File menu in the menu bar, which looks like this:

```
File
Open
Close
Preferences...
Stop Printing
```

*Open* displays the PrintMonitor window, and *Close* puts it away.

*Stop Printing* interrupts a printing job. After you select it, the command on the menu changes to *Resume Printing*, and choosing it restarts the job where it left off.
If your Mac crashes during a print job, PrintMonitor usually remembers where it left off printing, and resumes the job when you restart the Mac. Check the PrintMonitor window for the status of an interrupted job when you restart the Mac after a crash.

When you choose **Preferences**..., you'll see a dialog box like this:

```
Preferences...
Show the PrintMonitor window when printing:
   ◀ No  □ Yes

When a printing error needs to be reported:
   ◆ □ Only display □ in Application menu
   ◆ ◆ Also display icon in menu bar
   ◆ ◆ Also display alert

When a manual feed job starts:
   ◆ Give no notification
   ◆ ◆ Display icon in menu bar
   ◆ ◆ Also display alert

[Cancel] [OK]
```

This example shows the default settings for these options.

**Show the PrintMonitor window when printing** Normally the PrintMonitor window is hidden when you’re printing documents. If you really want the PrintMonitor window to show during printing jobs, click Yes here.

**Warning**

Showing the PrintMonitor window during printing interrupts your other work, and defeats the purpose of background printing. Skip this option.

**When a printing error needs to be reported** As set above, the PrintMonitor icon will flash at the top of the Application menu.
whenever there's a printing problem. And when you open the Application menu, you'll see a diamond next to the PrintMonitor name. Once you select PrintMonitor from the menu in these situations, the actual alert box will overlay the PrintMonitor window, so you can deal with it.

It's a good idea to have the icon flash in the menu bar so at least you know there's a printing problem. But if you'd rather be kept in the dark, click **Only display [ in Application menu.** Then you'll have to check your printer or the Application menu to find out if there's a problem.

If you always want to deal with printer problems immediately, click the **Also display alert** button to display printer alert boxes on top of whatever else you're doing.

With either of the two bottom choices in **When a manual feed job starts** clicked, whenever you choose **Manual Feed** in the Print... command's dialog box and try to begin printing, the Mac starts flashing the icon in the menu bar or immediately displays an alert box (depending on your clicked choice) reminding you to insert paper in the manual feed tray. You have to click **OK** before printing will actually start.

If all this seems like a lot of hassle—and it is—click **Give no notification.** This will suspend the manual feed alert entirely, even if you're not using PrintMonitor for background printing. You'll still become aware of the problem if you forget to put paper in the manual feed tray, because the yellow "paper out" light on your LaserWriter will light up and your document won't print.

---

**The LaserWriter Font Utility**

The LaserWriter Font Utility (we'll just call it the Font Utility from here on) has been included with LaserWriter printers since 1989, but it's now included in the System 7.1 software as well.
LaserWriters have been improved a lot since the old LaserWriter and LaserWriter Plus, and the Font Utility lets you manage all their features more easily: download, list, display and print fonts, cancel the printer’s startup page and many other useful things.

All of the Font Utility’s features are controlled with menu commands. When you start up the program, you see a dialog box that explains the program’s basic purpose. After you click the OK button, the Mac checks to see what kind of LaserWriter you have and which fonts are installed in it, and then the Font Utility’s File, Edit and Utilities menus appear in the menu bar.

**File menu commands**

The File menu contains commands for downloading, displaying and printing fonts, among other things. It looks like this:

```
File

Download Fonts... %D
Display Available Fonts... %L
Initialize Printer’s Disk...

Page Setup...
Print Font Catalog... %P
Print Font Samples...

Quit %Q
```

The *Download Fonts*... command produces a dialog box like the one at the top of the next page:
Here you can select one or more fonts from your disk and then download them all to your printer at once.

The Download to buttons let you choose whether to download your selected fonts to the printer or to the printer’s hard disk—if it has one directly connected. (If it doesn’t, you only have the option of downloading to the printer, as in the above example.)

The Fonts to download list shows what fonts you’ve selected for downloading.

To choose a font for downloading, click the Add... button. You’ll see a standard directory dialog box you can use to navigate to and select a font file. Once you’ve done so and clicked the box’s Open button, the font file’s name is added to this list here.

The Remove button lets you delete fonts from the list to be downloaded. Just select the font file name and click the Remove button.

When you’ve collected all the fonts you want to download in the list box, click the Download button to send them to the printer.
When you choose *Display available fonts*... from the File menu, the program lists all the fonts currently available to your printer. You’ll see a window like this:

![Available Fonts window](image)

If you have a hard disk or expansion card connected to your printer, you’ll be able to list the fonts they store by clicking the relevant button; otherwise, their buttons will be dimmed, as shown.

The list of fonts shows all the fonts in your printer, whether they’re built-in or downloaded. If it shows any downloaded fonts, you can select them and click the *Delete* button to remove them from the Printer’s memory, disk or expansion card.

If you have a hard disk connected to your printer, you use the *Initialize Printer’s Disk*... command on the File menu to initialize it. You must use this command to format your LaserWriter’s hard disk since it needs to be formatted differently from hard disks connected to your Mac.

The *Page Setup*... command on the File menu produces the standard LaserWriter Page Setup dialog box. *Print Font Catalog*...
prints a list of the fonts available to your printer, and **Print Font Samples**... also prints that list, along with a sample of each font. (Since it uses all the fonts in your printer, the Font Samples list takes a while to print.)

**Edit menu commands**

The Font Utility's Edit menu contains the same commands as the Edit menu in the Finder. You don't need them when you're using the Font Utility.

**Utilities menu commands**

The Utilities menu looks like this:

```
Utilities
    Download PostScript File...
    Start Page Options...
    Remove TrueType...
    Restart Printer...
```

The **Download PostScript File...** command lets you select a PostScript file from your disk and send it to the LaserWriter for printing. Choosing this command displays a directory dialog box where you can locate and select the file you want to print.

Once you select a file and click the *Open* button, you'll see another directory dialog box where you can name the output file created by the printing operation, if there is one. (If your PostScript file contains a series of PostScript commands, an output file is created at the end of the printing job listing all the PostScript commands that were executed.) After you click the *Save* button to save the output file, the PostScript file is downloaded to your LaserWriter and printed. If there has been no output file created at the end of the print job, you'll see a message telling you this.

If you select a non-PostScript file for printing with **Download PostScript File...**, nothing will happen when you try to print it.
(The PrintMonitor program doesn't support PostScript files, so you have to wait until your PostScript file is printed before you can do any other work.)

The **Start Page Options**... command lets you decide whether your LaserWriter will print a startup page each time you turn it on. The startup page shows how many fonts are installed in your printer, how much memory it has, which version of PostScript it is using and, most importantly, how many pages it has printed. You probably don't need to see these statistics every time you turn on your printer, so you might as well save some paper by turning the page off.

When you choose **Start Page Options**... you'll see a small dialog box where you can choose either **On** or **Off**. The standard setting is **On**, which means the printer will print a startup page. Click the **Off** button to do away with the startup page, then click the **OK** button to close the dialog box. Click the **On** button to turn the startup page on again.

The **Remove TrueType**... command removes all TrueType fonts from a LaserWriter's disk. If this command is dimmed (as in the example above) it's because you're not connected to a LaserWriter, the LaserWriter doesn't have a disk connected to it, the disk doesn't contain any TrueType fonts, or the printer isn't available.

The **Restart Printer**... command lets you reinitialize your printer, which is like turning it off and then back on again, except that you don't use the power switch. When you do this, you clear any downloaded fonts out of the printer's memory—you'll see a dialog box warning that you're about to do this when you choose the command. Click the **Restart** button to start up again.

The **Restart Printer**... command usually clears up any problems you have with the printer not executing print jobs correctly. (Sometimes, for example, the printer goes into a “preparing data” sequence indefinitely, and restarting it is the only way to clear out its buffer and get it working right again.)
Mixing TrueType and other fonts on a LaserWriter

System 7.1's new TrueType fonts give you more ways to produce nice-looking text on a LaserWriter, and they make it a lot easier to manage font files on your Mac. Some TrueType fonts are included with System 7.1 along with the same old fixed-size fonts we've had for years. To see which fonts of each type are installed on your Mac, open the Fonts folder inside the System Folder. (For more information about this, see The Fonts folder in Chapter 7, p. 114.)

Mixing font formats

Under System 7.1, you can use any of the three basic font formats and even mix them in the same document. However, each type of font has slightly different character forms, leading between lines, and spacing between characters, and there are some scaling problems that produce inappropriate results in TrueType. For example, a "3" in 7-point TrueType Geneva looks a lot like a dollar sign.

If you're doing professional work or are otherwise inclined to be picky about the appearance of text, be sure to check out the finished printout for spacing problems when you mix font formats. Also, if you open a document created with PostScript screen fonts and you only have a TrueType version of those fonts installed, the document could very well look different than its original designer intended. You might have to reformat the document to make line endings the same as they were in the original version.

To achieve better consistency among font formats, use a utility like Ares Software's FontMonger or Altsys's Metamorphosis to convert your TrueType fonts to PostScript, or vice versa.

Built-in fonts and screen fonts

Your LaserWriter comes with about three dozen PostScript fonts built into its Read-Only Memory (ROM). These include various versions of Avant Garde, Bookman, Courier, Helvetica,
New Century Schoolbook, Palatino, Times, Symbol, Zapf Chancery and Zapf Dingbats. Because they’re built into your printer, these fonts can be used and printed more quickly than others.

But since the Macintosh’s screen display doesn’t support PostScript fonts, LaserWriters come with a floppy disk of screen fonts to match the printer’s built-in ones. (You must install the screen fonts before you can select them from menus and see them on the screen.)

While PostScript printer fonts can be printed smoothly at any size from about six points up to 128 points, the screen fonts only come in a range of fixed sizes (from about 9 points to 24 or sometimes 36 points). So there are lots of font sizes that print clearly, but don’t display accurately. The best remedy to this problem if you use a lot of font sizes for which there aren’t fixed-size screen versions is to get Adobe Type Manager. With ATM, you’ll be able to install only one screen font and then scale it to any size you like on the screen.

If you have PostScript screen fonts and ATM installed but aren’t seeing smooth characters on your screen, move the PostScript screen fonts from the Fonts folder to the Extensions folder.

If you have a TrueType font installed on your Mac and it has a PostScript counterpart in your LaserWriter’s ROM (Helvetica, for example), you’ll be able to scale the TrueType font to the size you like on the screen and then the LaserWriter will print it using the built-in PostScript font. If you have both PostScript fixed-size screen fonts and TrueType fonts installed, your Mac will use the PostScript version for display when it’s available at the size you’re requesting, and it will use the TrueType font when the PostScript version isn’t installed. Of course, if you have ATM installed, the PostScript screen font will always be scaled and the Mac won’t use the TrueType version at all.
Downloadable fonts

There are hundreds of different fixed-size, TrueType and PostScript fonts available besides the built-in LaserWriter fonts. You can use them on your LaserWriter by temporarily transferring (or downloading) them to the LaserWriter’s RAM.

There two ways of doing this:

1. You can use the LaserWriter Font Utility to select and download fonts before you print a document. (The procedure is covered in *The LaserWriter Font Utility* on p. 184 of this chapter.) In this case, the font files can be stored anywhere on your disk, because you’re the one who has to locate them and select them for downloading.

2. If you have downloadable fonts stored in your Fonts folder, the LaserWriter will ask the Mac to automatically look for them and download them when you print a document that uses those fonts.

More on fonts

For a complete guide to Macintosh fonts, check out *The Macintosh Font Book* by Erfert Fenton, also from Peachpit Press.
Publishing and subscribing are powerful new capabilities in System 7.1 that will make life a lot easier for Mac users who regularly copy data from one document to another. These features may not be available to you when you first install System 7.1, because each application must specifically support publishing and subscribing. But many programs already support this new feature, so we’ll take a look at it here.
What's publishing and subscribing?

Publishing and subscribing allows you to create automatic data connections between copies of the same data—within the same document or in different documents, on your own Mac or on a network. It takes cutting and pasting to a new level. With cut and paste, you select data in one document and copy or cut it to the Clipboard. Then you select another location, in that document or another one, and paste the data there. This is like taking a snapshot of a painting in progress and sending it to someone. As soon as you change the painting, the snapshot is out of date.

With publish and subscribe, you select data in one document and “publish” it (make it available for use elsewhere) by creating an edition, a special file that contains a current copy of the published data. Once you’ve created an edition, you can “subscribe” to that edition from other documents. After that, changes to that data in the publishing document will also show up in the subscribing document.

Generally, the edition file is updated (with any changes to the original data) whenever the document containing the original data is saved. You can also send changes in a published selection of data to its edition file manually at any time (see Publisher options on p. 198 below). Because the edition contains the most recent version of the published data, a subscriber to the edition can always obtain a current version of the data. Typically, subscriptions to an edition are updated with data changes whenever the document that contains the subscription is opened, but you can also update subscriptions manually at any time.

Publishing and subscribing has lots of possibilities. Suppose two people produce a monthly report, for example. The person responsible for a graph might publish the graph, and then the person responsible for the report’s layout could subscribe to the graph. Whenever new data came in each month, the graph person
would update the graph on his Macintosh. Because the graph is published in an edition file, the layout person's version of the graph would automatically be updated to reflect the new data.

Particular uses for publish and subscribe will depend, of course, on how developers support it in their programs. But this feature will become a common enhancement to Mac programs.

Publishing and subscribing in action

Each application adds its own wrinkles to publishing and subscribing, but to get an idea of how it works, we'll look at how a spreadsheet graph is published from Claris Resolve and subscribed to in a document created with Microsoft Word version 5. In this example, we've created a stacked bar graph in a Resolve spreadsheet called *Coffee Imports*, and we want to use that graph in a Word 5 document called *Coffee Letter*.

The *Coffee Imports* graph looks like this:
To publish this graph,

1. Select the chart in the Resolve spreadsheet, and choose Create Publisher... from the Publishing submenu on Resolve's Edit menu. A directory dialog box appears, like this:

The dialog box includes a preview of the chart you've selected for publication—in this case the drawing. The file you're creating is an edition, which is why the entry box for the file name is headed Name of new edition. This edition file will contain only the chart you've selected.

2. Type a name for the edition file (we'll call it Coffee.ed) and click the Publish button. The edition is saved to disk. You can choose to manually send any future changes to the published data to the edition file at any time, or Resolve will automatically update the edition file each time this spreadsheet is saved. (See Publisher options on p. 198 below.)

Edition files have fuzzy, rectangular icons so you can tell them apart from normal document icons.

3. Open the Coffee Letter document with Word 5 and move the insertion point to the place where you want the drawing to appear.

and select it. A reduced version of the chart appears in the dialog box, like this:

5. Doubleclick on the Coffee.ed file name, or select it and click the Subscribe button. The drawing appears in the document, like this:

As an astute businessman, I'm sure you'll agree that growth like this leads to a high probability of profits.
Now that the edition is published and the word processor document has subscribed to it, any changes to the original chart (style changes or changes to the data which affect the bar sizes) can be quickly transferred to the edition file, and from there to the word processor’s subscription. Typically, the subscription will update itself by getting the most recent version of the edition file each time the Coffee Letter document is opened. (See Subscriber options below.)

Publisher and subscriber options

Once you publish or subscribe to an edition, you can select the data being published or subscribed and set some options about it. These options control when the published edition is updated with new data, or when a subscriber to the edition receives updated data.

Publisher options

If you select the chart in the Coffee Imports spreadsheet and then choose the Publisher Options... command from the Publishing submenu, you’ll see a dialog box like this:

Use the Publisher to pop-up menu at the top to see the directory path of the edition you’ve published. The menu shows the folder and disk names where the edition is located.
Publishing and subscribing

The Send Editions area lets you control when changes to the selected chart will be sent to the edition file. In the example above, the new data is sent each time this spreadsheet file is saved. You can also send an update any time by clicking the Send Edition Now button.

Finally, the Cancel Publisher button breaks the link between the selected chart and the published edition. If you click this button, updated data will no longer be sent to the edition file, although the last version of the edition file will remain on your disk.

Subscriber options

If you select the pasted-in chart in the Coffee Letter document, you can then select the Subscriber Options... command on Word’s Edit menu to reveal a dialog box like this:

Use Subscriber to to find the edition file to which you’ve subscribed—the pop-up menu shows the edition file name and its directory path. You can use the Get Editions area to choose when the subscription receives new data from the edition, and you can break the link between this subscription and the edition file with the Cancel Subscriber button.

The Open Publisher button is very handy when you can’t remember the name of the document from which the original published information came. When you click Open Publisher, your Mac opens the document that contains the original published data. If the program used to create that document isn’t
running at the time, your Mac will load it as long as there’s enough memory.

Publishing and subscribing on a network

You can publish or subscribe among documents on your own hard disk, or among documents on your disk and those located elsewhere on a network. The procedure is the same, as long as the publisher has placed the edition file on a disk that’s available for sharing over the network.

For more on sharing disks, see Chapters 12–14.

This publishing and subscribing overview gives you an idea of how this feature works under System 7.1. To explore it more yourself, check out the programs you own that support it.
PART 5
Sharing files and linking programs
File sharing lets people on a Mac network use files on each other's hard disks or CD-ROM disks. It's one of the most powerful new capabilities in System 7.1.
If you're an experienced AppleShare user and you're on an AppleTalk network, you can get up to speed on file sharing quickly by reading *File sharing for the AppleShare user* immediately following. But if you're not, start with *File sharing step-by-step* on p. 206.

---

**File sharing for the AppleShare user**

File sharing works very much like AppleShare—it turns your Mac into a network file server. But unlike an AppleShare server, a file-sharing Mac can still be used as an individual workstation. (When file sharing is on, it just uses about 300K more of your Mac's available memory.) So any (or every) Mac on a network can both share its files and log onto other file-sharing Macs as a user.

Each file-sharing Mac has an **owner** who has complete control of all its files, much like the administrator of an AppleShare file server. As an owner, first you turn file sharing on, then you select the folder(s) or disk(s) you want to share and make them available for others to use. You can register users and groups and set access privileges for shared items just as you would on an AppleShare server. (See Chapter 13 for more on users, groups and access privileges.)

Connecting to other Macs to share their files is just like logging onto an AppleShare server. And as with AppleShare, you are the owner of every folder you create, whether it's on your disk or on another Mac.

The biggest difference between file sharing and AppleShare is ease of access. With file sharing, everything you select to share is open to everyone on the network—you must use access privileges to restrict availability. Under AppleShare, it's the opposite—each new folder on the shared disk is available only to its owner, who must specify who else may use it.

These differences will be obvious as you use file sharing.
Sharing your files with others

To turn file sharing on, open the Sharing Setup control panel in the Control Panels folder, enter your name, password and Mac name in the boxes shown, and then click the Start button under File Sharing. File sharing will start up in a few seconds and you can then close the Sharing Setup control panel.

Tip
You don’t have to enter a password name if you don’t want to, but the Mac will warn you if you don’t.

On the desktop, select the folder or hard disk on your Macintosh that you want to share (you can’t share floppy disks) and then choose Sharing... from the File menu. The sharing window appears.

Tip
If you don’t have file sharing on when you choose the Sharing... command, you’ll see an alert box that explains the problem and offers to open the Sharing Setup control panel so you can turn file sharing on.

In the sharing window, check the Share this item and its contents checkbox, then close the window. The item will now be available on the network.

You’ll notice that as soon as you check the Share this item... checkbox, the access privileges options become active. For more on setting access privileges and registering users, see Chapter 13.

Monitoring and disconnecting users

To see who is connected to your Mac or to disconnect users, use the File Sharing Monitor control panel. It shows which folders you’ve made available for sharing and which users are currently sharing those items.

To disconnect a user, select the user’s name in the Connected Users list and click the Disconnect button. You’ll be able to set how much time will elapse before the user is disconnected, and a warning will appear on the user’s Mac that this is about to take place.
To disconnect everyone at the same time, turn off file sharing by clicking the **Stop** button under File Sharing in the Sharing Setup control panel. You’ll also be able to set how much time will elapse before file sharing shuts down, and a warning will appear on the screen of any user who is connected to your Mac at the time.

Don’t cut users off without giving them a couple of minutes’ notice. They could be accessing a file on your disk at the time, and the file could be damaged if the cutoff is abrupt.

**Warning**

**Connecting to other file-sharing Macs**

You don’t need to have file sharing on to use another Mac’s shared folders or disks. File-sharing Macs become network file servers, and you connect to them the same way you log on to an AppleShare server. Click the AppleShare resource in the *Chooser*, and you’ll see a list of other Macs on your network that are currently sharing files. Select the Mac you want, enter your user name and password if necessary, and then choose the folders or disks on the remote Mac that you want to add to your desktop.

**File sharing step-by-step**

File sharing on a network means being able to open and work with another Mac user’s disks or folders (think of them as *shared items*) just as if they were your own—and, if you want, giving other users similar access to yours.

Until now, this required you to buy special networking software and perhaps an extra Mac and hard disk to function as a dedicated file server. Now, thanks to System 7.1, the same network you use to share a LaserWriter will let you share files.

When you have file sharing on, you’re using an extra 300K or so of your Mac's available memory. You can share anything on hard disks or CD-ROM disks, with up to ten shared folders or
disks on your desktop at once (although working with a shared item takes a bit longer than on a locally connected disk—that's why you can't share floppy disks over a network: the access times are too slow).

You can tell when your Mac is accessing data across the network because a pair of arrows blinks at the far left edge of your menu bar, like this:

잂�

The arrows disappear when the remote disk access is finished.

**File sharing at a glance**

How you use file sharing depends on whether you're sharing your own folders or disks with other users or accessing those items the owner of a remote Mac has made available for you to share.

When you share files from your own disk, you become the *host* of those items on the network. When you connect to a disk someone else is sharing, you become a *user* of that disk.

If you're doing the latter—accessing someone else's shared items via your own Mac—you don't even need to turn file sharing on. You just connect to the remote Mac through the *Chooser* and then select from the folders or disks the other Mac's owner has made available to you for sharing. Their icons appear on your desktop just as those of your unshared items would. And when you open the icon of the item you want access to, your Mac sends a signal over the network and opens the real disk or folder on the Mac that's sharing it.

When you share your folders with others on a network, however, you must turn file sharing on and select those items you want to share, and to what extent you want others to have access to them.

In order for this all to work, you have to be able to tell one Mac on the network from another. Before you can use a Mac for file sharing, therefore, you must register the Mac's name on the network. Each Mac must have a unique name.
Also, each Mac has an owner—a person who controls the file sharing functions on that Mac. You must register an owner name before you can use a Mac for file sharing.

Because a Mac might be used by more than one person, there are ways for other users who aren’t Mac owners to share files. Users can register as anonymous guests or with a unique name. Users with unique names can have their own folders or disks on the network and can control who else can use them. (For more on registering users, see Chapter 13, p. 224.)

With System 7.1, you use various control panels, DAs and menu commands to set up your disk for file sharing, create users and grant them access privileges and connect to other file-sharing Macs. Let’s look at the steps you take to set up a Mac for file sharing.

Setting up file sharing

Before you can use file sharing, there are three things you have to do:

- Connect your Mac to an AppleTalk network.
- Turn on AppleTalk on your Mac.
- Identify yourself and your Mac on the network.

(If you’re already connected to a LaserWriter and some other Macs on a network, skip to Identify yourself and your Mac on the following page.)

**Connect your Mac to a network** It’s beyond the scope of this book to examine options for physically connecting AppleTalk networks. If you’re already connected to a LaserWriter, you’re already on an AppleTalk network. If you don’t yet have an AppleTalk network, you’ll need to buy network connectors and cabling from your Apple dealer or a mail order company.

The least expensive option for AppleTalk networking is ordinary telephone line cord and telephone network connectors that plug in between your Mac’s printer port and the modular connector at the end of the telephone cord. See your Apple dealer or local user group for more information.
Turn on AppleTalk Once you’re connected physically, you have to notify your system software about it. You do this with the Chooser:

1. Select the Chooser from the menu. The Chooser window opens (see the top of the next page).

![Chooser Window](image)

2. Click the Active button in the lower right corner of the window to make AppleTalk active. You’ll see a reminder about making sure you’re really connected to an AppleTalk network. Click the OK button to put the reminder away.

3. Close the Chooser window.

Identify yourself and your Mac This is handled with the Sharing Setup control panel.

1. Open Sharing Setup in the Control Panels folder. Its control panel will open like this:
2. Click in the **Owner Name** box and type your name. Your first name's enough, unless someone else has the same name. In that case, use your first and last name or last initial.

3. Click in the **Owner Password** box and type a password. This can be up to eight characters long, and it should be easy to remember but hard to guess. If you think you might forget it, write it down some place where you can find it. Once you click away from the password box or close the window, the word you type is replaced by bullets so nobody can read it.

4. Click in the **Macintosh Name** box and type a name for your Mac. This can be something simple like Joe's Mac (assuming your name is Joe), or something unusual like the name of a city. It's a good idea to pick a descriptive name, something people will associate with you, since your Mac name is how other people will locate your files on the network. (See *Connecting your Mac to other Macs* on p. 216 below.)

If you're planning to start file sharing right away, don't close the Sharing Setup control panel. Instead, continue with the next section.
Turning file sharing on

To start file sharing, use the Sharing Setup control panel. Remember that when you turn file sharing on, it uses an extra 300K or so of your Mac’s memory.

1. Open the Sharing Setup control panel if you haven’t already.

You can’t start file sharing without entering a Macintosh name and an Owner name (see above).

2. Click the Start button in the File Sharing area. The button name will change to Cancel, and the Status area will say that file sharing is starting up. Once it has, the Cancel button will change to Stop, and the Status area will say that file sharing is on.

3. Close the Sharing Setup control panel.

Now you’re ready to identify specific folders or disks to share.

Sharing folders and disks

Whenever you create a new item, you are its owner, and only you can change the way it’s shared, or its access privileges. You can share a single folder, several folders or an entire disk. To share individual files, put them in a folder and then share the folder. This way you can exchange information with others on your network without giving them access to files you want to keep private.

To share a folder:

1. Select the folder on the desktop.

2. Choose Sharing... from the File menu. The sharing window for that folder appears, as on the next page:

If you don’t have file sharing turned on, you’ll see a message that says so, and the Mac will offer to open the Sharing Setup control panel for you so you can turn it on. If you haven’t selected a folder or disk, the Sharing... command is dimmed.
The window has the same name as the folder—each shared folder or disk can have its own sharing options. Where tells you the location of the folder.

3. Check the Share this item and its contents checkbox. The access privileges options become active in the middle part of the window (see Chapter 13, p. 230 for how to set them).

4. Close the window. This folder is now available for sharing.

A shared disk or folder icon looks like this:

(The icon name may be different in your case, but this distinctive icon tells you the item is shared over the network, rather than connected locally to your Mac.)

This is the quickest way to set up a folder or disk for sharing, but it makes the shared items available to everyone on your network. Following the above steps, you're letting others use a shared
folder or disk as if it were their own. They can open, copy, rename or delete files or folders inside the shared item, just as you can. If you've shared your whole hard disk, they can even move, delete or rename shared folders on it.

Giving everyone on your network unlimited access to a shared item isn’t necessarily a problem. On the other hand, you may want to restrict access to a shared item to a few specific users on your network, give different users different access privileges or prevent others from moving, deleting or renaming a shared folder. For more about controlling access by other users, see Chapter 13.

**Monitoring shared folders**

Whenever you’re sharing files, you can find out who’s using folders on your disk and, if you want, disconnect them.

Open the **File Sharing Monitor** control panel in the Control Panels folder. It looks like this:

![File Sharing Monitor](image)

The **Shared Items** list shows the names of folders or disks you have made available for sharing from your Mac. The **Connected Users** list shows people who are currently sharing one or more of those folders (although it doesn’t show which items each user is sharing).
Maximizing file-sharing performance

Whenever someone else on the network is sharing a file on your disk, your Mac has to spend some of its processing power handling that task. When several other people are sharing your files, this power drain can slow your own work down.

If the files being shared are small, you can fix this problem by asking other users to copy the files they need to their own disks. Then they can work with files on their own Macs and your Mac won't be involved in processing their work. (This will speed up the other users' work as well as yours—you always get better performance by working with a file on your own disk than with one over a network.) After the other users have made their changes to the shared files, they can save them back to your disk.

This solution works best with small files, which can be copied quickly over the network. Also, you may want to monitor what files are copied and when they’re copied—especially if they’re ones that several users share on a regular basis. If two users need to use the same file at the same time, and they both make changes to different copies of it, you’ll have to reconstruct a single up-to-date file from the two modified versions—which can be difficult, if not impossible.

File sharing wasn’t designed as a replacement for dedicated network servers like AppleShare. If you regularly share lots of files among several users, you’ll want to invest in an AppleShare server.

Disconnecting users

If you’re backing up your hard disk, using a hard disk optimizer, working with sensitive information in a shared folder or performing other delicate operations, you should disconnect users currently sharing files with your Mac. In other cases you might want to disconnect just one user. It’s unlikely you’ll want to take the drastic step of turning off your Mac or physically unplugging it from the network just to disconnect one or more users.
So, to disconnect one user:

1. Open the File Sharing Monitor control panel.
2. Select the name of the user you want to disconnect in the Connected Users list.
3. Click the **Disconnect** button. When you tell the Mac to disconnect a user, it displays a dialog box like this:

   ![Dialog Box](image)

   The default time is ten minutes, but you can set it for any amount (up to 999). To disconnect a user immediately, type \( 0 \) (zero).

   Don’t disconnect a user without warning unless you’re sure the user isn’t currently accessing any files on your Mac.

4. Click the **OK** button. On the Mac you’ve just disconnected, a message will appear on its screen telling the user that he or she will be disconnected after the time you specified. When the disconnection actually happens, the user will see another alert saying that he or she is no longer connected.

To disconnect everyone from your Mac at once:

1. Open the Sharing Setup control panel.
2. Click the **Stop** button in the File Sharing area. You’ll see the above dialog box, for setting the time until disconnection.
3. Type in how much time you want to give them.

4. Click the OK button. Your Mac will stop sharing files when the time you set elapses.

Be careful when disconnecting users from your Mac. Even if you give people what seems like plenty of time to close any shared files, make sure they actually close them. A user with an open shared file might be out to lunch, for example, and not see your message until well after the disconnection and any damage has occurred. It's always a good idea to check verbally with connected users, if possible, to make sure they see the disconnect warning. (See Chapter 14 for more file sharing tips.)

---

**Connecting your Mac to other Macs**

So far, we've been covering making your Mac's files available for other Macs to share. When you want to connect to shared files on other Macs, the procedure's entirely different. You don't even need to have file sharing on.

**Tip**

If you're not sharing items from your disk, leave file sharing off. Otherwise, you're wasting about 300K of memory.

**Connecting to a shared item**

To access a shared disk or folder on another Mac, you must connect (or log on) to the remote Mac you want to access, and then select the disk or folder you want to use. You use the AppleShare resource in the Chooser to do this:

1. Select the Chooser from the \( \text{\textbullet\textbullet\textbullet} \) Menu. The Chooser window opens.

2. Click the AppleShare icon. At the right side of the window, a list of Macs available for sharing will appear, like this:
3. Select the name of the Mac you want to use and click the OK button. A log-on dialog box will appear, like this:

4. Your Mac's Owner name will appear in the Name box. If you aren't the Mac's owner, type your user name. Then press Tab and type your password. If you aren't a registered user for the Mac you want, click the Guest button to register
as a guest. (If you don’t know whether you have a registered user name, check with the other Mac’s owner.)

5. Click OK. You’ll be connected to the other Mac, and you’ll see this dialog box for selecting specific shared items:

Only disks or folders that the remote Mac’s owner has made available for sharing will appear in this dialog box.

6. Click on the folder or disk name you want to share. (Shift)-click or drag in the list to select more than one item.

7. Click OK. The shared item(s) will appear on your desktop.

**Connecting to a shared item automatically at startup**

If you use a shared item constantly, you may want to set up your Mac so it automatically puts the item on your desktop every time you start up. To do this:

1. Select all the items you want to share (steps 1 through 6 in the section directly above).

2. Check the checkbox(es) next to the item(s) you want automatically placed on your desktop. Two new buttons will appear at the bottom of the box, like this:
If you click the **Save My Name Only** button, then you’ll be asked to enter your password each time your Mac starts up, (unless you’ve connected to the Mac as a guest user).
If you’re a registered user, choose this option when other people use your Mac and you don’t want them to use the shared folders you’ve set to automatically be put on the desktop. When they start up your Mac, they won’t know the password for the log-in dialog box, and they’ll click the **Cancel** button. Then the Mac will start up, but the shared folder won’t appear on the desktop.

If you click the **Save My Name and Password** button, then you’ll automatically be logged on and the shared item will appear on your desktop without your having to do anything.

3. Click the **OK** button. The shared item will appear on your desktop, and it will appear there each time you start up your Mac.

**Changing your password**

If you’re not using registered user names and passwords when you share files, skip this section.
When you share the files of several different Macs on your network, you must register and log on to each Mac individually. If you connect as a registered user rather than as a guest, it’s best to use the same user name and password throughout. Otherwise, you’ll have to remember which name and password you need for each Mac on your network.

Likewise, Mac owners must register users by name, so you should get together with others on your network to make sure you’re all using the same names to register each other (see File sharing tips Chapter 14, p. 244). If they’re not consistent, each file-sharing Mac’s owner can change them so they are (owners can also allow for you to change your own password when they register your user name—see Setting user access options, Chapter 13, p. 226).

If you’re allowed to change your password, you use the log-in procedure to do it; and in order to do it, you must know the existing one. (Otherwise, anyone could set the password and gain access to your files.) This is how you change it:

1. If you’re already connected to the Mac where you want to change your password, disconnect from it by dragging the shared item’s icon to the Trash on your desktop.

2. Select the file-sharing Mac you want with the Chooser (see Connecting to a shared item, p. 216 above if you need the steps). The log-in dialog box will appear.

3. Click the Set Password button. A dialog box will ask you to enter your current password and new password, like this:

   ![Password dialog box](image)
4. Type your old password and new password in the boxes provided, then click OK. You’ll be asked to re-enter the new password to confirm it.

5. Re-enter your password and click OK again. The second dialog box appears so you can select specific shared items on the remote Mac’s disk. From here, you can continue the log-in procedure normally.

Using a shared item

Once a shared item appears on your desktop, what you can do with it depends on the access privileges you have for that item. If an item has been shared following only the procedures in this chapter, it has the default access privileges and you’ll be able to use the files in that item just as if they were on a disk connected locally to your Mac. But your access privileges for shared items may be restricted—see Chapter 13, p. 230.

If you have full access privileges within a shared folder or disk, you can make new folders inside it. As you know, when you make a new folder and become the folder’s owner, only you can change that folder’s access privileges. However, the remote Mac’s owner is still the owner of the shared item that contains the folder you’ve created.

Disconnecting from a shared item

When you shut down your Mac, you’ll be automatically disconnected from any shared items on your desktop. To disconnect from a shared item without shutting down:

1. Make sure you’ve closed all the files from the shared item.

2. Select the item’s icon on the desktop and either drag it to the Trash, or choose Put Away from the File menu.
As explained in Chapter 12, you can share your folders or disks with other users on a network. If you accept the default settings, sharing an item means that everyone on the network can see, copy, rename, change or delete the files in that item.
By registering **users** and **groups** and setting **access privileges**, though, you can specify who shares your files and what they can do with them:

- With registered users or groups, you can share items with some users but not with others.
- By changing access privileges, you control what others can do with your shared items. For example, you can let some users change the contents of a shared folder while letting others see the contents, but not change them.

In this chapter, we'll cover all the details of registering users and groups and setting access privileges. We assume you've read Chapter 12 or at least have registered your Macintosh name and owner name with the Sharing Setup control panel. If you haven't, see *Setting up file sharing* in Chapter 12, p. 208.

### About users and groups

#### Registering users

As a Mac's owner, you control who can connect to your shared items. You register specific user names and then assign different access privileges to different users and to guests. Privileges for a particular user apply only to that user, while those you assign for guests apply to anyone who registers as a guest.

Before you can assign access privileges to a particular user, you must register that user's name. Register as many users as you want, as long as each of them has a unique name.

To register a user:

1. Open the **Users & Groups** control panel in the Control Panels folder. It looks like the one at the top of the next page:
If the Users & Groups control panel hasn’t been used on your Mac before, you’ll only see two icons, one for a guest user and one for yourself as the Mac’s owner. The owner’s icon has a heavier outline to distinguish it from other user icons.

2. Choose New User from the File menu. A New User icon appears in the control panel with the name selected, like this:

3. Type the user’s name, and then press Return or Enter, or click away from the icon to confirm the name change.
Setting user access options

Once you've created a user, you can set that user's access options. Access options determine the level of access a user may have to your shared items (subject to further restriction by the access privileges you set for each of those items; see p. 230). To set a user's access options:

1. Doubleclick that user's icon in the Users & Groups control panel. The user's window opens, like this:

![User window](image)

2. If you like, type a password the user will need to get into your system in the User Password box, then close the window. The next time you open this user's window, a string of bullets will have replaced the actual password to hide it from view.

It's usually better to let users select their own passwords; if you don't, be sure to tell them what their passwords are.
Users., groups and access privileges

The *Allow User to Connect* checkbox is normally checked so the user can connect to your Mac. Uncheck the box if you don’t want the user to have access to your Mac.

The *Allow User to Change Password* checkbox is also normally checked, so the user can change the password you’ve entered. If you don’t want the user to be able to change the password, uncheck the box.

The *Groups* list shows the names of all the groups to which the user belongs. At first this list will be blank because you haven’t created any groups yet. (See *Registering groups*, p. 229 below).

Finally, the *Program Linking* area has a checkbox that lets a remote user’s programs exchange information with programs on your disk. See Chapter 15 for more information on program linking.

**Changing owner and guest access options**

You can also set access options that always apply to guest users or to yourself as the Mac’s owner (for times when you access this Mac from other Macs on the network).

To set the owner access options, doubleclick the owner’s icon in the Users & Groups control panel. The owner window will appear, like the one at the top of the next page:
The only difference between this window and an ordinary user window is the *Allow User to See Entire Volume* checkbox. Checking this allows you to access all the disks, folders or files on your Mac from another one, whether or not items have been shared—which is convenient if you have to use someone else’s Mac.

To set guest options, doubleclick on the Guest icon in the Users & Groups control panel. The Guest window appears, like this:
Users, groups and access privileges

The only file sharing option here is to allow or deny guests access to your Mac. The default setting allows access. Uncheck the box if you don’t want guests to connect to your Mac. (For more on the Program Linking option, see Chapter 15.)

Registering groups

Creating groups lets you assign the same access privileges to several users at the same time. Once you create a group, adding or removing users is easy.

To create a group of users:

1. Choose New Group from the File menu. A New Group icon appears in the Users & Groups control panel with the name selected, like this:

2. Type a different name for the group if you want, then press Return or Enter to confirm it, or click away from the icon.

3. To add users to the group, drag their icons on top of the new group icon. A message will tell you the user is being added to the group. But the user’s icon still appears by itself in the Users & Groups control panel. (That’s because a single user might have additional privileges beyond those assigned to any group he or she is part of.)
To see all the users in a group, double-click its icon. You'll see the group's window, like this:

You can also add users to a group by dragging them inside this window.

Deleting users and groups

You can delete registered users or groups at any time. But you can't delete the Owner or Guest icons.

To delete a user from your Mac, select the user's icon in the Users & Groups control panel and drag it to the Trash.

To delete a user from a group, open the group window and drag the user's icon from there into the Trash. (This won't delete the user's icon from the Users & Groups control panel.)

To delete an entire group, select the group's icon in the Users & Groups control panel and drag it to the Trash. (This doesn't delete individual users from the Users & Groups control panel, only the group.)

About access privileges

Whether or not you register specific users on your Mac, you can specify access privileges for your shared items. (These may be
items on your own hard disk, or ones you’ve created on another user’s shared disk.)

Whenever you have file sharing turned on and you select an item to share on your disk and then choose the Sharing… command from the File menu, the sharing window presents you with several options for setting access privileges, defaulted like this:

![Shared Stuff](image)

The Share this item and its contents checkbox is checked, and the access privileges options in the middle of the window are active. If you uncheck the Share this item and its contents checkbox, the access privileges will be dimmed, because there are no privileges to set if the item isn’t being shared.

Whenever you have file sharing turned on, you can select any item on any disk and choose the Sharing… command to view its current setting. If file sharing isn’t turned on at the time, you’ll see an alert that tells you sharing must be on first. If you’re not the owner of a selected item, the sharing window will still appear, but you won’t be able to share the item or change its access privileges.
Kinds of access privileges

There are three classes of access privileges you can set in the sharing window:

- **See Folders** means users can see a folder but not open it to see what’s in it or work with its contents.
- **See Files** means users can open a folder and open its files or copy them to their own disks.
- **Make Changes** by itself means users can save new files to a folder. If **See Folders** and **See Files** are also checked, users can open the folder and open, copy, rename, change or delete files or folders within it.

You can use the checkboxes in any combination for different situations. When a box is checked, that privilege is granted; when it’s unchecked, that privilege is withheld.

The sample window on the preceding page (Shared Stuff) shows the default access privileges. Everything is checked, so anyone who shares this item can do anything with it. For some examples of different access privileges you can set, see *Access privileges in action* at the end of this chapter, p. 238.

Classes of users

The sharing window lets you set access privileges for three levels of user: the Mac’s **Owner**, a specific user or group of users (**User/Group**) and all other users (**Everyone**).

The Owner and User/Group boxes are actually pop-up menus. You can choose a new owner for the shared item or assign access privileges to a specific user or group by selecting different names from these pop-up menus.

Until you’ve registered other users and groups, the Owner menu will list only your name and *<Any User>*; and the User/Group menu will say *<None>*.
If you’re the owner of a folder, you’ll want to be able to do anything with its contents, so you would normally leave all the Owner checkboxes checked. To restrict access privileges for specific users, groups or guests, uncheck the box(es) for the class(es) of privileges you want to deny.

For more on how these settings work, see *Access privileges in action* on p. 238, later in this chapter.

**Other access options**

The two checkboxes at the bottom of the sharing window give you additional control over folder access.

The *Make all enclosed folders like this one* checkbox lets you copy the privileges of the current folder to any other folders contained (or nested) in it. This option saves you the trouble of setting the options for nested folders individually. If you don’t check this box or set specific privileges separately, any nested folders will have the default access privileges.

When you first make a new folder inside a shared disk or folder, its default access privileges are the same as the ones set for the disk or folder itself, and you’re the new folder’s owner.

The *Can’t be moved, renamed or deleted* checkbox locks the folder so its name and location can’t be changed. This is often a wise precaution, since you’ve probably given folders their names and locations for a good reason and you don’t want others to be able to change them.

**Using consistent user names**

Once you register a user’s name, that person must use that exact name to connect to your Mac, so be sure to tell other users exactly what names you’ve registered them with.

So again, it’s easiest if every Mac owner on the network uses the same set of names when registering users.
Viewing access privileges

With lots of people setting access privileges and sharing files, it's not always easy to remember which user has which privileges for each shared item, or even who owns each shared folder. Fortunately, there are lots of ways to find these things out.

Checking access privileges

To see the specific access privileges for an item and find out who owns it, use the Sharing... command on the File menu in the Finder:

1. Make sure file sharing is turned on with the Sharing Setup control panel. (See Turning file sharing on on p. 211 in Chapter 12.) Note: this step isn't necessary if you're selecting an item you've connected to over the network.
2. Select the shared item.
3. Choose Sharing... from the File menu. The item's sharing window will open. If the shared item is one from your own disk and you're the item's owner, the access privileges options will be active. If the shared item you select is one you've connected to over the network, you'll see a sharing window like the one at the top of the next page:
The sharing window for an item located on another Mac shows **Where** the item is located, the user name you’ve used to connect to that Mac (**Connected As**), and the access **Privileges** you have for that item. Notice that the Where information includes the disk name and Mac name.

If your network has more than one zone, the network zone name follows the Mac name in the Where information in a sharing window.

Because you’re not the item’s owner, you don’t have the option to share this item; all the access privilege options in the middle and bottom of the window are dimmed, because you aren’t allowed to change them.

**Folder privileges icons**

Along with the **Sharing**... command, there are graphic clues to your access privileges with shared items. These are visible when you view folders and windows inside shared items on the desktop.

When you look at a shared item in Icon or Small Icon view, icons representing shared folders can be **plain, tabbed, belted** or **belted with an arrow**.
A plain folder icon looks just like any folder you’ve created on your own disk, and it means you can at least open the folder. (You’ll need to select the folder and open it or choose Sharing… to see what privileges you may have beyond that.)

A tabbed folder looks like this:

![Tabbed Folder]

When you have file sharing on, any folder on your disk that is available for others to share has a tabbed icon and network cables coming out of the bottom of it. When you view folders you own on other users’ shared Macs, they also have a tabbed icon, but no network cables.

A belted folder looks like this:

![Belted Folder]

This icon means this folder is off limits—you can’t open it and don’t have any privileges with it. Folders like this appear gray in list view windows.

There’s also a belted folder with an arrow, like this:

![Belted Folder with Arrow]

This icon means you can’t open the folder, but the arrow means you can save items to it. This type of folder is sometimes called a “drop box” because you can put things into it but you
can’t see its contents. With a folder like this, you have Make Changes privileges only.

**Warning**

If you’ve replaced your standard folder icons with custom icons, the folder privileges icons don’t appear.

**Window privileges icons**

When you open a shared folder or disk, its window may contain icons that tell you which access privileges you don’t have. These icons appear at the left edge of the space just below the window’s title bar, like this:

![Window contents](image)

(This happens to be a list view window, but the icons show up in icon views as well.) In this case the user has See Files privileges, but not Make Changes or See Folders privileges—the pencil icon means no changes and the folder icon means can’t see folders. (There are actually folders stored in this window’s folder, but they’re not visible because the user doesn’t have privileges to see them.)

Along with the no changes and can’t see folders icons, there’s a can’t see files icon like this:

![Can’t see files icon](image)

If you had See Folders privileges only, you’d see this icon and the no changes one below the window’s title bar. If you had full
privileges, you wouldn’t see any icons. In other words, the window shows you only what you can’t do, not what you can.

Access privileges in action

The checkboxes in the sharing window allow you to assign many different combinations of privileges, but it isn’t obvious how some of these combinations work.

File and folder privileges

The three columns of privileges, See Folders, See Files, and Make Changes, can be used in various combinations to allow different types of access. Here are some examples:

<table>
<thead>
<tr>
<th>See Folders</th>
<th>See Files</th>
<th>Make Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>☒</td>
<td>☒</td>
<td>☒</td>
</tr>
</tbody>
</table>

Here people can open files and folders inside the shared item and copy files to their own disks, but they can’t add any new files or folders to it, and they can’t change any of the existing items.

<table>
<thead>
<tr>
<th>See Folders</th>
<th>See Files</th>
<th>Make Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>☒</td>
<td>☒</td>
</tr>
</tbody>
</table>

With this set of privileges, users can see individual files inside your shared item and make changes to them (or add new files or folders), but any folders inside the shared item will be invisible. This combination is good when you have private folders inside a shared item, because other users won’t even be able to see them.
Users, groups and access privileges

Here others can save new items to the shared item or to folders inside it, but they can’t see any individual files in the shared item.

This option means others can’t see folders inside the shared item or make any changes to it. They can only view, open and copy individual files inside the shared item.

This is the “drop box” option, with which others can save files into the shared item, but they can’t open it to see its contents.

Privileges by user class

The access others have to your shared items depends not only on file and folder privileges, but on which classes of users have them. There are three rows of file and folder privileges checkboxes: one for the item’s owner, one for specific users and groups, and one for everyone, and, you must be careful which rows of checkboxes are set, as well as which checkboxes. On the next page are some examples:
### Users, groups and access privileges

**Owner:** Charlie

**User/Group:**<br>
- Everyone

Here, everyone who can connect to this Mac has full privileges to the shared item.

**Owner:** Charlie

**User/Group:** Marketing

- Everyone

The above setting also gives everyone full access to this item. This is the same as having all the boxes in every row checked.

**Owner:** Charlie

**User/Group:** Marketing

- Everyone

Here, full privileges are granted only to the owner (Charlie) and the Marketing group. Everyone else has no access to this item.
Here, the Marketing group’s boxes aren’t checked (so you would think that this group has no access to the item), but since the Everyone boxes are checked, everyone (including the Marketing group) still has full access. This example shows the “lowest common denominator” operation of the Sharing window—you must uncheck the Everyone boxes to limit access to specific users or groups.

<table>
<thead>
<tr>
<th>Owner: Charlie</th>
<th>See Folders</th>
<th>See Files</th>
<th>Make Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>User/Group: Marketing</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Everyone</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

Here, only the owner has privileges. All other users are denied access.

<table>
<thead>
<tr>
<th>Owner: Charlie</th>
<th>See Folders</th>
<th>See Files</th>
<th>Make Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>User/Group: Doris</td>
<td>☒</td>
<td>☒</td>
<td>☒</td>
</tr>
<tr>
<td>Everyone</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

In this case, only the user named Doris has access.

---

**How secure is it?**

When you share files, there are lots of ways to set users, groups and access privileges to create a custom data security scheme on your Mac. As you experiment with these options, you’ll find just the right combination of privileges, users and groups to give others exactly as much access to your files as they need.
However, the access privileges options in System 7.1 are only designed to limit access to people who will respect the privileges you set.

Even though you can set an owner password when you use the Sharing Setup control panel, anyone can change that password at any time, and anyone who has access to your Mac can reset the access privileges to any shared item.

If you have highly sensitive information on your hard disk and you want to be sure nobody else can access it, you should use a commercial security or data encryption utility. Check with your Apple dealer or software retailer for more information on these.
File sharing can make you a lot more productive, but it's also fairly complex. In this chapter, we'll look at some ways to make file sharing as easy and reliable as possible and see how to solve some common problems.
File sharing tips

Some of these suggestions have been mentioned in Chapters 12 and 13, but this section expands on them.

Keep it simple

The more you use the various access privileges and user registration options available with file sharing, the more difficult it becomes to keep track of all the safeguards you’ve created. If you share files a lot, users will invariably want access to something on your Mac they can’t get to, and you’ll be forever resetting access privileges or moving files around. Eventually you may find just the right set of options for everyone, but it will take a while.

The best security system is the simplest. When you first turn on file sharing, there are no registered users (except yourself) and no groups of users. When you first share any item, everyone on the network has access to it. Unless you have a really good reason to limit access, don’t do it, because you’ll probably end up having to change it later. After all, you can limit access to files without setting special privileges—just don’t share them.

Make a folder called “Shared Stuff” and share just that folder. Then, drag only the items you want to share inside that folder.

Use consistent user names and passwords

To access shared files on a Mac, a user must either know the specific name and password under which he or she is registered on that particular Mac, or register as a guest.

If you and others on your network are registering users, be sure you all use the same user names on every Mac. If a user is named Margaret, for example, don’t register her as Margaret on one Mac, Maggie on another and Marge on a third. If you do, Margaret will have to remember how she’s registered on every Mac.
File sharing tips and troubleshooting

What's good for user names is also good for passwords, only in this case it's best to let the user choose a password. When you create a new user, you have the option of entering a password for the user in the user window. Whether you enter a password or not, leave on the default setting in the user window which allows the user to change the password. (See *Changing your password* Chapter 12, p. 219.)

**Use aliases**

If you must frequently add users, create groups or monitor user activity on your Mac, create aliases for the Users & Groups and File Sharing Monitor control panels and put them on the menu. That way you don't have to open the Control Panels folder first to get to them. (See *The Make Alias command* in Chapter 5, p. 77, for more information.)

You can use aliases inside shared items, too. Placing an alias in a shared folder allows others to open the original item, but since users only see the alias, they can't rename or delete the original item.

**Save files locally**

If a file-sharing Mac crashes while you're accessing its files, you'll lose your access to those files. If you're allowed to, save any shared file to your own hard disk as soon as you connect to the shared Mac. The file will then be safely stored on your disk in case the connection is broken.

Before shutting down or restarting a file-sharing Mac, choose one of the options to disconnect other users so they'll be warned. (See *Disconnecting users* and *Disconnecting from a shared item* in Chapter 12, p. 214 and p. 221 respectively.)

**Don't overdo it**

File sharing is a very handy feature of System 7.1, but it's no substitute for a dedicated file server when lots of people on a network
File sharing tips and troubleshooting

want to use the same disk or folder. Try to share only the items on your disk that really need to be shared, and encourage others to make local copies of your shared items so they’re not constantly accessing them on your Mac.

Every time a remote user accesses an item on your Mac, your Mac has to devote some of its performance to serving that user’s request, which means that it will be slower to respond to your own commands. If your shared items are being accessed by others so frequently that it interferes with your own work, it’s time to consider other options like placing the shared item on a dedicated AppleShare server or another file server, or distributing copies of the item for other users to store on their own disks.

File sharing troubleshooting

Until you've used file sharing for a while, you may not know exactly what's gone wrong when something you don't expect happens. In this section, we'll take a quick look at some common file sharing problems.

File sharing won't start

If you can’t start file sharing when you click Start in the Sharing Setup control panel, make sure you:

- are physically connected to an AppleTalk network
- have AppleTalk set to Active in the Chooser window
- have entered an Owner Name and Macintosh Name in the Sharing Setup dialog box

See Turning file sharing on in Chapter 12, p. 211 for more information.
You can’t find a file-sharing Mac on the network

If you click on the AppleShare resource in the Chooser to display all the file-sharing Macs available and you don’t see the Mac name you’re looking for, there are a couple of possibilities:

1. The shared Mac doesn’t have file sharing on. Check that Mac to see if this is the case.

2. Your Mac or the file-sharing Mac is physically disconnected from the network. To find out if this is the problem, click the LaserWriter resource in the Chooser window—from both your own Mac and the file-sharing one. If one or more LaserWriter names appear, then that Mac’s connected to the network. (Remember, if your LaserWriter is turned off, it won’t show up in the Chooser window.) If no names appear, check that the networking cable is plugged into your Mac’s printer port or network adapter card (if you have one).

If everything looks okay, you’ll have to call a technician or your network administrator to diagnose the problem.

You can find a file-sharing Mac, but you can’t connect to it

If you can see the file-sharing Mac you want but you have trouble connecting to it, there are two possible problems. Either you’re using a name or password different from the one that’s registered on that Mac, or the Mac’s owner isn’t allowing anyone to connect.

In either case, you’ll see an alert box like this:

```
Unknown user or log on is disabled.
Please retype the name or contact the server’s administrator.
```

OK
First try to enter your name and password a few times—you may have mistyped them. Make sure you're using uppercase or lowercase letters exactly as you're supposed to, and that you're not typing any extra spaces.

If this doesn't work, check your user name and password with the remote Mac's owner to make sure you're typing exactly the same ones registered on that Mac. You'll either correct your mistake or you'll find out that the Mac's owner isn't currently allowing people to connect.

**You have forgotten your password**

If you've forgotten your password, you have three remedies.

1. If another Mac owner set your password, ask him or her for it.

2. If the other Mac's owner set your password originally and doesn't remember it, he or she can enter a new one.

3. If you have physical access to the other Mac, you can use its Users & Groups control panel to re-register yourself.

The moral here is: *Don't forget your password.* Write it down some place where you can find it later.

**You can connect to a file-sharing Mac, but you can't find the folder or disk you're looking for**

In this case, the owner of the file-sharing Mac simply hasn't made the folder or disk available for sharing, or available to you. Check with the Mac's owner.

**You can't change the access privileges for a shared item**

This means you're not the item's owner. Look in the Owner box in the Sharing window to see who the owner is, then ask the owner to reset the privileges if you need more access (or reset them yourself at that owner's Mac, if it's available to you). If you want to
control the access privileges, you'll have to get the owner to transfer the item's ownership to you by choosing your name from the Owner menu in that item's Sharing window.

**You can't open a shared folder, see its files or save files to it**

If you can connect to a shared folder but then can't open it on your desktop, see folders or files inside it, or save new or changed files to it, you don't have the necessary access privileges. Check with the owner of the folder to see if he or she will change the privileges for you. You can tell who owns the folder by selecting it on the desktop and choosing the Sharing... command from the File menu.

Sometimes you won't be aware that your privileges are limited until you try to save a document to a shared item. If you get an alert box that says you don't have the proper access privileges, check with the remote Mac's owner.

**You can't move, rename or delete a shared item**

In this case, the shared item's owner has created these restrictions by clicking the Can't be moved, renamed or deleted checkbox at the bottom of the folder's sharing window. To remove the restrictions, the folder's owner must select the item, choose Sharing... from the File menu, and uncheck the checkbox.

**You can't find a user or group name**

If you're trying to choose a name from one of the pop-up menus in the Sharing window and the user or group name doesn't appear, that user or group hasn't been registered on the Mac you're using. Even if you've registered users or groups on your own Mac, it doesn't mean that they are registered on other Macs. Each Mac owner must register the users or groups that will be allowed to connect to his or her Mac.
Your connection with a shared item is suddenly cut off

Your connection with a shared item may be deliberately cut off by the item’s owner or accidentally disconnected by a system crash or network failure.

If the shared item’s owner is cutting you off deliberately, you’ll usually get a warning on your screen, like this:

"Doris' Mac"

The file server is closing down in 5 minute(s)
[12:11 PM on 3/1/91].

OK

(You won’t be warned in advance if the owner just shuts down or unplugs the Mac from the network.)

At the top of the box you’ll see the name and location of the Mac that you’re being disconnected from. A series of warnings like this means that you’re being deliberately cut off. Ask the shared Mac’s owner about reconnecting. To stop the messages from popping up, drag the shared item’s icon to the Trash.

When a cutoff takes place, deliberate or not, you’ll usually see an alert like the one at the top of the next page:
Check with the remote Mac's owner to see what went wrong. If the network's physical connection is broken, you may also see the above warning.

If the remote Mac is physically disconnected or crashes, you may not see an alert at all. Sometimes, the double arrow icon will appear at the left edge of the menu bar to show that your Mac is using the network, but the arrows will stay there and your Mac will lock up when you try to use the shared item. In this case you'll have to restart your Mac to continue working. Test your connection using step 2 in You can't find a file-sharing Mac on the network on p. 247. If your connection is okay, ask the owner of the remote Mac to resolve the problem from his or her end.
Program linking, IAC and Apple Events

System 7.1 has a powerful new capability called Inter-Application Communication (IAC) that allows different programs to exchange commands or data with one another automatically. IAC goes far beyond cut and paste or publish and subscribe because it allows programs to actually launch, quit, and otherwise control one another as well as exchange data.
For example, you might have a database that produces a summary of data calculated from sales records, and each week you need to transfer that data to a spreadsheet program and make a chart of it. With IAC, you could send a command from the database program to open the spreadsheet document, copy the summary data into the spreadsheet document, and then run a spreadsheet macro or script that automatically produces the chart you need.

IAC is the basic capability that allows these exchanges. It is built into System 7.1. The commands themselves, however, are called Apple Events, and it's up to the developers of individual programs to support Apple Events.

Apple itself has defined four "required" Apple Events (Open Document, Open Application, Print Document and Quit Application), and any program that supports Apple Events is required to support these four events. However, Apple has also asked all of its developers to create and register more specific Apple Events of their own. All these are being compiled into a directory available to developers, so that anyone creating or updating a program for System 7.1 will be able to support many more events if they choose.

For information on the Apple Events directory, contact the Apple Program Developers Association at Apple Computer.

Eventually, most programs will support Apple Events, and this will make integrating information on the Mac easier and more effective than ever. Thanks to Apple Events, you'll be able to use the best program for the job every time, rather than relying on one program to do things that could be done better with another. For example, you might want to create charts of spreadsheet data, and a dedicated charting program might offer you more power and design flexibility than the spreadsheet's own built-in chart function. With Apple Events, you'll be able to send the spreadsheet data to the charting program and have it charted there automatically.
Program linking is the feature in System 7.1 that you must activate before your programs can exchange Apple Events with one another. With program linking on and applications set up to allow linking, your programs can exchange Apple Events with programs on file-sharing Macs or AppleShare servers across a network. (To send Apple Events between different programs on your own Mac, you don’t need to have program linking on.

As with IAC and Apple Events, System 7.1 makes program linking possible, but your programs must support it before you can actually use it. It’s like a telephone system: System 7.1 provides the basic telephone wires between different programs and lets you turn on the connections, but the individual programs must be able to understand each other once the connection is made. If a program supports program linking, it also supports at least the four basic Apple Events.

Programs that support Apple Events have their own ways of allowing you to send these events, and their manuals will explain how to use it. At this writing, programs that support Apple Events include HyperCard 2.1 or later, FileMaker Pro 2.0 or later, QuicKeys 2, Resolve 1.1 or later, and Excel 4.0 or later. The procedure for sending Apple Events and the events you can send will be different for each program, so you should refer to that program’s manual for more information.

In this chapter, we’ll focus on activating and managing program linking using System 7.1.

Two ways to link programs

As with file sharing, there are different procedures for linking programs, depending on whether you or another network user is doing the linking. (If you’re sending Apple Events to other programs on your own hard disk(s), you don’t need to turn on program linking and can skip this section.)
1. **Linking from your Mac to other programs** If you’re linking from a program on your Mac to programs on your Mac or on other networked Macs, you don’t need to start program linking. Instead, you choose a command inside your program and then select the other program(s) you want to link to. This is managed entirely by individual programs, which will have their own specific menus, commands and dialog boxes. Check your program’s manual for further instructions.

   If you’re linking to a program on a remote Mac, you’ll have to connect to that Mac first, of course, either as a guest or with a registered user name (see *Connecting your Mac to other Macs*, Chapter 12, p. 216 for more information). And you’ll only be able to link to those programs made available for that purpose (see *Controlling other users’ access to your shared programs*, p. 258 below).

2. **Sharing your programs so others can link to them** If you’re sharing your Mac’s programs so other users on the network can link to them, you have to turn on program linking at your Mac and then identify the programs you want to share. There are various ways to control other users’ access to your programs once you turn program linking on.

---

**Starting program linking**

Before you can even turn program linking on, you must be connected to an AppleTalk network and have AppleTalk set to *Active* in the Chooser window. If you’re sharing a LaserWriter on a network, these have already been done. If you’re connecting to a network for the first time, see *Setting up file sharing*, Chapter 12, p. 208, for network information.
Once you’ve got an AppleTalk network connected and active, you turn on program linking using the Sharing Setup control panel in the Control Panels folder. (That control panel is covered in detail in Chapter 12, p. 209.)

1. Open the Sharing Setup control panel.

2. Click the Start button in the Program Linking area at the bottom of the control panel.

   You’ll see a message in the Status area that says program linking is starting up, and the Start button name will change to Cancel. To cancel the startup at this point, click the Cancel button. Once program linking is on, the Status area will say so, and the Cancel button’s name will change to Stop.

3. Close the Sharing Setup control panel.

   Program linking is now on. To share specific programs at this point, you must select them individually and share them.

---

**Sharing your programs with other users**

Just as with shared items in file sharing, you must select specific programs you want to share for program linking, and then make them available to the network. As with file sharing, you identify programs to share with the Sharing... command.

1. Choose a program you want to share by selecting its icon on the desktop.

2. Choose Sharing... from the File menu. The program’s sharing window appears, like this:
3. Check the **Allow remote program linking** checkbox, if it isn't checked already. If this box is dimmed, the program you’ve selected doesn’t support program linking.

4. Close the sharing window. The program is now available for other users to link to.

---

**Controlling other users’ access to your shared programs**

Other users who want to share your programs must first connect to your Mac, either as guests or as registered users with passwords. (See *Connecting your Mac to other Macs*, Chapter 12, p. 216, for more information.)

By granting access to specific users, as outlined in Chapter 13, you control who can link to your programs. By granting access to guest users, you can let anyone on your network link to your programs. Users and guests are not allowed program linking until you specifically permit it, which you do with the Users & Groups control panel:

1. Open the Users & Groups control panel in the Control Panels folder.
2. Doubleclick on the icon for the user whose access you want to change. The user’s window opens, like this:

![User window](image)

3. Check the *Allow remote user to link to my programs* checkbox in the Program Linking area.

4. Close the window.

That user can now link to your shared programs.

To stop a user from linking to your programs, uncheck the *Allow remote user*... checkbox. Unlike turning program linking off (see section below), this won’t cut the user off if he or she is currently linked to programs on your Mac—but it will deny future access to that user.

Controlling access to guest users is just the same, except the checkbox in the Guest user’s window says *Allow guest to link to my programs*.

Here’s a review of the various access options you have with program linking and how to set them:
Access level | Action
---|---
No access to any program | Turn program linking off.
No access to a particular program | Don’t share that program.
No access for a particular user | For each user and guest, no access is the default, so just leave it alone.
No access for guests

**Turning program linking off**

When you want to stop program linking, just open the Sharing Setup control panel and click the Stop button in the Program Linking section of the window. Any users linked to that program will get an alert message that tells them the link has been broken.

**Managing program linking performance**

Whenever someone else’s linked program is exchanging information with yours, it affects the performance of your Mac. Your Mac has to divide its resources between handling program linking and handling any work you’re doing yourself. Apple says you can have up to 100 users linking to programs on your Mac at the same time, but it recommends no more than 50 users linked at a time.

The only way to regulate your Mac’s performance with program linking is to limit the number of users who can link to your programs. The 50-user suggestion is an arbitrary one—with a Mac Classic or another relatively low-powered machine, your Mac’s performance will probably slow to an absolute crawl well before 50 users are linked.
Performance will also depend on which programs are linked, how much data or how many Apple Events they exchange, what those Apple Events are, and how often they exchange information. As always, experiment in your own situation to find out what suits you best.
As you work with System 7.1, you’ll run into unfamiliar terms and concepts dealing with new Macintosh capabilities. Most of these are defined the first time they appear in each chapter, but you can also look them up here for quick reference.

See Help menu below.

**access options**

In *file sharing*, a set of permissions assigned to a user which governs that user’s basic abilities to connect to a shared Macintosh.

**access privileges**

The right to view or change specified files and/or folders in a shared folder or disk, given to other users on a *network*.

**alias**

A small file that represents and operates like another file, folder, disk—even the Trash. Aliases allow you to open these items from various places—like the ⌘ menu, the Finder desktop or inside a folder.

**Apple Events**

Commands that can be exchanged between programs to open documents, select data, and perform many other tasks automatically. Programs must specifically support Apple Events in order to use them. Also see *Inter-Application Communication*. 
**AppleShare**

1. Software that turns a Macintosh with a hard disk into a *file server*, and allows individual Macs on a *network* to share the files on that server.

2. A Chooser extension that lets you connect to other Macintoshes or AppleShare *file servers* on a *network*.

**Apple Menu Items folder**

A folder inside the System Folder that stores desk accessories or other items you want to appear on the ⌘ menu.

**Application menu**

A menu in the Finder that displays all the programs or *desk accessories (DAs)* you currently have open.

**Balloon Help**

A feature in the Finder that automatically displays balloons containing explanations of different items, such as menus, commands or window elements, when you point to them with the mouse.

**bit**

The smallest possible unit of information. It can represent only one of two things: yes or no, on or off or—as it’s expressed in the binary numbers used in computers—0 or 1. Short for *binary digit*. Also see *byte*.

**bitmap**

A pattern of dots used by the Mac’s screen or a printer to represent a character or other graphic object.

**byte**

Eight *bits*. Bytes are typically used to represent characters (letters, numbers, punctuation marks and other symbols) in text.

**cdev**

A *control panel* device—in System 7.1, these are just called *control panels* (see below).
control panel
1. A program that lets you adjust an aspect of the Macintosh's operating characteristics (like its speaker volume, desktop pattern or networking features).
2. The dialog box you see when you open a control panel.

Control Panels folder
The folder inside the System Folder that stores control panel programs.

DA (desk accessory)
A small utility program available from the Finder desktop and, usually, from within most applications via the menu.

default
What you get if you don’t specify something different. Often used to refer to standard settings (for example, the standard margins in a word processing program).

desktop
1. The Finder screen, showing the disks you currently have available for use with your Macintosh, the Trash icon and any files or folders you’ve moved out of their disk or folder windows.
2. A new organizational level at the top of the Mac’s file storage system that shows any available disks or other items on the Finder desktop.
3. A button in the Open and Save dialog boxes of applications that lets you view all the disks or other items on the desktop.

Desktop Folder
An invisible folder, containing the files and folders stored on the Finder's desktop, that is automatically created on every disk by System 7.1. (If you view a shared hard disk under System 7.1 or you view any disk set up for System 7.1 while you’re running System 6, the folder becomes visible, and you can open it to see the files and folders stored on that disk’s desktop.)
directory

An invisible file that keeps track of where various files are stored on a disk.

directory dialog box

A generic name for the dialog boxes you use to open or save files from within applications. Also known as a standard file box.

directory path

The path you must navigate through various folders to move from one organizational level to another in the Mac’s file storage system.

download

To transfer a font file from a hard disk to a laser printer.

edition

A file containing data that you have selected from a document and made available for use in other documents under System 7.1’s new Publish and Subscribe feature. Also see publishing and subscribing.

extension

A file that expands the Mac's system software capabilities, either by allowing it to communicate with other devices (such as printers, file servers or CD-ROM drives) or adding new functions like a menu bar clock. Files called inits or drivers under System 6 and previous system software versions are now called extensions.

Extensions folder

A folder inside the System Folder that contains extension files.

file server

A computer on a network that others on the network can access for applications and documents.

file sharing

The capability of networked Macintoshes to share the contents of folders with each other.
File Sharing Monitor

A control panel program that shows you which of your folders you have chosen to share with other users on a network, as well as which users are currently sharing those folders.

fixed-size font

A font that’s only one point size, such as Geneva 14. Compare outline and scalable fonts.

Fkey program

A program that assigns a combination of (Shift), (Cmd) and one of the number keys in the top row of the Mac keyboard to perform the same function at all times, no matter which program you have running.

Fonts folder

A folder inside the System Folder that stores all the font files used by your Mac.

gigabyte

A measure of computer memory, disk space and the like that’s equal to 1024 megabytes (1,073,741,824 bytes), or about 179 million words. Sometimes a gigabyte is treated as an even billion bytes but, as you can see, that’s almost 74 million bytes short. Sometimes abbreviated gig (more often in speech than in writing). Compare kilobyte and megabyte.

group

A collection of users on a network who have the same access to a designated shared folder or folders.

guest

In file sharing, someone who logs on to a shared item, but not as a registered user, and therefore gets the same access privileges assigned to all guests.

Help menu

A menu in the Finder that lets you turn on an automatic help function or display a list of keyboard shortcuts.
init
A program that loads automatically during the Mac’s startup sequence, and which adds extra capabilities to the Mac, like allowing it to recognize special keystroke sequences as commands, or communicate with printers and other devices. Under System 7.1, inits are now called extensions. See also extension.

Inter-Application Communication (IAC)
A facility built into System 7.1 that allows different programs to exchange data and commands using Apple Events. See also Apple Events.

item
A generic name for any object that can be represented by an icon in the Finder: a disk, file, folder or the Trash.

kilobyte
A measure of computer memory, disk space and the like that’s equal to 1024 bytes or about 170 words. Abbreviated K. Compare megabyte and gigabyte.

label
A name you can attach to a file to help you identify it, or to sort files into specific groups in Finder windows. On color Macintosh systems, a label can also assign a certain color to a file’s icon in the Finder.

Label menu
A menu in the Finder that allows you to assign one of seven different labels to a selected item.

logging on
In file sharing, the process by which someone gains access to a shared item on another Mac (usually by entering a user name and password).

megabyte
A measure of computer memory, disk space and the like that’s equal to 1024K (1,048,576 characters) or about 175,000 words. Abbreviated MB or meg.
network
Two or more computers (and/or other computer related devices) connected to share information, or the hardware and software that makes this connection possible.

outline font
A font designed for use on a laser printer or imagesetter. Rather than being composed of separate dots like a fixed-size font, it's made up of an outline of the shape of each letter and can be scaled to any size without loss of quality. Also see scalable font.

outline view
An arrangement of file or folder names in the Name, Date, Size, Kind and Label views of Finder windows that shows the contents of open folders, indented below the folder that contains them.

owner
The person who created and controls access to a folder, or who manages the file sharing functions on a particular Mac, as opposed to people who are simply using a folder or a Mac temporarily.

PMMU chip
A Paged Memory Management Unit chip, which must be added to the Macintosh II model computer before it can use System 7.1’s virtual memory feature.

pop-up menu
A menu linked to a window title or other object on the screen, which appears when you point to the object and click the mouse button (and, in some cases, hold down one or more keyboard keys). Because they are attached to windows, dialog boxes and other movable items, pop-up menus can appear anywhere on the screen, instead of only appearing in a menu bar.

PostScript
Adobe Systems, Inc.’s page-description programming language, designed to handle text and graphics and their placement on the page.
PostScript font
An outline font that's described with PostScript®.

Preferences folder
A folder inside the System Folder that holds files which store the current settings for the Finder views, file sharing's registered users, guests and groups and other user-adjustable features of the system software.

print spooler
A program (like PrintMonitor) that allows you to print a document into a special folder on your disk and have it fed to the printer from that folder while you get on with other work.

printer driver
A file that allows a Macintosh to print documents on a particular type of printer, like the ImageWriter or LaserWriter. You can't use any printer unless its driver is in your System folder (in System 7.1, it must be in the Extensions folder).

program linking
In System 7.1, a feature that allows programs on other Macs on a network to exchange commands and information directly with programs on your local Mac, via IAC and Apple Events. See also Inter-Application Communication and Apple Events.

publishing
Making data from one program available for use by other Macs on the same network (see subscribing).

QuickTime
An extension and added capability of System 7.1 that allows you to cut, copy, paste and play video or animation movies from within most documents.

rdev
Any resource file in the Chooser window, including printer drivers, network drivers and resources that allow the Mac to communicate with other devices like scanners.
registered user

In file sharing, a user who has been assigned an individual set of access options to another user’s shared items.

scalable font

A font that can be made any size you indicate, as opposed to being only one fixed size (compare fixed-size font).

screen font

A bitmapped version of an outline font, used to represent the font on the computer’s screen.

SCSI

Short for small computer system interface. It’s an industry-standard interface for hard disks and other devices that lets them transfer information very quickly. SCSI ports have been standard on all Macs since the Plus.

shared item

In file sharing, an item on a Mac which has been made available for others to use from their Macs on the same network.

startup disk

A disk you can use to start up your Macintosh. This disk must contain a System Folder and the right system software files to start your Mac properly.

startup item

A file or program that is opened automatically when the Macintosh starts up.

Startup Items folder

A folder inside the System Folder that holds programs or documents that will be opened automatically when the Macintosh starts up.

stationery (stationery pad)

A document that stores text, graphics and/or formatting information and is opened automatically as an Untitled document whenever you doubleclick on it in the Finder or choose the New command in an application.
subscribing  
Selecting published data made available from one location and pasting it into the current location, within or between documents—even between different applications or different computers on a network. Changes to the published data are automatically updated in the subscriber's copy of the data (see publishing).

suitcase (suitcase file, suitcase icon)  
A file that contains one or more fonts or desk accessories (DAs), so called because the icon representing this type of file looks like a suitcase.

32-bit addressing  
Addressing is how the Mac organizes memory. The more addresses a Mac can handle, the more memory it can use. Macs that use 24-bit addressing can access as many different memory locations as can be specified by addresses that are 24 bits long. Some of the newer Macs can handle 32-bit addresses, which means the amount of memory they can address is much larger (up to 128 megabytes on some Macs).

Trash Folder  
A System 7.1 folder containing files stored in the Trash. This folder is automatically created on every disk, and it's invisible if you start up your Mac with System 7.1. If you restart under System 6, the folder and any files in it are visible.

triangle (folder triangle)  
An icon to the left of a folder icon in list view windows of the Finder, which you can click to show the folder's contents in outline view (or to hide them if they're already showing).

TrueType  
A new scalable font technology used with some fonts supplied with System 7.1. One TrueType file lets you print or display a given font clearly in any size.

user name  
In file sharing, the name a shared item's owner gives to a registered user.
Views

A control panel file that lets you change the way files and folders are shown in Finder windows.

Virtual memory

The ability to set aside an unused portion of a hard disk as additional memory space for storing large programs or data files as you work with them on a Macintosh.

WorldScript

A set of extensions to System 7.1 that allows it to be easily customized to display menus, windows and dialog boxes in any of dozens of languages.
Index

A
32-bit addressing, 6, 144, 152
Mac models supporting, 156
RAM and, 157
turning on, 157
using, 156-157
See also memory
About This Macintosh command, 46-47
showing memory and, 49, 157
access privileges, file sharing, 230-233
by user class, 239-241
can't change, 248-249
checking, 234-235
file, 238-239
folder, 238-239
keeping simple, 244
options, 233
security and, 241-242
types of, 232
viewing, 234-238
Adobe Type Manager, 115, 171
aliases, 5
in Apple Menu Item folder, 110
application, 79
Clipboard, 79
Control Panels, 78, 79, 125
DA, 79
determining, 78
disk, 80
file names appearance, 111
file sharing and, 245
folder, 79-80
making, 77-78
names, 77
shared folder, 80
as startup items, 42	rash, 80
troubleshooting, 80-81
using, 78
tips for, 78-80
without a purpose, 80
alias information, 75
Apple Events, 254
benefits of, 254
required, 254
Apple HD SC Setup program, 26
Apple menu, 107-108
About This Macintosh command, 46-47
aliases in, 110-111
Apple Menu Item Folder and, 107
Chooser command, 50
Control Panels alias, 112
Control Panels command, 51
installing documents, folders, programs on, 110
managing, items, 111
unwanted, items, 112
Apple Menu Items folder, 107-112
aliases in, 110
illustrated, 108
Mac Portable/PowerBook and, 108
AppleShare
file sharing for, users, 204-206
file sharing vs., 204
resource, 206
for connecting to shared item, 216
AppleTalk network
connecting, 208
program linking and, 256
sharing folders/disks on, 144
turning on, 209
Application menu, 46, 100-102
adding names to, 100
Hide command, 101
Hide Others command, 101-102
removing names from, 101
Show All command, 102
applications, 149-168
activating different, 101
aliases, 79
installing, on Apple menu, 110
list of, running, 100
loading multiple, 49
memory and, 49-50, 72,
150-159
resetting size, 151
running and activating, 100-101
See also programs, shared
automatic scrolling, 55-56
B
backup utility programs, 18
functioning of, 19
Balloon Help, 98–99
  function of, 98
bitmap images
  precision alignment of, 175
  processing faster, 175
bitmapped fonts, 170
by Label command, 90
capture utility, 114
cdevs
  control panel and, 125
  incompatibility of, 38–39
  reinstalling, 30
CD-ROM, installing System 7.1 from, 28
Chooser command, 50–51
Chooser extensions, 113
Clean Up commands, 94
  Clean Up All, 95
  Clean Up by Name, 95, 96
  Clean Up Desktop, 95
  Clean Up Window, 95, 96, 137
  invisible grid and, 95
clipboard aliases, 79
Close command, 70
CloseView control panel, 126
Color command, 90–91
Color control panel, 126–129
colors, 126–129
  changing, 126
  label, 53, 94
  color component values, 128
  Label menu and, 90–92
  picking, 128–129
  selecting, 127
  setting monitor, 51–52
comments search criteria, 86
communications tools, 113–114
Compatibility Checker, 16
  function, 16
  reading, 17–18
  reinstalling DAs and, 32
  reinstalling old System Folder files and, 30
  running, 16–18
  sample, 17
control panels, 123–146
  aliases and, 125
  CloseView, 126
  Color, 126–129
  Date & Time, 55, 139–142
  Easy Access, 129–132
  File Sharing Monitor, 144
  General Controls, 132
  international, 145–146
  Keyboard, 132–133
  Labels, 93, 144
  language specific, 146
  Map, 125
  Memory, 144
  Monitors, 125
  Mouse, 125
  Numbers, 143
  opening, 124
  pointer changes in, 126
  Sharing Setup, 144
  Sound, 133–135
  Startup Disk, 125
  Text, 145–146
  Users & Groups, 144–145
  Views, 135–139
Control Panels command, 51
Control Panels folder, 38, 112, 124–125
  alias, 78, 79, 111
  contents of, 112
  illustrated, 124
  for switching startup disks, 40–41
  See also control panels
copying
  files, 57–58
  printed documents, 177
  screen snapshots, 61
Data Access Language (DAL), 8
Date & Time control panel, 55, 139–142
Date Formats dialog box, 140–141
  Custom option, 140
  Long date option, 140–141
  Short date option, 141
date search criteria, 86
deleting
  files, 58–59
  system software, 21
  fonts, 117–118
  groups, 230
  users, 230
desktop, 159
  cleaning up, 95
  button, 160
  folder, 41
  level, 159
directory paths and, 161
  explained, 159–161
dialog boxes
  Claris Resolve, 196–197
  Color Picker, 127–128
  Date Format, 140–141
directory, 62, 63
  Desktop button, 160
  New Folder button, 159, 161
Download Fonts, 185–186
Easy Install, 23
  Continue button, 25
  Customize option, 24–25
  Easy Install option, 23–24
  Restart button, 25
Find, 81–82
  all at once checkbox, 84
  expanded, 83
  More Choices button, 83, 85
Installer, 34
log-on, 217
  Set Password button, 220
Index

dialog boxes, continued
Open, 80
Page Setup, 173
illustrated, 174
Preferences, 183–184
Print, 176–178
Save, 80
Save As, 162
making stationery in, 162
shortcuts for, 63
Time Format, 142
See also windows
disk cache, 152
adjusting, 152–153
size, 144, 152–153
disks. See floppy disk; hard disk
Disk Tools disk, 15
Apple HD SC Setup program, 26
installing from floppy disks
and, 22–23
for startup, 38
Display Available Fonts command
(Font Utility), 187
document information, 74
documents
essential, 92
installing, on Apple menu, 110
opening, 159–161
printing
copies, 177
range of pages of, 177
removing, 181
reducing/enlarging, 174
saving, 159–161
See also files
Download Fonts command
(Font Utility), 185–186
Download PostScript File
command (Font Utility), 188–189
drivers
hard disk, updating, 26
LaserWriter, 13
System 7.1, 13
Duplicate command, 70
E
Easy Access control panel,
129–132
Acceptance Delay buttons, 131
Beep when modifier key is set
function of, 129
illustrated, 129
Initial Delay buttons, 130–131
Maximum Speed buttons, 131
Mouse Keys feature, 129
using, 130
Slow Keys, 131
Stick Keys feature, 129
modifier key, 131–132
using, 131
Use On/Off audio feedback
checkbox, 129
See also control panels
edition, 194
files, 196
Edit menu, 87
command shortcuts, 64
Paste command, 71
using, 87
Edit menu (Font Utility), 188
Edit menu (Word), 196, 198
Subscriber Options command, 199
Subscribe To command, 196
Eject command, 70
Eject Disk command, 70
Empty Trash command, 96–97
Extension Manager, 38
Extensions folder, 80, 113–114
function of, 113
Print Monitor program, 113
File menu, continued
Get Info command, 49–50,
71–76
for alias info, 75
for customizing icons, 71
document info, 74
for folder/disk info, 76
for making stationery, 163
for program info, 72–73
Make Alias command, 77–81
New Folder command, 70
Open command, 47, 56–57, 70
Page Setup command, 70, 172
Print command, 70, 172
Print Desktop command, 70
Print Window command, 70
Put Away command, 70, 221
Sharing command, 9, 70, 76,
205, 211
access privileges and, 234
function of, 76
for shared programs, 257
File menu (Font Utility), 185–188
Display Available Fonts
command, 187
Download Fonts command,
185–186
illustrated, 185
Initialize Printer’s Disk
command, 187
Page Setup command, 187
Print Font Catalog command,
187–188
Print Font Samples command,
188
files
access privileges, 238–239
see only, 232
backing up, 18–19
manually, 19
multiple copies of, 19
copying, 57–58
deleting, 58–59
system software, 21
desktop, rebuilding, 66
dictionary, 80
dragging, 57
Index

files, continued

dition, 196
finding, 81–86
by name, 81–82
by size/kind, 83–85
tips, 86
using same criterion, 82–83
font, 115
Help, 80
installing, in System Folder, 106–107
locked, 86
moving, 57–58
opening, 56–57
at startup automatically, 42
overwriting, 58
preferences, 119
saving when sharing, 245
shared, can't see/save, 249
snapshot, 122
suitcase, 109
system extension, 113
chooser extension, 113
communication tools, 113–114
System Folder
procedure for reinstalling old, 30–32
replacing, 22
System, reinstalling from, 32–33
system software, 21
VM Storage, 155
See also documents; file sharing
file server
installing System 7.1 from, 27–28
putting installer files on, 27
file sharing, 6, 203–221
access privileges, 230–233
by user class, 239–241
can't change, 248–249
checking, 234–235
tips, 238–239
folder, 238–239
keeping simple, 244
options, 233
types of, 232
viewing, 234–238
file sharing, continued
aliases and, 245
for AppleShare user, 204–206
arrows, 207
groups
adding to, 230
creating, 229
deleting, 230
list of, 227
name, can't find, 249
registering, 229–230
guest, changing options for, 227–229
host, 207
limiting access to, 144–145
maximizing performance of, 214
memory and, 206
monitoring and disconnecting
users and, 205–206
to other Macs, 206
overview, 207–208
owner, 208
changing options, 227–229
passwords, 210
can't change, 248
using consistent, 244–245
security, 241–242
setting up, 208–210
connecting to network, 208
identifying yourself, 209–210
turning on AppleTalk, 209
small files and, 214
step-by-step, 206–216
tips, 244–246
troubleshooting, 246–251
turning on, 144, 205, 211
users, 207, 208
access options, 226–227
classes of, 232–233
creating group of, 229–230
disconnecting, 214–216
name, can't find, 249
privileges by class, 239–241
registering, 224–225
file sharing, users, continued
registration, 208, 220, 224
using consistent names for, 233, 244–245
See also files; File Sharing
Monitor control panel
File Sharing Monitor control panel, 144
Connected Users list, 205, 213
Disconnect button, 205, 215
for disconnecting users, 215
illustrated, 213
Shared Items list, 213
using, 205–206
Find Again command, 81–86
function of, 81
using criterion and, 82
Find command, 81–86
Find within pop-up menu, 84
function of, 81
levels of options, 81–82
using criterion and, 82
Finder, 4
customizing windows in, 55
feature changes of, 46–48
loading multiple programs
and, 48–49
making stationery programs
and, 162–164
for printing in background,
50–51
using MultiFinder and, 48–49
window changes, 52–58
Finder Shortcuts command, 99
See also keyboard shortcuts
fixed-size fonts, 170
printing with, 172–173
See also fonts
FKeys, 59–61
for ejecting floppy disks, 59–60
for taking screen shots, 60–61
See also keyboard shortcuts
flag icon, 66–67
floppy disks
information on, 76
installing System 7.1 from, 22–26
See also hard disk
folders
access privileges, 238–239
see only, 232
aliases for, 79–80
calculating size of, 138
information, 76
installing, on Apple menu, 110
navigating shortcuts for, 62–63
New Folder button and, 161
shared
aliases for, 80
belted, 236
belted with arrow, 236–237
can’t find, 248
can’t open, 249
connecting to, 216–218
connecting to automatically at startup, 218–219
cut off from, 250–251
disconnecting from, 221
plain, 236
tabbed, 236
using, 221
sharing, 211–213
functions available in, 213
monitoring, 213
See also specific folders
Font/DA Mover program, 9, 118
FontMonger, 190
fonts
Adobe Type Manager and, 171
bitmapped, 170
built-in, 190
changing, 136
deleting, 117–118
displaying available, 187
downloadable, 176, 192
downloading, 185–186, 192
files, 115
fixed-size, 117, 170
printing with, 172–173
formats of, 170–171
ID conflicts, 118
installing, 4, 117–118
files, 35
printer, 6
management of, 6
fonts, continued
management programs for, 118
in menu bar, 136
mixing formats of, 190
more info on, 192
Postscript, 170–171
printer, 191
screen, 191
printing samples of, 188
reinstalling, from old System
file, 32–33
screen, 190–191
TrueType, 5, 117, 171
printing with, 173
types of, 115
viewing, 4, 116–117
in window titles, 136
Fonts folder, 6, 114–118
function of, 115
illustrated, 114
making changes to, 117
See also folders
font suitcases, 115
installing only some fonts from, 118
opening, 115–116
Font Utility, 184–189
Edit menu, 188
File menu, 185–188
Utilities menu, 188–189

Groups, continued
list of, 227
name, can’t find, 249
registering, 229–230
See also users, file sharing

H
hard disk
aliases, 80
backing up on, 18
cost, 11
driver, updating, 26
information, 76
installing from, 28
installing printer files on, 27
local, 27
reclaiming space in, 36
requirements, 10
setup program, 26
shared
can’t find, 248
connecting to, 216–218
connecting to at startup, 218–219
cut off from, 250–251
disconnecting from, 221
using, 221
sharing, 211–213
functions available in, 213
monitoring, 213
See also control panels
See also Macintosh computer
Help menu, 5, 46, 98–99
About Balloons Help command, 99
Finder Shortcuts command, 99
Hide Balloons command, 99
Show Balloons command, 98
Hide Balloons command, 99
Hide command, 101
Hide Others command, 101–102
Highlight color pop-up menu, 127
Other command, 127
host, file sharing, 207

See also specific folders
Hypercnd, 17

stack, 16–17

IAC (Inter-Application Communication), 253

icons
AppleShare, 216
application, 49
Application menu, 46, 100
arranging, 94
belted folder, 236
belted folder with arrow, 236
cosmetics of, 51–52
customizing, 71
disk, 30
flag, 66–67
folder privileges, 71
Guest, 228
guest user, 225
“happy mac,” 37
Help menu, 46
Installer program, 23
item, 47–48, 108
Labels, 93
LaserWriter, 50
layouts of, 137
Mac owner, 225
Monitors, 51
New Group, 229
New User, 225
Orientation, 174
owner’s, 227
plain folder, 236
printer, 179
selecting, shortcuts, 61–62
shared disk/folder, 212
size of, 137
Startup Disk, 40, 124
stationery, 162
Sticky Keys, 131
System Folder, 34
blessed, 20
Text control panel, 145
Trash, 97
window privileges, 237–238
Word, 100

Import Movie command, 166
incompatibilities
running, 39
startup, 38–39
Initialize Printer’s Disk command (Font Utility), 187
INITPicker, 38

ints
incompatibilities of, 38–39
reinstalling, 30
Startup Items folder and, 120
Installer disk, 22–23
Installer program, 15
completion of, 29–33
icon, 23
QuickTime extension, 34
using, 16

installing
DAs, 4
desk accessories, 109–110
documents on Apple menu,

files in System Folder, 106–107
doors on Apple menu, 110
fonts, 4, 117–118
keyboard layouts, 133
programs on Apple menu, 110
QuickTime extension, 33–34
resources, 24–25
scripts and font files, 35
sounds, 4, 121–122
System 7.1, 15–36
from CD-ROM disk, 28
Customize option, 24–25
Easy Install option, 23–24
failure of, 29
from file server, 27–28
from floppy disks, 22–26
from local hard disk, 28
on multiple hard disks, 40
preparation for, 16
WorldScript extensions, 35
See also FKeys

items, continued
labels, sorting, 53
names of, 47–48
arranging, 111
editing, 48
selecting, 47–48
by typing, 55
can’t move, rename, delete, 249
groups in list view, 55
shared
can’t change access privilege for, 248–249
connecting to, 216–218
connecting to at startup, 218–219
cut of, 250–251
disconnecting from, 221
using, 221

K
Keyboard control panel, 132–133
illustrated, 132
international users and, 133
Keyboard Layout list, 132
keyboard layouts, 66–67
installing, 132–133
Keyboard menu, 46, 66
keyboard shortcuts, 61–66
additional, 65–66
for dialog boxes, 63
for Edit menu commands, 64
for File menu commands, 64
for navigating folders/windows, 62–63
for selecting icons, 61–62
for Special menu commands, 65
See also FKeys
kind search criteria, 86

L
Label menu, 46, 90–92
for changing colors, 52
for changing names and colors of labels, 53
function of, 90
illustrated, 91
None command, 91
Index

labels, 91
- color of, 94
- customizing, 93–94
- defined, 144
- for desktop items, 92
- name of, 90
  - changing, 93
  - not using, 92
- search criteria, 86
- sorting windows by, 92
- system extension, 114
Labels control panel, 93, 144
LaserWriter
- eliminating rough edges with, 175
- Font Utility. See Font Utility
  - PostScript fonts and, 170
- printing startup page with, 189
- sharing on network, 256
- substituting fonts with, 174
- upgrading, 13
  - See also printers; PrintMonitor
- list views, 53
  - selecting groups of items in, 55
lock search criteria, 86

M
- Macintosh computers, 10
  - startup compatibility problems, 38–39
  - upgrading, 11
    - costs of, 11–12
- Macintosh Font Book, The, 192
- Macintosh Memory Guide, 159
- MacroMaker, 9
- Make Alias command, 77–81
  - for making aliases, 77–78
  - for using aliases, 78–80
- MasterJuggler program, 118
  - memory, 150–151
  - 32-bit addressing, 6, 144, 152
  - using, 156–157
  - application, 49–50, 72
  - cache size, 144, 152–153
  - file sharing and, 206
  - fragmentation, 157–159
    - low-memory message, 158
    - minimizing, 158
memory, continued
- learning more about, 159
- managing, 49–50
  - program
    - managing, 150–159
    - resetting size, 151
  - QuickTime extension and, 33
  - for running System 7.1, 150–151
  - saving, 151
  - showing amount of, 49
    - virtual, 6, 144, 152
    - tips, 155–156
    - using, 153–155
Memory control panel, 144
  - After restart box, 154
  - Available on disk, 154
  - illustrated, 152, 154
  - Total memory, 154
  - using, 151–152
  - for using virtual memory, 153–155
  - VM Storage, 155
  - See also control panels
Metamorphosis, 190
MODE 32, 11
moving files, 57–58
Multifinder, 9
  - Finder and
    - differences, 49
    - using, 48–49

N
- name search criteria, 86
- networks
  - can't find Mac on, 247
  - connecting to, 208
  - file sharing on, 206–216
  - publishing and subscribing on, 200
- New Folder command, 70
- None command (Label menu), 91

O
- Open command, 47, 56–57, 70
opening
  - control panels, 124
  - documents, 159–161
  - files, 56–57
  - font suitcases, 115–116
  - System file, 121
- outline views, 54
  - owner, in file sharing, 208
  - changing options, 227–229

P
- Page Setup command, 70, 172
- Page Setup command (Font Utility), 187
- Page Setup dialog box, 173
- Faster Bitmap Printing, 175
- Flip Horizontal/Flip Vertical, 175
- Font Substitution, 174
  - illustrated, 174
- Invert Image, 175
- Large Print Area, 176
- more options, 175–176
- Orientation icons, 174
- Paper options, 174
- Precision Bitmap Alignment, 175
- Printer Effects, 174
- Text Smoothing/Graphics Smoothing, 175
- Unlimited Downloadable Fonts, 176

passwords, 210
  - changing, 219–221
  - forgotten, 248
  - Set Password button, 220
  - using consistent, 244–245
  - See also file sharing
Paste command, 71
- PICT format, 60
- PMMU chip, 11
- pointer, control panels, 126
- Postscript
  - files, 177–178
    - downloading, 188–189
  - fonts, 170–171
    - printer, 191
    - screen, 191
PowerBook
Apple Menu Items folder and, 108
virtual memory and, 156
Preferences command (Print-Monitor menu), 182, 183
Preferences dialog box, 183–184
Also display alert button, 184
Give no notification, 184
illustrated, 183
Only display in Application menu, 184
Show Print/Monitor window when printing, 183
When a manual feed job starts, 184
When a printing error needs to be reported, 183–184
Preferences folder, 119
Print command, 70, 172
Print Desktop command, 70
Print dialog box, 176–178
Copies, 177
Cover Page, 177
Destination, 177
illustrated, 176
Pages, 177
Paper Source, 177
PostScript File, 178
Print buttons, 177
printers
changing with chooser, 51
fonts available for, 6, 187
ImageWriter, 172
Laserwriter
Personal, LS, 172
PostScript compatible, 173–178
Postscript fonts and, 170
printing on different, 56
QuickDraw, 172–173
reinitializing, 189
StyleWriter, 172
See also LaserWriter; Print-Monitor
printer spooler, 119
Print Font Catalog command (Font Utility), 187–188
Print Font Samples command (Font Utility), 188
printing, 169–192
in background, 50–51, 179
changing, order, 181
cover page, 177
destination, 177
documents, 176–178
removing, 181
enlarging, area, 176
with fixed-size fonts, 172–173
inverting image of, 175
paper source and, 177
with TrueType fonts, 173
viewing, information, 181
See also printers
PrintMonitor, 113
alerts, 182
explained, 178
starting, 178–179
using, 178–184
window, 179–182
displaying, 180
illustrated, 180
Postpone Indefinitely, 182
Printing box, 180
Printing Status box, 180–181
Remove from List button, 181
Set Print Time, 181
Waiting list, 181
See also LaserWriter; printers; printing
PrintMonitor Documents folder, 119
PrintMonitor menu, 182–184
Open/Close commands, 182
Preferences command, 182, 183
Stop Printing/Resume Printing commands, 182–183
Print Window command, 70
program information, 71–73
program linking, 7
explained, 255
managing, performance, 260–261
on remote Mac, 256
program linking, continued
starting, 256–157
turning off, 260
two ways for, 255–256
users/guest access to, 258–260
See also file sharing
programs, shared
controlling user access to, 258–260
linking to, 256
procedure for using, 257–258
See also applications
publish and subscribe, 7
defined, 194–195
example of, 195–198
on a network, 200
uses for, 194–195
publishing, 194
options, 198–199
procedure, 196
submenu, 196, 198
See also publish and subscribe
Put Away command, 70
for disconnecting from shared item, 221
Q
QuickDraw
GX, 56
printers, 172–173
QuickMail, 114
QuickTime, 7–8
data, 166
example, 166–167
explained, 165–166
extension
installing, 33–34
memory and, 33
installation disk, 15
movie, 167
player controls, 167
speeds, 168
Starter Kit, 168
using, 165–168
RAM
32-bit addressing and, 157
accessing, 6
amount installed, 154
cache, 152
System 7.1 requirements, 10
virtual memory and, 154–156
See also memory
registration
group, 224, 229–230
user, 208, 220, 224
procedure for, 224–225
reinstalling
DAs, 32
fonts, 32–33
old System Folder files, 30–32
sounds, 32–33
See also installing
Remove TrueType command
(Font Utility), 189
Resolve, Claris, 195
publish and subscribe with, 196–197
dialog box, 196–197
resources, installing, 24–25
Restart Printer command (Font
Utility), 189
Resume Printing command
(PrintMonitor menu), 182
saving documents, 159–161
Scrapbook, sounds and, 121
screen
format, 60
snapshots, 60–61
copying, 61
scripts, installing, 35
scrolling, automatic, 55–56
searching
criteria, 83–84
tips for, 86
for file names, 82
for file size/kind, 83–85
limitations, 85
with multiple criteria, 85
searching, continued
selected items, 85
selecting, items, 47–48
Set Startup command, 9, 42, 94
setup programs, 26
Sharing command, 9, 70, 76, 205, 211
access privileges and, 234
function of, 76
for shared programs, 257
Sharing Setup control panel, 144
for disconnecting users, 215–216
for identifying yourself and your Mac, 209–210
illustrated, 210
Macintosh Name box, 210
Owner Name box, 210
Owner Password box, 210
for program linking, 257
Start button, 205
Stop button, 215
for turning on file sharing, 211
See also control panels
Show All command (Application
menu), 102
Show Balloons command, 98
size search criteria, 86
snd resources, 122
sorting, windows by labels, 92
Sound control panel, 133–135
Add button, 134
Alert Sounds list, 134
illustrated, 134
Microphones list, 134
Options button, 134
Record button, 135
Save button, 135
Speaker Volume control, 134
Stop, Pause, Play buttons, 135
See also control panels
sounds, 121–122
files, 122
installing, 4, 121–122
playing, 4
reinstalling, from old System file, 32–33
stored in separate file, 122
Special menu, 94
Clean Up Window command,
95, 96, 137
command shortcuts, 65
Eject Disk command, 70, 94
functions of, 94
Start Page Options command
(Font Utility), 189
startup, 37–42
disk, 124–125
scanning order, 40
switching, 40–41
Disk Tools disk for, 38
incompatibilities, 38–39
items, 42, 120
aliases as, 42
with multiple hard disks, 39–41
opening files automatically at, 42
Startup Items folder, 42, 120
aliases inside, 42
function of, 120
inits and, 120
stationery, 162
document, 164
icon, 162
making
in Finder, 162–164
in Save As box, 162
pad, 164
changing, 165
Stationery pad checkbox, 163
turning document into, 74
using, 161–165
stationery option, 5
Sticky Keys, 129
icon, 131
modifier key, 131–132
Stop Printing command (Print-
Monitor menu), 182
Stuff folder, 30
in reinstalling old System
Folder files, 30–32
See also System Folder
subscribing, 194
options, 199–200
procedure, 196–197
See also publish and subscribe
Suitcase program, 118
System 7.1
compatibility, 12, 16–18
features missing from, 9
installing, 15–36
from CD-ROM disk, 28
failure, 29
from file server, 27–28
from floppy disks, 22–26
from local hard disk, 28
memory for, 150–151
new features in, 4–8
QuickTime and, 7–8
reliability of, 12
requirements for running, 10–11
starting, 37
upgrading to, 11–13
System 6
features, 9
staying with, 12–13
system extensions, 38
Chooser extension files, 113
communication tools, 113–114
defined, 113
labels, 114
third-party, 114
System file, 112
illustrated, 121
installing sounds on, 121–122
location of, 112
opening, 121
reinstalling from, 32–33
System Folder, 105–122
blessed, icon, 20
contents of, after installation, 29–30
eliminating, 19–20
icon, 20, 34
icon view window, 106
installing files in, 106–107
installing System 7.1 and, 19
moving files to, 20
reclaiming disk space and, 36
reinstalling old files, 30–32
replacing, files, 22
unblessing, 20
updating, 21–22
System software, compatibility
problems, 38–39
Text control panel, 145–146
icon, 145
illustrated, 146
Script pop-up menu, 146
System direction buttons, 146
See also control panels
Time Format dialog box, 142
Clock options, 142
Format options, 142
title bar, window, 52
Trash, 41
aliases, 80
changes in functioning of, 58
emptying, 58–59, 96–97
turning, warning off, 97
temporarily, 97
troubleshooting
alias, 80–81
file sharing, 246–251
can’t change access
privileges, 248–249
can’t connect file sharing
Mac, 247–248
can’t find folder/disk, 248
can’t find Mac on network, 247
can’t find user/group name, 249
can’t move, rename, delete
shared item, 249
can’t open shared folder, 249
file sharing won’t start, 246
forgotten password, 248
shared item connection cut
off, 250–251
TrueType fonts, 5, 117, 171
mixing
formats, 190
with other fonts, 190–192
printing with, 173
removing, 189
See also fonts
Users & Groups control panel,
144–145
illustrated, 225
New Group (File menu), 229
New User (File menu), 225
for registering users, 224–225
for setting owner access
options, 227–228
for shared programs user
access, 258–260
See also control panels
users, file sharing, 207
access options, 226–227
classes of, 232–233
privileges by, 239–241
creating group of, 229–230
disconnecting, 214–216
warning for, 216
name, can’t find, 249
registration, 208, 220, 224
procedure for, 224–225
using consistent names for,
233, 244–245
Utilities menu (Font Utility),
188–189
Download PostScript File
command, 188–189
Remove TrueType command,
189
Restart Printer command, 189
Start Page Options command,
189
View menu, 90
by Label command, 90
Icon view, 94
Small Icon view, 94
views
Icon, 137, 235
list, 53, 55
outline, 54
Small Icon, 137, 235
Views control panel, 55, 135–139
Always snap to grid checkbox,
Views control panel, continued
  Calculate folder sizes checkbox, 138
  Font for views area, 136
  function of, 135–136
  Icon and Small Icon Views area, 137
  illustrated, 136
  List Views area, 137
  Show boxes, 137–138
  Show disk info in header checkbox, 139
  Straight grid/Staggered grid buttons, 137
  See also control panels
virtual memory, 6, 144, 152
  function of, 153
  PowerBook and, 156
  RAM and, 154–156
  tips, 155–156
  using, 153–155
  who can use, 153

Windows
  See also dialog boxes
  WorldScript, 8
    activating, 35
    extensions, 34
    control panels and, 145–146
    installing, 35
    Keyboard control panel and, 133
    WorldScript I, 35
    WorldScript II, 35
    installing additional keyboard layouts and, 133

W
  Window color pop-up menu, 127
  Other command, 127
windows
  About This Macintosh, 47
    illustrated, 158
    Unused Block indicator, 158
    alias information, 75
    Find Original button, 75
    automatic scrolling and, 55–56
  windows, continued
    Chooser, 50–51, 217
      Active button, 209
    illustrated, 209
    cleaning up, 95–96
    closing shortcuts, 54
    customizing, 55
    directory path, 52, 65
    document information, 74
    Stationery pad checkbox, 74
    folder/disk information, 76
    Guest, 228
    hiding, 101–102
    icon view, 106
    information, 163–164
    list view, 53
      information in, 137
    moving shortcut, 65
    navigating shortcuts for, 62–63
    PrintMonitor, 179–182
    privileges icons, 237–238
    program information, 71–72
      Locked checkbox, 73
      Minimum size box, 73
      Preferred size box, 72–73
      Suggested size box, 73
    Sharing, 205, 212
      access privileges and, 235
    illustrated, 235
      options for access privileges, 231
      for shared programs, 257–258
  windows, continued
    showing, 101–102
    sorting by label, 92
    title bar, 52
    Trash information, 97
    user's, 226
      Allow User to Change Password checkbox, 227
      Allow User to Connect checkbox, 227
      Groups list, 227
      Program Linking area, 227
      User Password box, 226
      zoom box, 53

Z
  zoom box, 53
More from Peachpit Press...

**Art of Darkness (with disk)**  
*Erfurt Fenton*  
This book is the perfect companion to *AFTER DARK*, the world's most popular screen saver and one of the top-selling utility programs of all time. It explains how to install, operate, and customize the program, as well as how to create modules for new screen savers. Included are nine new *AFTER DARK* modules created exclusively for this book. (128 pages)

**Canvas 3.0: The Book**  
*Deke McClelland*  
This book takes you on a fact-filled tour of Canvas 3.0. It includes essential information about using the program with System 7, creating dynamic illustrations and text effects, and much more. (384 pages)

**The Dead Mac Scrolls**  
*Larry Pina*  
Now any Mac owner—from the novice to the expert—can keep repair costs down. In this unique and encyclopedic guide, Macintosh guru Larry Pina diagnoses hundreds of hardware problems, shows the simplest and cheapest way to fix them, and reveals how much the repairs should cost. Of particular value is the book’s directory of companies that sell parts or provide service. (484 pages)

**Desktop Publisher’s Survival Kit**  
*David Blatner*  
Here is a book that provides insights into desktop publishing on the Macintosh: troubleshooting print jobs, working with color, scanning, and selecting fonts. A disk containing 12 top desktop publishing utilities, 400K of clip art, and two fonts is included in this package. (176 pages)

**Illustrator Illuminated**  
*Clay Andres*  
This book is for people who want to know more about Adobe Illustrator than the manuals can tell them. *Illustrator Illuminated* uses full-color graphics to show how professional artists use Illustrator’s tools to create a variety of styles and effects. Each chapter shows the creation of a specific illustration from concept through completion. Additionally, it covers using Illustrator in conjunction with Adobe Streamline and Photoshop. (200 pages)

**The Little Mac Book, 2nd Edition**  
*Robin Williams*  
Praised by scores of magazines and user group newsletters, this concise, beautifully written book covers the basics of Macintosh operation. It provides useful reference information, including charts of typefaces, special characters, keyboard shortcuts, and a special update on System 7. (184 pages)

**The Little Mac Word Book**  
*Helmut Kobler*  
Here’s a fast way to learn Word 5.0 basics. This book provides concise and clear information about formatting text; using Word with Apple’s new System 7 operating system; taking advantage of Word’s writing tools; setting up complex tables, and much more! (240 pages)

**The Little QuicKeys Book**  
*Steve Roth and Don Sellers*  
This handy guide to CE Software’s QuicKeys 2.0 explores the QuicKeys Keysets and the different libraries QuicKeys creates for each application; shows how to link together functions and extensions; and provides an abundance of useful macros. (288 pages)

**The Macintosh Bible**  
*Arthur Naiman, Nancy E. Dunn, Susan McAllister, John Kadyk, and a cast of thousands*  
It’s more than just a book—it’s a phenomenon. Even Apple’s own customer support staff uses it. Now the Fourth Edition is here, and its 1,248 pages are crammed with tips, tricks, and shortcuts...
to get the most out of your Mac. And to make sure the book doesn’t get out-of-date, three 30-page updates are included in the price (we mail them to you free of charge). Every Mac owner should have one. (1,248 pages)

**The Macintosh Bible Software Disks**  
**Dave Mark**  
This two-disk companion to *The Macintosh Bible, 4th Edition* offers Mac users an introduction to the very best public-domain software and shareware that exists for the Mac (more than 2 megabytes!). The disks include useful utilities, modem software, sounds, games, and fonts.

**The Macintosh Bible Guide to FileMaker Pro**  
**Charles Rubin**  
Claris’s FileMaker Pro product manager enthusiastically declared this book a “must for every FileMaker Pro user.” Best-selling author Charles Rubin offers fast relief for FileMaker users of all levels, providing clear and understandable solutions for scores of the most common problems. (284 pages)

**Charles Rubin**  
Completely updated through System 7, this bestseller covers just about every sort of basic problem a Mac user can encounter. The book shows the error message exactly as it appears on screen, explains the problem (or problems) that can produce the message, and discusses what to do. This book is geared for beginners and experienced users alike. (352 pages)

**The Mac is not a typewriter**  
**Robin Williams**  
This best-selling, elegant guide to typesetting on the Mac has received rave reviews for its clearly presented information, friendly tone, and easy access. Twenty quick and easy chapters cover what you need to know to make your documents look clean and professional. (72 pages)

**The QuarkXPress Book, 2nd Edition**  
**David Blatner and Keith Stimely**  
This best-selling guide to the world's most powerful desktop publishing program is required reading for any serious XPress user. It explains how to import and modify graphics and provides tips for printing, using XTensions and other applications to customize the user interface. Additionally, it includes a section outlining XPress 3.1's numerous new features and techniques. (640 pages)

**Real World FreeHand 3**  
**Olav Martin Kvorn**  
The ultimate insider’s guide to FreeHand, this authoritative and entertaining book first lays out the basics and then concentrates on advanced techniques. (528 pages)

**Silicon Mirage**  
**Steve Aukstakalnis and David Blatner**  
Virtual reality is the amazing new technology of “pretend worlds,” where individuals can completely immerse themselves in computer-generated environments. *Silicon Mirage* provides an easily understandable explanation of the “virtual senses” already possible, the strikingly broad array of fields where virtual reality is having an impact, and the breathtaking horizons yet to be discovered. (300 pages)

**Zen and the Art of Resource Editing**  
**(with disk)**  
**Derrick Schneider et al.**  
This book introduces the beginner to ResEdit 2.1, one of the most useful tools ever designed for the Macintosh. It covers ResEdit from a nonprogrammer’s point of view, and shows how to customize the Finder, menus, keyboard map and icons. The book contains a disk with the latest version of ResEdit and 1400K of sample resources. (240 pages)
# Order Form

To order, call: (800) 283-9444 or (510) 548-4393 (M-F) • (510) 548-5991 fax

<table>
<thead>
<tr>
<th>#</th>
<th>Title</th>
<th>Price</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Art of Darkness (with disk)</td>
<td>19.95</td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>Canvas 3.0: The Book</td>
<td>21.95</td>
<td></td>
</tr>
<tr>
<td>03</td>
<td>Dead Mac Scrolls</td>
<td>32.00</td>
<td></td>
</tr>
<tr>
<td>04</td>
<td>Desktop Publisher’s Survival Kit (with disk)</td>
<td>22.95</td>
<td></td>
</tr>
<tr>
<td>05</td>
<td>Illustrator Illuminated</td>
<td>24.95</td>
<td></td>
</tr>
<tr>
<td>06</td>
<td>The Little Mac Book, 2nd Edition</td>
<td>14.95</td>
<td></td>
</tr>
<tr>
<td>07</td>
<td>The Little Mac Word Book</td>
<td>15.95</td>
<td></td>
</tr>
<tr>
<td>08</td>
<td>The Little QuicKeys Book</td>
<td>18.95</td>
<td></td>
</tr>
<tr>
<td>09</td>
<td>The Macintosh Bible, 4th Edition</td>
<td>32.00</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>The Macintosh Bible Disks, 4th Edition</td>
<td>25.00</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>The Macintosh Bible Guide to FileMaker Pro 2.0</td>
<td>22.00</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>The Macintosh Bible Guide to System 7.1</td>
<td>15.00</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>The Macintosh Bible “What Do I Do Now?” Book</td>
<td>15.00</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>The Mac is not a typewriter</td>
<td>9.95</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>The QuarkXPress Book, 2nd Edition</td>
<td>27.95</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Real World FreeHand</td>
<td>27.95</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Silicon Mirage</td>
<td>15.00</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Zen and the Art of Resource Editing</td>
<td>24.95</td>
<td></td>
</tr>
</tbody>
</table>

**SHIPPING:**

- **UPS Ground**: $4 + $1 per additional item
- **UPS Blue**: $7 + $2 per additional item
- **Canada**: $6 + $4 per additional item
- **Overseas**: $14 + $14 per additional item

Subtotal: 8.25% Tax (CA only)

Shipping

**TOTAL**

<table>
<thead>
<tr>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Company</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>City</th>
<th>State</th>
<th>Zip</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

- [ ] Check enclosed
- [ ] Visa
- [ ] MasterCard

<table>
<thead>
<tr>
<th>Company purchase order #</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Credit card #</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Expiration Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

Peachpit Press, Inc. • 2414 Sixth Street • Berkeley, CA • 94710

Your satisfaction is guaranteed or your money will be cheerfully refunded!
"If you’re looking for the three most important aspects of a computer book—clarity, clarity, and clarity—then the Bible bunch has done it again.”

—DAVID POGUE, MACWORLD

Written in a clear, concise, no-nonsense style, this book is for people who are already familiar with the Mac. Skipping tedious and repetitive explanations, it gets right to the information you need to use System 7.1:

- Installation and compatibility
- The new & improved Finder
- The System Folder
- Managing program memory
- Printing and fonts
- Sharing files and linking programs
- Using Publish & Subscribe